
 

 

COMPUTER COURSES

Home

Beginners Computing

Word 2007 to  2010

Word 2000 to  2003

Excel 2007 to  2010

Excel to  2003

Web Design

Visual Basic .NET

Beginners PHP

C# .NET

Java for Beginners

 

Getting Started
 

One of  the dif f icult  things about gett ing started
with Java is installing everything you need. Even
before you write a single line of  code, the
headaches begin! Hopefully, the following
sect ions will make life easier for you.We're going
to write all our code using a f ree piece of
software called NetBeans. This is one of  the
most popular IDEs (Interface Development
Environment) in the world for writ ing Java
programmes. You'll see what it  looks like short ly.
But before NetBeans will work, it  needs you to
install the necessary Java components and f iles.
First  up is something called the Java Virtual
Machine.

 

The Java Virtual Machine

Java is plat form independent. This means that it  will run on just  about any operat ing system. So
whether your computer runs Windows, Linux, Mac OS, it 's all the same to Java! The reason it  can
run on any operat ing system is because of  the Java Virtual Machine. The Virtual Machine is a
programme that processes all your code correct ly. So you need to install this programme (Virtual
Machine) before you can run any Java code.
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Java is owned by a company called Sun Microsystems, so you need to head over to Sun's
website to get the Java Virtual Machine, also known as the Java Runt ime Environment (JRE). Try
this page f irst :

ht tp://java.com/en/download/index.jsp

You can check to see if  you already have the JRE on your computer by clicking the link "Do I have
Java?". You'll f ind this link under the big Download button at  the top of  the page. (Unless Sun
have changed things around, again!) When you click the link, your computer will be scanned for
the JRE. You will then be told whether you have it  or not. If  not , you'll be given the opportunity to
download and install it .

Or you could just  head over to this page:

ht tp://java.com/en/download/manual.jsp

The "manual" in the above links means "manual download". The page gives you download links
and instruct ions for a wide variety of  operat ing systems.

After downloading and installing, you may need to restart  you computer. When you do, you will
have the Java Virtual Machine.

The Java Software Development Kit

At this stage, you st ill can't  write any programmes. The only thing you've done is to install
sof tware so that Java programmes can be run on your computer. To write code and test  it  out ,
you need something called a Software Development kit .

Java's Software Development Kit  can current ly be downloaded from here:

ht tp://developers.sun.com/downloads/

The one we're going to be using is called Java SE. (The SE stands for Standard Edit ion.). Click on
that link, then on "Java SE (JDK) 6 Download". You'll then f ind yourself  on a page with a
bewildering list  of  opt ions to download. Because we're going to be using NetBeans, locate this:

JDK 6 Update X with NetBeans 6.x
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Click the Download link to be taken to yet  another page. Click the top download to be taken to a
page that asks you to select  your operat ing system. Click Cont inue to f inally get the download
you need. A word of  warning, though - this download will be big, at  over a 130 megabytes at  the
t ime of  writ ing! Once you've downloaded the JDK and NetBeans, install it  on your computer.

We're going to be using NetBeans to write our code. Before launching the software, however,
here's how things work in the world of  Java.

 

How things work in Java

You write the actual code for your programmes in a text  editor. (In NetBeans, there's a special
area for you to write code.) The code is called source code, and is saved with the f ile extension
.java. A programme called Javac is then used to turn the source code into Java Byte Code. This is
known as compiling. After Javac has f inished compiling the Java Byte Code, it  creates a new f ile
with the extension .class. (At least , it  does if  no errors are detected.) Once the class f ile has been
created, it  can be run on the Java Virtual Machine. So:

Create source code with the extension .java
Use Javac to create (compile) a f ile ending in .class
Run the compiled class

NetBeans handles all the creat ing and compiling for you. Behind the scenes, though, it  takes your
sources code and creates the java f ile. It  will launch Javac and compile the class f ile. NetBeans
can then run your programme inside its own software. This saves you the hassle of  opening up a
terminal window and typing long strings of  commands.

Now that you have a general idea of  how Java works, launch your NetBeans software. Then click
the link below to go to cont inue with the lesson.

The NetBeans Software -->

Back to the Home Page
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The NetBeans Software

When you f irst  run NetBeans, you'll see a screen something like this one:

The NetBeans Software - First  Start  (38K)

You may have to drum your f ingers and wait  a while, as it 's not the fastest  thing in the world.

To start  a new project , click on File > New Project  f rom the NetBeans menu at  the top. You'll see
the following dialogue box appear:
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We're going to be create a Java Applicat ion, so select  Java under Categories, and then Java
Applicat ion under Projects. Click the Next button at  the bottom to go to step two:
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In the Project  Name area at  the top, type a Name for your Project . Not ice how the text  at  the
bottom changes to match your project  name (in the text  box to the right  of  Create Main Class):

f irstproject .Main

If  we leave it  like that, the Class will have the name Main. Change it  to FirstProject :
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Now, the Class created will be called FirstProject , with a capital "F", capital "P". The package is
also called f irstproject , but  with a lowercase "f" and lowercase "j".

The default  locat ion to save your projects appears in the Project  Locat ion text  box. You can
change this, if  you prefer. NetBeans will also create a folder with your project  name, in the same
locat ion. Click the Finish button and NetBeans will go to work creat ing all the necessary f iles for
you.

When NetBeans returns you to the IDE, have a look at  the Projects area in the top lef t  of  the
screen (if  you can't  see this, click Window > Projects f rom the menu bar at  the top of  the
software):

Click the plus symbol to expand your project , and you'll see the following:

Now expand Source Packages to see your project  name again. Expand this and you'll see the
Java f ile that  is your source code.

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


This same source code should be displayed to the right , in the large text  area. It  will be called
FirstProject .java. If  you can't  see a code window, simply double click FirstProject .java in your
Projects window above. The code will appear, ready for you to start  work.

The coding window that appears should look like this (we've changed the author's name):

One thing to note here is that  the class is called FirstProject :

public class FirstProject  {

This is the same name as the java source f ile in the project  window: FirstProject .java. When you
run your programmes, the compiler demands that the source f ile and the class name match. So if
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your .java f ile is called f irstProject  but the class is called FirstProject  then you'll get  an error on
compile. And all because the f irst  one is lowercase "f" and the second one uppercase.

Note that although we've also called the package f irsproject , this is not necessary. We could have
called the package someprogramme. So the name of the package doesn't  have to be the same
as the java source f ile, or the class in the source f ile: it 's just  the name of the java source f ile and
the name of the class that must match.

In the next part , you'll learn about Java comments.

<-- Gett ing Started | Java Comments -->

Back to the Home Page
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The greyed-out areas are comments. When the programme runs, comments are ignored. So you
can type whatever you want inside of  your comments. But it 's usual to have comments that
explain what is you're t rying to do. You can have a single line comment by typing two slashes,
followed by your comment:

//This is a single line comment

If  you want to have more than one line, you can either do this:

//This is a comment spreading
//over two lines or more
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Or you can do this:

/*
This is a comment spreading
over two lines or more
*/

In the comment above, note how it  starts with /*. To end the comment, we have */ instead.

There's also something called a Javadoc comment. You can see two of  these in the coding image
on the previous page. A Javadoc comment starts with a single forward slash and two asterisks
(/**) and ends with an asterisk and one slash ( */ ). Each line of  the comment starts with one
asterisk:

/**
*This is a Javadoc comment 
*/

Javadoc comments are used to document code. The documented code can then be turned into
an HTML page that will be helpful to others. You can see what these look like by clicking Run from
the menu at  the top of  NetBeans. From the Run menu, select  Generate Javadoc. There's not
much to see, however, as you haven't  writ ten any code yet!

At this stage of  your programming career, you can delete the comments that NetBeans
generates for you. Here's our code again with the comments deleted:
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In the next part , you'll learn about the structure of  the above code, and how to run your
programmes.

<-- The NetBeans Software | Java Code Structure -->

Back to the Home Page
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The Structure of Java Code

In the previous sect ion, you t idied up your code a bit . Here's what your coding window should
look like now:

You can see we have the package name f irst . Not ice how the line ends with a semicolon. If  you
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miss the semicolon out, the programme won't  compile:

package f irstproject;

The class name comes next:

public class FirstProject  {

}

You can think of  a class as a code segment. But you have to tell Java where code segments start
and end. You do this with curly brackets. The start  of  a code segment is done with a lef t  curly
bracket { and is ended with a right  curly bracket }. Anything inside of  the lef t  and right  curly
brackets belong to that code segment.

What 's inside of  the lef t  and right  curly brackets for the class is another code segment. This one:

public stat ic void main( String[ ] args ) {

}

The word "main" is the important part  here. Whenever a Java programme starts, it  looks for a
method called main. (A method is just  a chunk of  code. You'll learn more about these later.) It  then
executes any code within the curly brackets for main. You'll get  error messages if  you don't  have
a main method in your Java programmes. But as its name suggest, it  is the main entry point  for
your programmes.

The blue parts before the word "main" can be ignored for now.

(If  you're curious, however, public means that the method can be seen outside of  this class; stat ic
means that you don't  have to create a new object ; and void means it  doesn't  return a value - it
just  gets on with it . The parts between the round brackets of  main are something called
command line arguments. Don't  worry if  you don't  understand any of  that , though.)

The important point  to remember is that  we have a class called FirstProject . This class contains a
method called main. The two have their own sets of  curly brackets. But the main chunk of  code
belongs to the class FirstProject .

In the next part , you'll learn how to run your Java programmes.
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<-- Java Comments | Running your Java Programmes -->

Back to the Home Page
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Running your Java Programmes

When you run a programme in NetBeans, it  will run in the Output window at the bottom of your
screen, just  underneath your code. This is so that you don't  have to start  a terminal or console
window - the Output window IS the console.

There are various ways to run your programme in NetBeans. The easiest  way is to press F6 on
your Keyboard. You can also run programmes using the menus as the top of  NetBeans. Locate
the Run menu, then select  Run Main Programme:
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You can also click the green arrow on the NetBeans toolbar:

Another way to run your programmes is f rom the Projects window. This will ensure that the right
source code is being run. Simply right  click your java source f ile in the projects window and you'll
see a menu appear. Select  Run File.
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Using one of  the above methods, run your programme. You should see something happening in
the Output window:
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The second line in the Output window above is our code: My First  Project . You can quickly run it
again by clicking the two green arrows in the top lef t  of  the Output window.

<-- Java Code Structure | The Output Window -->

Back to the Home Page
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Printing to the Output Window

You can run the code you have so far, and turn it  into a programme. It  doesn't  do anything, but it
will st ill compile. So let 's add one line of  code just  so that we can see how it  works.

We'll output some text  to a console window. Add the following line to your main method:

public stat ic void main( String[ ] args ) {

System.out.print ln( "My First  Project" );

}

When you type the full stop af ter "System", NetBeans will t ry to help you by displaying a list  of
available opt ions:
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Double click out to add it  to your code, then type another full stop. Again, the list  of  opt ions
appears:
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Select  print ln( ). What this does is to print  a line of  text  to the output screen. But you need to
place your text  between the round brackets of  print ln. Your text  needs to go between a pair of
double quotes:

Once you have your double quotes in place, type your text :
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Notice that the line ends in a semicolon. Each complete line of  code in Java needs a semicolon at
the end. Miss it  out  and the programme won't  compile.

OK, we can now go ahead and test  this programme out. First , though, save your work. You can
click File > Save, or File > Save All. Or click the Save icon on the NetBeans toolbar.

To end this sect ion, click below to learn how to share your Java programmes with others.

<-- Running Java Programmes | Sharing your Java Programmes -->

Back to the Home Page
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Sharing your Java Programmes

You can send your programmes to other people so that they can run them. To do that, you need
to create a JAR f ile (Java Archive). NetBeans can do all this for you. From the Run menu at  the
top, select  Clean and Build Main Project .

When you do, NetBeans saves your work and then creates all the necessary f iles. It  will create a
folder called dist  and place all the f iles in there. Have a look in the place where your NetBeans
projects are and you'll see the dist  folder:
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Double click the dist  folder to see what 's inside of  it :

You should see a JAR f ile and README text  f ile. The text  f ile contains instruct ions on how to run
the programme from a terminal/console window.

Now that you know how to run your java source f iles, let 's do some programming.

<-- Print ing to the Output window | Java Variables -->
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Java Variables
 

Programmes work by manipulat ing data placed in
memory. The data can be numbers, text , objects,
pointers to other memory areas, and more
besides. The data is given a name, so that it  can
be re-called whenever it  is need. The name, and
its value, is known as a Variable. We'll start  with
number values.

To store a number in java, you have lots of
opt ions. Whole numbers such as 8, 10, 12, etc,
are stored using the int  variable. (The int  stands
for integer.) Float ing point  numbers like 8.4, 10.5,
12.8, etc, are stored using the double variable.
You do the storing with an equals sign ( = ). Let 's
look at  some examples (You can use your
FirstProject  code for these examples).

To set up a whole number (integer), add the following to the main method of  your project  f rom
the previous sect ion:

public stat ic void main(String[ ] args) {

int  f irst_number;

System.out.print ln("My First  Project");
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}

So to tell Java that you want to store a whole number, you f irst  type the word int , followed by a
space. You then need to come up with a name for your integer variable. You can call them almost
anything you like, but there are a few rules:

Variable names can't  start  with a number. So f irst_number is OK, but not 1st_number. You
can have numbers elsewhere in the variable name, just  not at  the start .
Variable names can't  be the same as Java keywords. There are quite a lot  of  these, and
they will turn blue in NetBeans, like int  above.
You can't  have spaces in your variable names. The variable declarat ion int  f irst  number will
get  you an error. We've used the underscore character, but  it 's common pract ise to have the
f irst  word start  with a lowercase let ter and the second or subsequent words in uppercase:
f irstNumber, myFirstNumber
Variable names are case sensit ive. So f irstNumber and FirstNumber are dif ferent variable
names.

To store something in the variable called f irst_number, you type an equals sign and then the
value you want to store:

public stat ic void main(String[ ] args) {

int  f irst_number;

f irst_number = 10;

System.out.print ln("My First  Project");

}

So this tells java that we want to store a value of  10 in the integer variable that we've called
f irst_number.

If  you prefer, you can do all this on one line:

public stat ic void main(String[ ] args) {

int  f irst_number = 10;

System.out.print ln("My First  Project");
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}

To see all this in act ion, change the print ln method slight ly to this:

System.out.print ln( "First  number = " + f irst_number  );

What we now have between the round brackets of  print ln is some direct  text  enclosed in double
quotes:

("First  number = "

We also have a plus sign, followed by the name of our variable:

+ f irst_number );

The plus sign means "join together". So we're joining together the direct  text  and the name of our
variable. The joining together is known as concatenat ion.

Your coding window should now look like this (note how each line of  code ends with a semicolon):

Run your programme and you should see the following in the Output window at the bottom:
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So the number that we stored in the variable called f irst_number is output af ter the equals sign.

Let 's t ry some simple addit ion. Add two more int  variables to your code, one to store a second
number, and one to store an answer:

int  f irst_number, second_number, answer;

Notice how we have three variable names on the same line. You can do this in Java, if  the
variables are of  the same type (the int  type, for us). Each variable name is then separated by a
comma.

We can then store something in the new variables:

f irst_number = 10;
second_number = 20;
answer = f irst_number + second_number;

For the answer variable, we want to add the f irst  number to the second number. Addit ion is done
with the plus ( + ) symbol. Java will then add up the values in f irst_number and second_number.
When it 's f inished it  will store the total in the variable on the lef t  of  the equals sign. So instead of
assigning 10 or 20 to the variable name, it  will add up and then do the assigning. In case that 's not
clear, here's what happens:
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The above is equivalent to this:

answer = 10 + 20;

But Java already knows what is inside of  the two variables, f irst_number and second_number, so
you can just  use the names.

Now change your print ln method slight ly to this:

System.out.print ln("Addit ion Total = " + answer );

Again, we are combining direct  text  surrounded by double quotes with a variable name. Your
coding window should look like this:

When you run your programme you should get the following in the output window:
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So our programme has done the following:

Stored one number
Stored a second number
Added these two numbers together
Stored the result  of  the addit ion in a third variable
Printed out the result

You can also use numbers direct ly. Change the answer line to this:

answer = f irst_number + second_number + 12;

Run your programme again. What printed out? Was it  what you expected?

You can store quite large numbers in the int  variable type. The maximum value is 2147483647. If
you want a minus number the lowest value you can have is -2147483648. If  you want larger or
smaller numbers you can use another number variable type: double. You'll meet them in the next
part  of  the course.

<-- Sharing your Programmes | Double Variables -->
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The Double Variable
 

The double variable can hold very large (or small)
numbers. The maximum and minimum values are
17 followed by 307 zeros.

The double variable is also used to hold f loat ing
point  values. A f loat ing point  value is one like 8.7,
12.5, 10.1. In other words, it  has a "point
something" at  the end. If  you try to store a
f loat ing point  value in an int  variable, NetBeans
will underline the faulty code. If  you try to run the
programme, the compiler will throw up an error
message.

Let 's get some pract ise using doubles.

Change the int  f rom your previous code to
double. So change this:

int  f irst_number, second_number, answer;

to this:

double f irst_number, second_number, answer;

Now change the values being stored:
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f irst_number = 10.5;
second_number = 20.8;

Leave the rest  of  the programme as it  is. Your coding window should look like this:

Run your programme again. The output window should look like this:

Try changing the values stored in f irst_number and second_number. Use any values you like. Run
your programme and see what happens.

In the next part , you'll learn about two more Java variable types: short  and f loat .

<-- Integer Variables | Short  and Float -->
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Short and Float Variables
 

Two more variable types you can use are short
and f loat . The short  variable type is used to
store smaller number, and its range is between
minus 32,768 and plus 32,767. Instead of  using
int  in our code on the previous pages, we could
have used short  instead. You should only use
short  if  you're sure that the values that you want
to hold don't  go above 32, 767 or below -32,768.

The double value we used can store really big
numbers of  the f loat ing point  variety. Instead of
using double, f loat  can be used. When storing a
value in a f loat  variable, you need the let ter "f" at
the end. Like this:

f loat  f irst_number, second_number, answer;

f irst_number = 10.5f;
second_number = 20.8f;

So the let ter "f" goes af ter the number but before the semicolon at  the end of  the line. To see
the dif ference between f loat  and double, see below.
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Simple Arithmetic

With the variables you've been using, you can use the following symbols to do calculat ions:

+ (the plus sign)
- (the minus sign)
* (the mult iplicat ion sign is the asterisk sign)
/ (the divide sign is the forward slash)

Try this exercise:

Delete the plus symbol that  is used to add f irst_number and second_number. Replace it  with the
symbols above, f irst  the minus sign, then the mult iplicat ion sign, and then the divide. The answer
to the f inal one, the divide, should give you a really big number.

The number you should get for divide is 0.5048076923076923. This is because you used the
double variable type. However, change the double to f loat . Then add the let ter "f" to the end of
the numbers. So your code should look like this:

When you run the above code, the answer is now 0.5048077. Java has taken the f irst  6 numbers
after the point  and then rounded up the rest . So the double variable type can hold more numbers
than f loat . (Double is a 64 bit  number and f loat  is only 32 bit .)

In the next lesson, you'll learn about the importance of  Operator Precedence.

<-- Double Variables | Operator Precedence -->
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Operator Precedence

You can, of  course, calculate using more than two numbers in Java. But you need to take care of
what exact ly is being calculated. Take the following as an example:

f irst_number = 100;
second_number = 75;
third_number = 25;

answer = f irst_number - second_number + third_number;

If  you did the calculat ion lef t  to right  it  would be 100 - 75, which is 25. Then add the third number,
which is 25. The total would be 50. However, what if  you didn't  mean that? What if  you wanted to
add the second and third numbers together, and then deduct the total f rom the f irst  number? So
75 + 25, which is 100. Then deduct that  f rom the f irst  number, which is 100. The total would now
be 0.

To ensure that Java is doing what you want, you can use round brackets. So the f irst  calculat ion
would be:

answer = (f irst_number - second_number) + third_number;

Here's the coding window so that you can try it  out :
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The second calculat ion is this:

answer = f irst_number - (second_number + third_number);

And here's the code window:

Now let 's t ry some mult iplicat ion and addit ion.

Change your math symbols (called Operators) to plus and mult iply:

answer = f irst_number + second_number * third_number;

Delete all your round brackets, and then run your programme.
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With no brackets, you'd think Java would calculate f rom lef t  to right . So you'd think it  would add
the f irst  number to the second number to get 175. Then you'd think it  would mult iply by the third
number, which is 25. So the answer would be 4375. Run the programme, though. The answer that
you actually get is 1975! So what 's going on?

The reason Java got the "wrong" answer was because of  Operator Precedence. Java treats
some mathematical symbols as more important than others. It  sees mult iplicat ion as having a
priority over addit ion, so it  does this f irst . It  then does the addit ion. So Java is doing this:

answer = f irst_number + (second_number * third_number);

With the round brackets in place, you can see that second number is being mult iplied by third
number. The total is then added to the f irst  number. So 75 mult iplied by 25 is 1875. Add 100 and
you get 1975.

If  you want it  the other way round, don't  forget to "tell" Java by using round brackets:

answer = (f irst_number + second_number) * third_number;

Division is similar to mult iplicat ion: Java does the dividing f irst , then the addit ion or subtract ion.
Change your answer line to the following:

answer = f irst_number + second_number / third_number;

The answer you get is 103. Now add some round brackets:

answer = (f irst_number + second_number) / third_number;

The answer this t ime will be 7. So without the round brackets, Java does the dividing f irst , and
then adds 100 to the total - it  doesn't  work f rom lef t  to right .

Here's a list  on Operator Precedence

Mult iply and Divide - Treated equally, but  have priority over Addit ion and Subtract ion
Add and Subtract  - Treated equally but have a lower priority than mult iplicat ion and division

So if  you think Java is giving you the wrong answer, remember that Operator Precedence is
important, and add some round brackets.

In the next part , we'll take a look at  how to store text  values using Java.
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<-- Short  and Float Variables | String Variables -->
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As well as storing number values, variables can hold text . You can store just  one character, or lots
of  characters. To store just  one character, the char variable is used. Usually, though, you'll want to
store more than one character. To do so, you need the string variable type.

Start  a new project  for this by clicking File > New Project  f rom the menu bar at  the top of
NetBeans. When the New Project  dialogue box appears, make sure Java and Java Applicat ion
are selected:
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Click Next  and type StringVars as the Project  Name. Make sure there is a t ick in the box for
Create Main Class. Then delete Main af ter stringvars, and type StringVariables instead, as in
the following image:
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So the Project  Name is StringVars, and the Class name is StringVariables. Click the Finish
button and your coding window will look like this (we've deleted all the default  comments). Not ice
how the package name is all lowercase (stringvars) but the Project  name was StringVars.

To set up a string variable, you type the word String followed by a name for your variable. Note
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To set up a string variable, you type the word String followed by a name for your variable. Note
that there's an uppercase "S" for String. Again, a semicolon ends the line:

String f irst_name;

Assign a value to your new string variable by typing an equals sign. After the equals sign the text
you want to store goes between two sets of  double quotes:

f irst_name = "William";

If  you prefer, you can have all that  on one line:

String f irst_name = "William";

Set up a second string variable to hold a surname/family name:

String family_name = "Shakespeare";

To print  both names, add the following print ln( ):

System.out.print ln( f irst_name + " " + family_name );

In between the round brackets of  print ln, we have this:

f irst_name + " " + family_name

We're saying print  out whatever is in the variable called f irst_name. We then have a plus symbol,
followed by a space. The space is enclosed in double quotes. This is so that Java will recognise
that we want to print  out a space character. Af ter the space, we have another plus symbol,
followed by the family_name variable.

Although this looks a bit  messy, we're only print ing out a f irst  name, a space, then the family
name. Your code window should look like this:
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Run your programme and you should see this in the Output window:

If  you are storing just  a single character, then the variable you need is char (lowercase "c"). To
store the character, you use single quotes instead of  double quotes. Here's our programme
again, but this t ime with the char variable:

If  you try to surround a char variable with double quotes, NetBeans will underline the of fending
code in red, giving you "incompat ible type" errors. You can, however, have a String variable with
just  a single character. But you need double quotes. So this is OK:

String f irst_name = "W";

But this is not:
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String f irst_name = 'W';

The second version has single quotes, while the f irst  has double quotes.

There are lot  more to strings, and you'll meet them again later. For now, let 's move on and get
some input f rom a user.

<-- Operator Precedence | User Input -->
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Accepting Input from a User

One of the strengths of  Java is the huge libraries of  code available to you. This is code that has
been writ ten to do specif ic jobs. All you need to do is to reference which library you want to use,
and then call a method into act ion. One really useful class that handles input f rom a user is called
the Scanner class. The Scanner class can be found in the java.ut il library. To use the Scanner
class, you need to reference it  in your code. This is done with the keyword import .

import  java.ut il.Scanner;

The import  statement needs to go just  above the Class statement:

import  java.ut il.Scanner;

public class StringVariables {

}

This tells java that you want to use a part icular class in a part icular library - the Scanner class,
which is located in the java.ut il library.

The next thing you need to do is to create an object  f rom the Scanner class. (A class is just  a
bunch of  code. It  doesn't  do anything unt il you create a new object  f rom it .)
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To create a new Scanner object  the code is this:

Scanner user_input = new Scanner( System.in );

So instead of  set t ing up an int  variable or a String variable, we're set t ing up a Scanner variable.
We've called ours user_input . Af ter an equals sign, we have the keyword new. This is used to
create new objects f rom a class. The object  we're creat ing is f rom the Scanner class. In between
round brackets we have to tell java that this will be System Input (System.in).

To get the user input, you can call into act ion one of  the many methods available to your new
Scanner object . One of  these methods is called next . This gets the next string of  text  that  a user
types on the keyboard:

String f irst_name;
f irst_name = user_input.next( );

So after our user_input object  we type a dot. You'll then see a popup list  of  available methods.
Double click next  and then type a semicolon to end the line. We can also print  some text  to
prompt the user:

String f irst_name;
System.out.print("Enter your f irst  name: ");
f irst_name = user_input.next( );

Notice that we've used print  rather than print ln like last  t ime. The dif ference between the two is
that print ln will move the cursor to a new line af ter the output, but  print  stays on the same line.

We'll add a prompt for a family name, as well:

String family_name;
System.out.print("Enter your family name: ");
family_name = user_input.next( );

This is the same code, except that  java will now store whatever the user types into our
family_name variable instead of  our f irst_name variable.

To print  out the input, we can add the following:

String full_name;
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full_name = f irst_name + " " + family_name;

System.out.print ln("You are " + full_name);

We've set up another String variable, full_name. We're storing whatever is in the two variables
f irst_name and family_name. In between the two, we've added a space. The f inal line prints it  all
out  in the Output window.

So adapt your code so that it  matches that in the next image:

Run your programme unt il your Output window displays the following:
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Java is now pausing unt il you enter something on your keyboard. It  won't  progress unt il you hit
the enter key. So lef t  click af ter "Enter your f irst  name:" and you'll see your cursor f lashing away.
Type a f irst  name, and then hit  the enter key on your keyboard.

After you hit  the enter key, java will take whatever was typed and store it  in the variable name to
the lef t  of  the equals sign. For us, this was the variable called f irst_name.

The programme then moves on to the next line of  code:

Type a family name, and hit  the enter key again:

The user input has now f inished, and the rest  of  the programme executes. This is the output of
the two names. The f inal result  should like this:
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So we used the Scanner class to get input f rom a user. Whatever was typed was stored in
variables. The result  was then printed to the Output window.

In the next part , we'll take a brief  look at  Opt ion Panes.

<-- String Variables | Java Opt ion Panes -->
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Java Option Panes

Another useful class for accept ing user input, and displaying results, is the JOpt ionPane class.
This is located in the javax.swing library. The JOpt ionPane class allows you to have input boxes
like this one:

And message boxes like this:
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Let 's adapt our code from the previous sect ion and have some opt ion panes.

The f irst  thing to do is to reference the library we want to use:

import  javax.swing.JOptionPane;

This tells java that we want to use the JOpt ionPane class, located in the javax.swing library.

You can start  a new project  for this, if  you prefer not to adapt your previous code. (You should
know how to create a new project  by now. Just remember to change the name of the Class f rom
Main to something else. We're going to have the class name InputBoxes for ours. Our package
name will be userinput.)

Add the import  line to your new project , and your code window should look like something like
this:

(The reason for the wavy underline is that  we haven't  used the JOpt ionPane class yet. It  will go
away once we do.)

To get an input box that the user can type into, we can use the showInputDialog method of
JOpt ionPane. We'll store the input straight into a f irst  name variable again, just  like last  t ime. So
add the following line to your main method:

String f irst_name;
f irst_name = JOptionPane.showInputDialog("First  Name");

As soon as you type a full stop af ter JOpt ionPane you will see the following popup list :
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Double click showInputDialog. In between the round brackets of  showInputDialog type the
message that you want displayed above the input text  box. We've typed "First  name". Like all
strings, it  needs to go between double quotes.

Add the following code so that we can get the user's family name:

String family_name;
family_name = JOptionPane.showInputDialog("Family Name");

Join the two together, and add some text :

String full_name;
full_name = "You are " + f irst_name + " " + family_name;

To display the result  in a message box, add the following:

JOptionPane.showMessageDialog( null, full_name );

This t ime, we want showMessageDialog f rom the popup list . In between the round brackets we
f irst  have the word null. This is a java keyword and just  means that the message box is not
associated with anything else in the programme. After a comma comes the text  we want to
display in the message box. The whole of  your code should look like this:
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Notice the line at  the bottom of the code:

System.exit (0);

As its name suggests, this ensures that the programme exits. But it  also t idies up for us, removing
all the created objects f rom memory.

Now run your code. (Another quick way to run your programme in NetBeans is by right-clicking
anywhere inside of  the coding window. From the menu that appears, select  Run File.)

You'll see the First  Name input box. Type something into it , then click OK:
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When the Family Name input box appears, type a family name and click OK:

After you click OK, the message box will display:

Click OK to end the programme.

Exercise
Input boxes and Message boxes can be formatted further. Try the following for your Input boxes:

showInputDialog("First  Name", "Enter Your First  Name");

showInputDialog("Family", "Enter Your Family Name");
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Exercise
For your Message boxes try this (yours should be on one line):

showMessageDialog(null, full_name, "Name", JOptionPane.INFORMATION_MESSAGE);

Exercise
Instead of  JOpt ionPane.INFORMATION_MESSAGE try these:

ERROR_MESSAGE
PLAIN_MESSAGE

QUESTION_MESSAGE
WARNING_MESSAGE

Exercise
Input boxes are not just  used for text : they can accept numbers as well. Write a programme that
prompts the user for two numbers, the breadth of  a rectangle and the height of  a rectangle. Use
a message box to calculate the area of  the rectangle. (Remember: the area of  a rectangle is its
breadth mult iplied by the height.) However, you'll need some extra help for this exercise.

Help for the Exercise
You have to use the String variable to get your numbers f rom the user:

String breadth;
breadth = JOptionPane.showInputDialog("Rectangle Breadth");

However, you can't  mult iply two strings together. You need to convert  the Strings to integers. You
can convert  a string to an integer like this:

Integer.parseInt( string_to_convert  )

So you type Integer then a full stop. After the stop, type parseInt( ). In between the round
brackets of  parseInt , type the name of the string variable you're t rying to convert .

Set up an int  variable for the area. You can then mult iply and assign on the same line;

int  area = Integer.parseInt( string_one ) * Integer.parseInt( string_two);

For the message box, use concatenat ion:
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"answer = " + area

You can use any of  the MESSAGE symbols for your message box.

Exercise
The programme will crash if  you enter f loat ing point  values for the breadth and height. How
would you solve this?

When you have solved the above exercise, do you really want Integer.parseInt? What else do you
think you can use?

OK, we'll move on now. Let 's t ry some IF statements.

<-- User Input  | Java IF Statements -->
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Conditional Logic - If Statements
 

The programming you're doing now is sequent ial
programming, meaning the code is executed
from top to bottom. It 's very linear, in that  each
and every line of  code will be read, start ing with
the f irst  line of  code you write and ending at  the
last  line.

But you don't  always want your programmes to
work like that. Often, you want code to be
executed only if  certain condit ions are met. For
example, you might want one message to display
if  a user is below the age of  18 and a dif ferent
message if  he or she is 18 or older. You want to
control the f low of  the programme for yourself .
You can do this with condit ional logic.

Condit ional logic is mainly about the IF word: IF user is less than 18 then display this message; IF
user is 18 or older then display that message. Fortunately, it 's very easy to use condit ional logic in
Java. Let 's start  with IF Statements.

 

IF Statements

Execut ing code when one thing happens rather than something else is so common in
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programming that that  the IF Statement has been developed. The structure of  the IF Statement
in Java is this:

if  ( Statement  ) {

}

You start  with the word IF (in lowercase) and a pair of  round brackets. You then use a pair of  curly
brackets to sect ion of f  a chunk of  code. This chunk of  code is code that you only want to
execute IF your condit ion is met. The condit ion itself  goes between round brackets:

if  ( user < 18 ) {

}

This condit ion says "IF user is less than 18". But instead of  saying "is less than" we use the
shorthand notat ion of  the lef t -point ing angle bracket ( < ). IF the user is less than 18 then we
want something to happen, to display a message, for example:

if  ( user < 18 ) {

//DISPLAY MESSAGE

}

If  the user is not less than 18 then the code between the curly brackets will be skipped, and the
programme cont inues on its way, downwards towards the last  line of  code. Whatever you type
between the curly brackets will only be executed IF the condit ion is met, and this condit ion goes
between the round brackets.

Before we try this out, another shorthand notat ion is this symbol >. The right-point ing angle
bracket means "greater than". Our IF Statement above can be amended slight ly to check for
users who are greater than 18:

if  ( user > 18 ) {

//DISPLAY MESSAGE

}
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The only thing new in this code is the > symbol. The condit ion now checks for users who are
greater than 18.

But the condit ion doesn't  check for people who are exact ly 18, just  those greater than 18. If  you
want to check for those who are 18 or over, you can say "greater than or equal to". The symbols
for this are the greater than sign ( > ) followed by an equals sign ( = ):

if  ( user >= 18 ) {

//DISPLAY MESSAGE

}

You can also check for "less than or equal to" in a similar way:

if  ( user <= 18 ) {

//DISPLAY MESSAGE

}

The above code contains a less than symbol ( < ) followed by the equals sign.

Let 's t ry all this out in a simple programme.

Start  a new project  by clicking File > New Project  f rom the menu bar in NetBeans. You can call
your package and class names anything you like. Enter the following code (our package name is
condit ionallogic and the Class is called IFStatements):
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We've set up an integer variable, and assigned a value of  17 to it . The IF statement checks for
"less than 18". So the message between the curly brackets should be printed out.

Run your programme and check it  out . (NetBeans has a habit  of  running the programme in bold
text  in the Projects window and not the code you have displayed. To run the code in your coding
window, right  click anywhere in the code. From the menu that appears select  Run File.) You should
see this in your Output window:

Now change the value for the user variable f rom 17 to 18. Run your programme again. You should
see this:
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So the programme runs OK, with no error messages. It 's just  that  nothing gets printed out. The
reason is that  the message code is between the curly brackets of  the IF Statement. And the IF
Statement is checking for values less than 18. IF the condit ion is not met, Java ignores the curly
brackets altogether and moves on.

Exercise
Replace your "less than" symbol with the "less than or equal to" symbols. Change your message
to suit , something like "user is less than or equal to 18". Run your programme again. Do you see
the message?

Exercise
Change the user value to 20. Run your programme again. Do you st ill see the message?

You can have more than one IF Statement in your code. Try the following code:
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This t ime, we have two IF Statements. The f irst  tests for values less than or equal to 18. The
second tests for values greater than 18. When the code is run with a value of  18 or less for the
user variable, the Output is this:

Changing the value of  the user variable to 20 gives this:
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So only one of  the IF Statements will Output a print  line. And it  all depends on what the value of
the user variable is.

 

In the next part , we'll cont inue with Condit ional Logic

<-- Opt ion Panes | If  ... Else -->
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IF … ELSE

Instead of  using two IF Statements, you can use an IF … ELSE Statement instead. Here's the
structure of  an IF … ELSE statement:

if  ( condit ion_to_test  ) {

}
else {

}

The f irst  line starts with if , followed by the condit ion you want to test  for. This goes between two
round brackets. Again, curly brackets are used to sect ion of f  the dif ferent choices. The second
choice goes af ter the word else and between its own curly brackets. Here's our code again that
checks a user's age:
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So there are only two choices here: either the user is 18 or younger, or the user is older than that.
Adapt your code to match that in the image above and try it  out . You should f ind that the f irst
message prints out. Now change the value of  the user variable to 20 and run the code again. The
message between the ELSE curly brackets should display in the Output window.

 

IF … ELSE IF

You can test  for more than two choices. For example, what if  we wanted to test  for more age
ranges, say 19 to 39, and 40 and over? For more than two choices, the IF … ELSE IF statement
can be used. The structure of  an IF … ELSE IF is this:

if  ( condit ion_one ) {

}
else if  ( condit ion_two  ) {

}
else {

}

The new part  is this:

else if  ( condit ion_two ) {
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}

So the f irst  IF tests for condit ion number one (18 or under, for example). Next comes else if ,
followed by a pair of  round brackets. The second condit ion goes between these new round
brackets. Anything not caught by the f irst  two condit ions will be caught be the f inal else. Again,
code is sect ioned of f  using curly brackets, with each if , else if , or else having its own pair of  curly
brackets. Miss one out and you'll get  error messages.

Before t rying out some new code, you'll need to learn some more condit ional operators. The
ones you have used so far are these:

> Greater Than
< Less Than
>= Greater Than or Equal To
<= Less Than or Equal To

Here's four more you can use:

&& AND
|| OR
== HAS A VALUE OF
! NOT

The f irst  one is two ampersand symbols, and is used to test  for more than one condit ion at  the
same t ime. We can use it  to test  for two age ranges:

else if  ( user > 18 && user < 40 )

Here, we want to check if  the user is older than 18 but younger than 40. Remember, we're t rying
to check what is inside of  the user variable. The f irst  condit ion is "Greater than 18" ( user > 18 ).
The second condit ion is "Less than 40" ( user < 40). In between the two we have our AND
operator ( &&). So the whole line says "else if  user is greater than 18 AND user is less than 40."

We'll get  to the other three condit ional operators in a moment. But here's some new code to t ry
out:
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Run your programme and test  it  out . You should be able to guess what it  will print  out before
running it . Because we have a value of  21 for the user variable the message between the curly
brackets of  else if  will display in the Output window.

Exercise
Change the value of  the user variable f rom 21 to 45. The message for the else sect ion of  the
code should now display.

You can add as many else if  parts as you want. Suppose we wanted to check if  the user was
either 45 or 50. We can use two of  the new condit ional operators above. We can check if  the
user variable "has a value of  45" OR "has a value of  50":

else if  (user == 45 || user == 50)

To test  if  the user variable has a value of  something you use two equal signs, with no space
between them. Java will test  for that  value and no other values. Because want to test  for the
user being 50 as well, we can have another condit ion in the same round brackets: user == 50.
This just  says "test  if  the user variable has a value of  50". In between the two condit ions, we have
the OR operator. This is two pipe characters, which is just  to the lef t  of  the let ter "z" on a UK
keyboard. Again, there's no space between the two. The whole of  the line above says "Else if  the
user has a value of  45 OR the user has a value of  50".
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Here's our code with the new else if  part :

Try it  out  for yourself . Change the value of  the user variable to 45 and run your code. Then
change it  to 50 and run the code again. In both cases the new message should display.

The various condit ional operators can be tricky to use. But you're just  test ing a variable for a
part icular condit ion. It 's simply a quest ion of  picking the right  condit ional operator or operators
for the job.

 

Nested IF Statements

You can nest IF Statements. (This also applies to IF ... ELSE and IF ... ELSE IF statements.) Nest ing
an IF Statement just  means putt ing one IF Statement inside of  another. For example, suppose
you want to f ind out if  somebody is younger than 18, but older than 16. You want to display a
dif ferent message for the over 16s. You start  with the f irst  IF Statement:

if  ( user < 19 ) {
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System.out.print ln( "18 or younger");
}

To check for over 16, you can place a second IF Statement inside of  the one you already have.
The format is the same:

if  ( user < 19 ) {
if  ( user > 16 && user < 19  ) {

System.out.print ln( "You are 17 or 18");
}

}

So the f irst  IF Statement catches the user variable if  it 's less than 19. The second IF Statement
narrows the user variable down even further, for ages over 16 and under 19. To print  dif ferent
messages, you can have an IF ... ELSE statement instead of  the IF Statement above:

if  ( user < 19 ) {

if  ( user > 16 && user < 19  ) {
System.out.print ln( "You are 17 or 18");

}
else {

System.out.print ln( "16 or younger");
}

}

Notice where all the curly brackets are in the code: get one wrong and your programme won't  run.

Nested IF Statements can be tricky, but all you're t rying to do is to narrow down the choices.

In the next sect ion, you'll about the Boolean variable type.

<-- If  Statements | Boolean Values -->
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Boolean Values

A Boolean value is one with two choices: t rue or false, yes or no, 1 or 0. In Java, there is a variable
type for Boolean values:

boolean user = true;

So instead of  typing int  or double or string, you just  type boolean (with a lower case "b"). Af ter
the name of you variable, you can assign a value of  either t rue or false. Not ice that the
assignment operator is a single equals sign ( = ). If  you want to check if  a variable "has a value of"
something, you need two equal signs ( = =).

Try this simple code:

boolean user = true;

if  ( user == true) {
System.out.print ln("it 's true");

}
else {

System.out.print ln("it 's false");
}

So the f irst  IF Statement checks if  the user variable has a value of  t rue. The else part  checks if  it
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is false. You don't  need to say "else if  ( user = = false)". Af ter all, if  something is not t rue then it 's
false. So you can just  use else: there's only two choices with boolean values.

The only other condit ional operator on our lists is the NOT operator. You can use this with
boolean values. Have a look at  the following code:

boolean user = true;

if  ( !user ) {
System.out.print ln("it 's f lase");

}
else {

System.out.print ln("it 's true");
}

It 's almost the same as the other boolean code, except for this line:

if  ( !user ) {

This t ime, we have our NOT operator before the user variable. The NOT operator is a single
exclamat ion mark ( ! ) and it  goes before the variable you're tying to test . It 's test ing for negat ion,
which means that it 's test ing for the opposite of  what the value actually is. Because the user
variable is set  to t rue then !user will test  for false values. If  user was set to false then !user would
test  for t rue values. Think of  it  like this: if  something is NOT true then what is it? Or if  it 's NOT
false then what?

In the next part , we'll look at  Java Switch Statements.

<-- If  Else Statements | Java Switch Statements -->
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Switch Statements in Java

Another way to control the f low of  your programmes is with something called a switch
statement. A switch statement gives you the opt ion to test  for a range of  values for your
variables. They can be used instead of  long, complex if  … else if  statements. The structure of
the switch statement is this:

switch ( variable_to_test  ) {
case value: 

code_here;
break;

case value: 
code_here;
break;

default :
values_not_caught_above;

}

So you start  with the word switch, followed by a pair of  round brackets. The variable you want to
check goes between the round brackets of  switch. You then have a pair of  curly brackets. The
other parts of  the switch statement all go between the two curly brackets. For every value that
you want to check, you need the word case. You then have the value you want to check for:
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case value:

After case value comes a colon. You then put what you want to happen if  the value matches.
This is your code that you want executed. The keyword break is needed to break out of  each
case of  the switch statement.

The default  value at  the end is opt ional. It  can be included if  there are other values that can be
held in your variable but that  you haven't  checked for elsewhere in the switch statement.

If  all of  that  is confusing, here's some code to t ry out. You can either start  a new project  for this,
or just  comment out the code you have. A quick way to comment out code in NetBeans is f rom
the toolbar at  the top. First , highlight  the code you want to comment out. Then click the
comment icon:

But here's the code:
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The f irst  thing the code does is to set  a value to test  for. Again, we've set up an integer variable
and called it  user. We've set the value to 18. The switch statement will check the user variable
and see what 's in it . It  will then go through each of  the case statements in turn. When it  f inds one
that matches, it  will stop and execute the code for that  case. It  will then break out of  the switch
statement.

Try the programme out. Enter various values for the user variable and see what happens.

Sadly, you can't  test  for a range of  values af ter case, just  the one value. So you can't  do this:

case (user <= 18):

But you can do this:

case 1: case 2: case 3: case 4:

So the above line tests for a range of  values, f rom 1 to 4. But you have to "spell out" each value.
(Not ice where all the case and colons are.)
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To end this sect ion on condit ional logic, t ry these exercises.

 

Exercise
Write a programme that accepts user input f rom the console. The programme should take a
number and then test  for the following age ranges: 0 to 10, 11 to 20, 21 to 30, 30 and over.
Display a message in the Output window in the following format:

user_age + " is between 21 and 30"

So if  the user enters 27 as the age, the Output window should be this:

If  the user is 30 or over, you can just  display the following message:

"Your are 30 or over"

Help for this exercise

To get string values from the user, you did this:

String age = user_input.next( );

But the next ( ) method is used for strings. The age you are gett ing f rom the user has to be an
integer, so you can't  use next( ). There is, however, a similar method you can use: nextInt ( ).

 

Exercise
If  you want to check if  one String is the same as another, you can use a Method called equals.
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String user_name = "Bill";

if  ( user_name.equals( "Bill" )  ) {
//DO SOMETHING HERE

}

In the code above, we've set up a String variable and called it  user_name. We've then assigned a
value of  "Bill" to it . In between the round brackets of  IF we have the variable name again, followed
by a dot. Af ter the dot comes the word "equals". In between another pair of  round brackets you
type the string you're t rying to test  for.

NOTE: When checking if  one string is the same as another, they have to match exact ly. So "Bill" is
dif ferent f rom "bill". The f irst  has an uppercase let ter "B" and the second has a lowercase "b".

For this exercise, write a programme that asks a user to choose between four colours: black,
white, red, or blue. Use IF … ELSE IF statements to display one of  the following messages,
depending on which colour was chosen:

BLACK "You must be a Goth!"
WHITE "You are a very pure person"
RED "You are fun and outgoing"
BLUE "You're not a Chelsea fan, are you?"

When your programme ends, the Output window should look like something like this:

 

OK, let 's move on and have a look at  loops. We'll be upping the pace a bit  in this next sect ion, so
hang on to your hats!
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Loops in Java
 

As we ment ioned earlier, the programming you
are doing now is sequent ial programming. This
means that f low is downward, f rom top to
bottom, with every line of  code being executed,
unless you tell Java otherwise.

You saw in the last  sect ion that one way to "tell"
Java not to execute every line is by using IF
Statement to sect ion of f  areas of  code.

Another way to interrupt the f low from top to
bottom is by using loops. A programming loop is
one that forces the programme to go back up
again. If  it  is forced back up again you can
execute lines of  code repeatedly.

As an example, suppose you wanted to add up
the numbers 1 to 10. You could do it  quite easily in Java like this:

int  addit ion = 1 + 2 + 3 + 4 + 5 + 6 + 7 + 8 + 9 + 10;

But you wouldn't  really want to use that method if  you needed to add up the numbers 1 to a
1000. Instead, you can use a loop to go over a line of  code repeatedly unt il you've reached 1000.
Then you can exit  the loop and cont inue on your way.
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Java For Loops

We'll start  with For Loops, one of  the most common types of  loops. The "For" part  of  "For Loop"
seems to have lost  its meaning. But you can think of  it  like this: "Loop FOR a set  number of
t imes." The structure of  the For Loop is this:

for ( start_value; end_value; increment_number ) {

//YOUR_CODE_HERE

}

So after the word "for" (in lowercase) you have a pair of  round brackets. Inside of  the round
brackets you need three things: the start  value for the loop, the end value for the loop, and a way
to get f rom one number to another. This is called the increment number, and is usually 1. But it
doesn't  have to be. You can go up in chunks of  10, if  you want.

After the round brackets you need a pair of  curly brackets. The curly brackets are used to sect ion
off  the code that you want to execute repeatedly. An example might clear things up.

Start  a new project  for this. Call the Project  and Class anything you like. (We've called our Project
"loops", and the Class "ForLoops"). Now add the following code:
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We start  by sett ing up an integer variable, which we've called loopVal. The next line sets up
another integer variable. This variable will be used for the end value of  the loop, and is set  to 11.
What we're going to do is to loop round print ing out the numbers f rom 0 to 10.

Inside the round brackets of  the for loop, we have this:

loopVal =0; loopVal < end_value; loopVal++

The f irst  part  tells Java at  what number you want to start  looping. Here, we're assigning a value
of zero to the loopVal variable. This will be the f irst  number in the loop. The second part  uses
some condit ional logic:

loopVal < end_value

This says "loopVal is less than end_value". The for loop will then keep going round and round
while the value inside the loopVal variable is less than the value in the variable called end_value.
As long as it 's t rue that loopVal is less than end_value, Java will keep looping over the code
between the curly brackets.

The f inal part  between the round brackets of  the for loop is this:
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loopVal++

What we're doing here is telling Java how to go from the start ing value in loopVal to the next
number in the sequence. We want to count f rom 0 to 10. The next number af ter 0 is 1. loopVal++
is a shorthand way of  saying "add 1 to the value in the variable".

Instead of  saying loopVal++ we could have wrote this:

loopVal = loopVal + 1

To the right  of  the equals sign we have loopVal + 1. Java will then add 1 to whatever is current ly
stored in the loopVal variable. Once it  has added 1 to the value, it  will store the result  inside of  the
variable to the lef t  of  the equals sign. This is the loopVal variable again. The result  is that  1 keeps
gett ing added to loopVal. This is called increment ing the variable. It  is so common that the
shorthand notat ion variable++ was invented:

int  some_number = 0;
some_number++;

The value of  some_number will be 1 when the code above is executed. It  is the short  way of
saying this:

int  some_number = 0;
some_number = some_number + 1;

To recap then, our for loop is saying this:

Loop Start  value: 0
Keep Looping While: Start  value is less than 11
How to advance to the end value : Keep adding 1 to the start  value

Inside of  the curly brackets of  the for loop we have this:

System.out.print ln("Loop Value = " + loopVal);

Whatever is current ly inside of  the loopVal variable will be printed out, along with some text .

Run your programme and you should see this in the Output window:
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So we've trapped the programme in a loop, and forced it  to go round and round. Each t ime round
the loop, 1 gets added to the loopVal variable. The loop keeps going round and round while the
value inside of  loopVal is less than the value in end_value. Whatever is inside of  the loop's curly
brackets is the code that will be executed over and over. And that is the whole point  of  the loop:
to execute the curly bracket code over and over.

Here's some code that adds up the numbers 1 to 10. Try it  out :
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The answer you should get in the Output window is 55. The code itself  is more or less the same
as the previous for loop. We have the same two variables set up at  the top, loopVal and
end_value. We also have a third integer variable, which we've called addit ion. This will hold the
value of  the 1 to 10 sum.

In between the round brackets of  the for loop, it 's almost the same as last  t ime: we're looping
while loopVal is less than end_value; and we're adding 1 to the loopVal variable each t ime round
the loop (loopVal++). The only dif ference is that  the start ing value is now 1 (loopVal=1).

In between the curly brackets, we only have one line of  code:

addit ion = addit ion + loopVal;

This single line of  code adds up the numbers 1 to 10. If  you're confused as to how it  works, start
to the right  of  the equals sign:

addit ion + loopVal;

The f irst  t ime round the loop, the addit ion variable is holding a value of  0. The variable loopVal,
meanwhile, is holding a value of  1 (its start ing value). Java will add 0 to 1. Then it  will store the
result  to the variable on the lef t  of  the equals sign. Again, this is the addit ion variable. Whatever
was previously being held in the addit ion variable (0) will be erased, and replaced with the new
value (1).

The second t ime round the loop, the values in the two variables are these (the values are
between round brackets):

addit ion (1) + loopVal (2);

1 + 2 is obviously 3. So this is the new value that will be stored to the lef t  of  the equals sign.

The third t ime round the loop, the new values are these:

addit ion (3) + loopVal (3);

Java adds the 3 + 3 and stores 6 to the lef t  of  the equals sign. It  keeps going round and round
unt il the loop ends. The result  is 55.

(Not ice that our print  line is outside of  the for loop, af ter the f inal curly bracket of  the loop.)
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Exercise
Change you code so that the loop adds up the numbers 1 to a 100. The answer you should get is
5050.

Exercise
Write a t imes table programme. The programme should ask a user to input a number. This number
is then used as the t imes table. So if  the user enters 10, the 10 t imes table should be displayed.
Your Output window should look something like this, when your programme is run.

 

Help for this Exercise

Your for loop only needs two lines of  code between the curly brackets, and one of  those is the
print  line. You only need a single line to calculate the answers for your t imes table.

You should already know how to get the number f rom the user. This can be used in your loop's
curly brackets to work out the answer to your mult iplicat ion.

Your t imes table only needs to go from 1 to 10, like ours does in the image above.

Exercise
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Use a for loop to print  out the odd numbers f rom 1 to 10. (For the easy way to do this exercise,
think about the increment value of  the loop, which is the third item between the round brackets.)

One of  the hard ways to do the exercise above is by using an operator you haven't  yet  met - the
modulus operator. Modulus is when you divide by a number and keep the remainder. So 10 Mod 3
is 1, because 10 divide by 3 is 3. The remainder is 1, and that 's what you keep. The Modulus
operator in Java is the percentage sign, rather confusingly. It 's used like this:

int  remainder;
int  total = 10
remainder = total %3

So the number (or variable) you want to divide up goes f irst . You then type a percentage sign,
followed by your divider number. The answer is the remainder.

In the exercise above, you could use 2 as the Mod number, and then use an IF Statement in your
for loop to test  what the remainder is. (Can you see why 2 should be the Mod number?)

In the next part , we'll take a look at  Java while loops.

<-- Switch Statements | While Loops -->
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While Loops

Another type of  loop you can use in Java is called the while loop. While loops are a lot  easier to
understand than for loops. Here's what they look like:

while ( condit ion ) {

}

So you start  with the word "while" in lowercase. The condit ion you want to test  for goes between
round brackets. A pair of  curly brackets comes next, and the code you want to execute goes
between the curly brackets. As an example, here's a while loop that prints out some text  (Try the
code out for yourself ):

int  loopVal = 0;

while ( loopVal < 5) {
System.out.print ln("Print ing Some Text");
loopVal++;

}

The condit ion to test  is between the round brackets. We want to keep looping while the variable
called loopVal is less than 5. Inside of  the curly brackets our code f irst  prints out a line of  text .
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Then we need to increment the loopVal variable. If  we don't  we'll have an inf inite loop, as there is
no way for loopVal to get beyond its init ial value of  0.

Although we've used a counter (loopVal) to get to the end condit ion, while loops are best used
when you don't  really need a count ing value, but rather just  a checking value. For example, you
can keep looping while a key on the keyboard is not pressed. This is common in games
programme. The let ter "X" can pressed to exit  the while loop (called the game loop), and hence
the game itself . Another example is looping round a text  f ile while the end of  the f ile has not been
reached.

 

Do ... While

Related to the while loop is the do … while loop. It  looks like this:

int  loopVal = 0;

do {
System.out.print ln("Print ing Some Text");
loopVal++;

}
while ( loopVal < 5  );

Again, Java will loop round and round unt il the end condit ion is met. This t ime, the "while" part  is
at  the bottom. But the condit ion is the same - keep looping while the value inside of  the variable
called loopVal is less than 5. The dif ference between the two is the code between the curly
brackets of  do … while will get  executed at  least  once. With the while loop, the condit ion could
already be met. Java will then just  bail out  of  your loop, and not even execute your curly bracket
code. To test  this out, t ry the while loop f irst . Change the value of  your loopVal variable to 5, and
then run the code. You should f ind that the text  doesn't  get  printed. Now try the do loop with a
value of  5 for loopVal. The text  will print  once and then Java will bail out  of  the loop.

OK, we'll leave looping there. It  is a subject  you need to get grips with. But don't  worry if  you're not
completely perfect  with them - you'll learn as we go along. In the next sect ion, we'll take a look at
something called an array.

<-- Java For Loops | Arrays in Java -->
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Java Arrays
 

A programming concept you just  have to get
used to if  you're to code ef fect ively is the array.
In this sect ion, you'll learn what arrays are, and
how to use them.

 

What is an Array?

So far, you have been working with variables that
hold only one value. The integer variables you
have set up have held only one number, and the
string variables just  one long string of  text . An
array is a way to hold more than one value at  a
t ime. It 's like a list  of  items. Think of  an array as
the columns in a spreadsheet. You can have a

spreadsheet with only one column, or lots of  columns. The data held in a single-list  array might
look like this:
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Like a spreadsheet, arrays have a posit ion number for each row. The posit ions in an array start  at
0 and go up sequent ially. Each posit ion in the array can then hold a value. In the image above
array posit ion 0 is holding a value of  10, array posit ion 1 is holding a value of  14, posit ion 2 has a
value of  36, and so on.

To set up an array of  number like that in the image above, you have to tell Java what kind of  data
is going in to your array (integers, strings, boolean values, etc). You then need to say how many
posit ions the array has. You set them up like this:

int [ ] aryNums;

The only dif ference between sett ing up a normal integer variable and an array is a pair of  square
brackets af ter the data type. The square brackets are enough to tell Java that you want to set
up an array. The name of the array above is aryNums. Just like normal variables, you can call them
almost anything you like (with the same except ions we ment ioned earlier).

But this just  tells Java that you want to set  up an integer array. It  doesn't  say how many posit ions
the array should hold. To do that, you have to set  up a new array object :

aryNums = new int[6];

You start  with your array name, followed by the equals sign. After the equals sign, you need the
Java keyword new, and then your data type again. After the data type come a pair of  square
brackets. In between the square brackets you need the size of  the array. The size is how many
posit ions the array should hold.

If  you prefer, you can put all that  on one line:

int [ ] aryNums = new int[6];

So we are telling Java to set  up an array with 6 posit ions in it . Af ter this line is executed, Java will
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assign default  values for the array. Because we've set up an integer array, the default  values for
all 6 posit ions will be zero ( 0 ).

To assign values to the various posit ions in an array, you do it  in the normal way:

aryNums[0] = 10;

Here, a value of  10 is being assigned to posit ion 0 in the array called aryNums. Again, the square
brackets are used to refer to each posit ion. If  you want to assign a value of  14 to array posit ion
1, the code would be this:

aryNums[1] = 14;

And to assign a value of  36 to array posit ion 2, it 's this:

aryNums[2] = 36;

Don't  forget, because arrays start  at  0, the third posit ion in an array has the index number 2.

If  you know what values are going to be in the array, you can set them up like this instead:

int [ ] aryNums = { 1, 2, 3, 4 };

This method of  set t ing up an array uses curly brackets af ter the equals sign. In between the curly
brackets, you type out the values that the array will hold. The f irst  value will then be posit ion 0,
the second value posit ion 1, and so on. Note that you st ill need the square brackets af ter int , but
not the new keyword, or the repet it ion of  the data type and square brackets. But this is just  for
data types of  int  values, string, and char values. Otherwise, you need the new keyword. So you
can do this:

String[ ] aryStrings = {"Autumn", "Spring", "Summer", "Winter" };

But not this:

boolean[ ] aryBools = {false, true, false, true};

To set up a boolean array you st ill need the new keyword:

boolean[ ] aryBools = new boolean[ ] {false, true, false, true};
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To get at  the values held in your array, you type the name of the array followed by an array
posit ion in square brackets. Like this:

System.out.print ln( aryNums[2] );

The above code will print  out whatever value is held at  array posit ion 2 in the array called
aryNums. But let 's get some coding pract ice.

Start  a new project  and call it  anything you like. Don't  forget to change the name of the Class to
something relevant.

Type the following code into your new Main method:

When you run the programme you should see this in the Output window:
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Change the array posit ion number in the print  line f rom 2 to 5 and 18 should print  out instead.

In the next part , we'll take a look at  how to use arrays with loops.

<-- While Loops | Arrays and Loops -->
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Arrays come into their own with loops. You have seen in the previous sect ion that to assign
values to array posit ions, you did this:

aryNums[0] = 10;

But that 's not terribly pract ical if  you have a lot  of  numbers to assign to an array. As an example,
imagine a lot tery programme that has to assign the numbers 1 to 49 to posit ions in an array.
Instead of  typing a long list  of  array posit ions and values you can use a loop. Here's some code
that does just  that :
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So we set up an array to hold 49 integer values. Then comes the loop code. Not ice the end
condit ion of  the loop:

i < lottery_numbers.length

Length is a property of  array objects that you can use to get the size of  the array (how many
posit ions it  has). So this loop will keep going round and round while the value in the variable i is
less than the size of  the array.

To assign values to each posit ion in the array, we have this line:

lot tery_numbers[i] = i + 1;

Instead of  a hard-code value between the square brackets of  the array name, we have the
variable called i. This increases by 1 each t ime round the loop, remember. Each array posit ion can
then be accessed just  by using the loop value. The value that is being assigned to each posit ion is
i + 1. So again, it 's just  the incremented loop value, this t ime with 1 added to it . Because the loop
value is start ing at  0, this will give you the numbers 1 to 49.

The other line in the loop just  prints out whatever value is in each array posit ion.
(If  you wanted, you could then write code to jumble up the numbers in the array. Once you have
jumbled up the values, you could then take the f irst  6 and use them as the lot tery numbers. Write
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another chunk of  code that compares a user's 6 numbers with the winning numbers and you have
a lot tery programme!)

In the next part , you'll see how to sort  your arrays.

<-- Arrays | Sort ing Java Arrays -->
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Sorting Arrays

Other inbuilt  java methods allow you to sort  your arrays. To use the sort  method of  arrays, you
f irst  need to reference a Java library called Arrays. You do this with the import  statement. Try it
with your aryNums programme. Add the following import  statement:

import  java.ut il.Arrays;

You code should look like ours below:
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Now that you have imported the Arrays library, you can use the sort  method. It 's quite easy:

Arrays.sort( aryNums );

First  you type the word "Arrays", then a dot. As soon as you type a dot, NetBeans will display a
list  of  things you can do with arrays. Type the word "sort". In between a pair of  round brackets,
you then put the name of the array you want to sort . (Not ice that you don't  need any square
brackets af ter the array name.)

And that 's it  - that 's enough to sort  the array! Here's some code to t ry out:
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The for loop at  the end will go round and round print ing out the values in each array posit ion.
When the code is run, the Output will look like this:
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As you can see, the array has been sorted in ascending order.

Sort ing in descending order, however, is only possible either by writ ing your own sort ing code, or
convert ing your array to Integer objects then import ing f rom the Collect ions library. If  you need to
a descending sort , here's some code that does just  that  (skip this code, if  you want):
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All a bit  messy, I'm sure you'll agree!

 

In the next lesson, we'll take a look at  arrays and strings.
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<-- Arrays and Loops | Arrays and Strings -->
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Multi-Dimensional Arrays in Java

The arrays you have been using so far have only held one column of data. But you can set up an
array to hold more than one column. These are called mult i-dimensional arrays. As an example,
think of  a spreadsheet with rows and columns. If  you have 6 rows and 5 columns then your
spreadsheet can hold 30 numbers. It  might look like this:

A mult i dimensional array is one that can hold all the values above. You set them up like this:

int [ ][ ] aryNumbers = new int[6][5];

They are set up in the same way as a normal array, except you have two sets of  square brackets.
The f irst  set  of  square brackets is for the rows and the second set of  square brackets is for the
columns. In the above line of  code, we're telling Java to set  up an array with 6 rows and 5
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columns. To hold values in a mult i-dimensional array you have to take care to t rack the rows and
columns. Here's some code to f ill the f irst  rows of  numbers f rom our spreadsheet image:

aryNumbers[0][0] = 10;
aryNumbers[0][1] = 12;
aryNumbers[0][2] = 43;
aryNumbers[0][3] = 11;
aryNumbers[0][4] = 22;

So the f irst  row is row 0. The columns then go from 0 to 4, which is 5 items. To f ill the second row,
it  would be this:

aryNumbers[1][0] = 20;
aryNumbers[1][1] = 45;
aryNumbers[1][2] = 56;
aryNumbers[1][3] = 1;
aryNumbers[1][4] = 33;

The column numbers are the same, but the row numbers are now all 1.

To access all the items in a mult i-dimensional array the technique is to use one loop inside of
another. Here's some code to access all our number f rom above. It  uses a double for loop:

The f irst  for loop is used for the rows; the second for loop is for the columns. The f irst  t ime
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round the f irst  loop, the value of  the variable i will be 0. The code inside of  the for loop is another
loop. The whole of  this second loop will be executed while the value of  the variable i is 0. The
second for loop use a variable called j. The i and the j variables can then be used to access the
array.

aryNumbers[ i ][ j ]

So the two loop system is used to go through all the values in a mult i-dimensional array, row by
row.

 

Exercise
Finish of f  the programme above where we are writ ing a programme to print  out all the values from
the spreadsheet. Your Output window should look something like this when you're done:

Mult i-dimensional arrays can be quite t ricky, but mainly because it 's hard to keep track of  all your
rows and columns! In the next part , you'll learn about array lists.

<-- Arrays and Strings | Array Lists in Java -->
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Array Lists in Java

If  you don't  know how many items are going to be held in your array, you may be better of f  using
something called an ArrayList . An ArrayList  is a dynamic data structure, meaning items can be
added and removed from the list . A normal array in java is a stat ic data structure, because you
stuck with the init ial size of  your array.

To set up an ArrayList , you f irst  have to import  the package from the java.ut il library:

import  java.ut il.ArrayList;

You can then create a new ArrayList  object :

ArrayList  listTest  = new ArrayList( );

Notice that you don't  need any square brackets this t ime.

Once you have a new ArrayList  objects, you can add elements to it  with the add method:

listTest .add( "f irst  item" );
listTest .add( "second item" );
listTest .add( "third item" );
listTest .add( 7 );
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In between the round brackets of  add you put what it  is you want to add to the ArrayList . You can
only add objects, however. The f irst  three items we've added to the list  above are String objects.
The fourth item is a number. But this will be a number object  of  type Integer, rather than the
primit ive data type int .

Items in the list  can be referenced by an Index number, and by using the get method:

listTest .get( 3 )

This line will get  the item at Index posit ion 3 on the list . Index numbers start  count ing at  zero, so
this will be the fourth item.

You can also remove items from an ArrayList . You can either use the Index number:

listTest .remove(2);

Or you can use the value on the list :

listTest .remove( "second item" );

Removing an item will resize the ArrayList , so you have to be careful when trying to get an item
on the list  when using its Index number. If  we've removed item number 2, then our list  above will
contain only 3 items. Trying to get the item with the Index number 3 would then result  in an error.

To go through each item in your ArrayList  you can set up something called an Iterator. This class
can also be found in the java.ut il library:

import  java.ut il.Iterator;

You can then at tach your ArrayList  to a new Iterator object :

Iterator it  = listTest .iterator( );

This sets up a new Iterator object  called it  that  can be used to go through the items in the
ArrayList  called listTest. The reason for using an Iterator object  is because it  has methods called
next and hasNext. You can use these in a loop:

while ( it .hasNext( ) ) {
System.out.print ln( it .next( ) );

}
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The method hasNext returns a Boolean value. The value will be false if  there are no more items in
the ArrayList . The next method can be used to go through all the items in the list .

To test  all this theory out, t ry the following code:

Not ice the line that prints out the ent ire list :

System.out.print ln( "Whole list=" + listTest  );

This gives you a quick way to see which items are on your list , if  it  gets a bit  too long.

When the code is run, the Output window will display the following:

f irst  item
second item
third item
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7
Whole list=[f irst  item, third item, 7]
Posit ion 1=third item

To sum up, then, use an ArrayList  when you're not sure how many elements are going to be in a
list  of  items.

We'll leave arrays, for now, and move on. In the next sect ion, we'll tackle strings.

<-- Mult i-Dimensional Arrays | Java Strings -->
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More on Java Strings
 

There's more to strings than meets the eye.
Unlike int  variables, or double variables, strings
are objects. What this means in pract ice is that
you can do things with strings of  text  that  you
can't  do with int  or double variables. (The same
applies to the primit ive data types boolean, byte,
single, char, f loat , long and short : they are not
objects like strings are.)

Before we get to manipulat ing strings of  text ,
here's some basic informat ion on what strings
actually are.

 

How Java Stores Strings

A string is a series of  Unicode characters held under a variable name. Take the following string:

String someText = "Bill";

This tells Java to set  up a string object  with the four characters "B", "i", "l" and another "l". In the
Unicode character set , these values are: \u0042, \u0069, \u006c, \u006c. Unicode values are
stored as hexadecimals numbers. Capital let ters (A to Z) are stored using the values \u0041 to
\u005a, while lowercase let ters (a to z) are stored using the hexadecimals values \u0061 to
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\u007a.

In the previous sect ion, we had an array which held strings of  text . We then sorted the array:

When the programme is run, the output is this:
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We noted that the word "This" comes f irst . If  the array is supposed to be sorted alphabet ically,
however, you would expect the word "a" to come f irst . The reason it  doesn't  is because
lowercase "a" has a hexadecimal value of  u\0061, which is the decimal number 97. But uppercase
"T" has a hexadecimal value of  u\0054, which is the decimal number 84. 84 is lower than 97, so
the "T" comes f irst .

OK, let 's do some work manipulat ing strings of  text . The string methods we'll take a look at  are:

toUpperCasse
toLowerCase
compareTo

IndexOf
endWith, startsWith

Substring
Equals
charAt

trim
valueOf

First  up are the easy ones, convert ing to upper and lower case let ters. You'll meet them in the
next part .

<-- Array Lists | Upper and Lower case-->
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Converting to Upper and Lower Case in Java

Convert ing your Java strings of  text  to upper or lower case is fairly straightforward: just  use the
inbuilt  methods toUpperCase and toLowerCase.

Start  a new project  for this, and add the following code:
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The f irst  two lines of  code just  set  up a String variable to hold the text  "text  to change", and then
we print  it  out . The third line sets of  a second String variable called result . The fourth line is where
we do the convert ing:

result  = changeCase.toUpperCase( );

To use a string method you f irst  type the string you want to work on. For us, this was the string in
the variable called changeCase. Type a dot af ter the variable name and you'll see a list  of
available methods that you can use on your string. Select  toUpperCase. (The method needs the
empty round brackets af ter it .)

Af ter Java has changed the word to uppercase let ters, we're storing the new string into our result
variable.

When the programme is run, the Output window displays the following:

But you don't  have to store the converted word in a new variable. This would work just  as well:

System.out.print ln( changeCase.toUpperCase( ) );

Here, Java will just  get on with convert ing the string, without needing to assign the result  to a
new variable.

If  you want to convert  to lowercase, just  use the toLowerCase method instead. It  is used in
exact ly the same way as toUpperCase.

In the next part , you'll see how to compare strings in Java.

<-- More on Strings | Comparing Strings -->
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Comparing Strings

You can compare one string to another. (When comparing, Java will use the hexadecimal values
rather than the let ters themselves.) For example, if  you wanted to compare the word "Ape" with
the word "App" to see which should come f irst , you can use an inbuilt  string method called
compareTo. Let 's see how it  works.

You don't  need to start  a new project  for this: simply comment out (or delete) the code you
already have. Now add the following code:
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We've set up two string variables to contain the words "Ape" and "App". The compareTo method
is then this line in the code above:

result  = Word1.compareTo( Word2 );

The compareTo method returns a value. The value that is returned will be greater than 0, less
than 0, or have a value of  zero. If  Word1 comes before Word2, then the value that is returned will
be less than 0. If  Word1 comes af ter Word2 then the value returned will be greater than 0. If  the
two words are ident ical then a value of  0 will be returned.

So you need to assign the value that compareTo returns to a variable. We're placing the value in
an integer variable called result . The IF Statements in the code simply tests to see what is in the
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result  variable

However, when you compare one string of  text  with another, Java compares the underlying
hexadecimals values, rather than the actual let ters. Because uppercase let ters have a lower
hexadecimal value than lowercase ones, an uppercase let ter "A" in "App" will come before a
lowercase let ter "a" in "ape". Try it  for yourself . Change "Ape" to "ape" in your code. The Output
will read "Word1 is more than Word2", meaning that Java will place the word "ape" af ter the word
"app" alphabet ically.

To solve the problem, there's a related method called compareToIgnoreCase. As its name
suggest, lowercase and uppercase let ter are ignored. Use this and "ape will come before "App"
alphabet ically.

Next up, we'll look at  another useful String method - indexOf.

<-- UpperCase and LowerCase | indexOf -->
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The Java Method indexOf

The indexOf  method is used to locate a character or string within another string. For example,
you can use it  to see if  there is a @ character in an email address. Let 's use that example in some
code.

Again, you can either delete or comment out the code you already have. But here's the new code
to t ry:
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We want to check if  the @ sign is in the email address, so we f irst  set  up a char variable and
assign it  a value of  '@'. (Note the single quotes for the char variable). Af ter set t ing up an email
address, we have a result  variable. This is an int  variable. The reason that result  is an integer is
because the indexOf  method will return a value. It  will return the posit ion number of  the
ampersand character in the string email_address. Here's the relevant line:

result  = email_address.indexOf( ampersand );

The string you're t rying to search comes f irst . Af ter a dot, type indexOf . In between the round
brackets of  indexOf, you have several opt ions. One of  the opt ions is to type a single character
(or the name of char variable). We've placed our ampersand variable between the round brackets
of indexOf. Java will then tell us the posit ion of  the @ character in the email address. It  will store
the value in the result  variable.

When you run the code, the output will be 4. You might think that the @ sign is the f if th character
in the email address. But indexOf starts count ing at  0.

However, if  the character is not in the word that you're searching, indexOf will return a value of  -1.
To test  this out, delete the @ sign from your email_address string. Then run your code again.
You'll see -1 as the output.

You can use the return value of  -1 to your advantage. Here's the code again, only with an IF
statement that examines the value of  the result  variable:
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So if  the result  of  indexOf is -1 then we can do one thing, else allow the user to cont inue.

You can also use indexOf to test  for more than one character. The code below checks the email
address to see if  it  ends with ".com":
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The code is almost ident ical, except we're now using a String variable to hold the text  we want to
check for (.com), and not a char variable.

Again, a result  of  -1 will be returned if  the text  to search for is not found in the String that comes
before the dot of  indexOf. Otherwise, indexOf will return the posit ion of  the f irst  of  the matching
character. In the code above, the dot is the seventh character of  the email address, when you
start  count ing from 0.

You can also specify a start ing posit ion for your searches. In our email address example, we can
start  searching for the ".com" af ter the @ symbol. Here's some code that f irst  locates the
posit ion of  the @ symbol, and then uses that as the start  posit ion to search for ".com".
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The new line of  code is this one:

result  = email_address.indexOf( dotCom, atPos );

The only thing dif ferent is the addit ion of  an extra variable between the brackets of  indexOf. We
st ill have the string we want to search for (which is whatever text  is in the dotcom variable), but
we now have a start ing posit ion for the search. This is the value of  the variable called atPos. We
get the atPos value by using indexOf to locate the posit ion of  the @ symbol in the email address.
Java will then start  the search from this posit ion, rather than start ing at  0, which is the default .

 

Ends With … Starts With

For the programme above, you can also use the inbuilt  method endsWith:

Boolean ending = email_address.endsWith( dotcom );

You need to set  up a Boolean variable for endsWith, because the method returns an answer of
t rue or false. The string you're t rying to test  goes between the round brackets of  endsWith, and
the text  you're searching goes before it . If  the text  is in the search string then a value of  t rue is
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returned, else it  will be false. You can add an if  … else statement to check the value:

if  (ending == false ) {
System.out.print ln( "Invalid Email Address" );

}
else {

System.out.print ln( "Email Address OK " );
}

The method startsWith is used in a similar way:

Boolean startVal = email_address.startsWith( dotcom );

Again, the return value is a Boolean true or false.

 

In the next lesson, you'll learn how to use a method called substring.

<-- Comparing Strings | Substring -->
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Substring
 

One really useful method available to you is
called substring. This method allows you to grab
one chunk of  text  f rom another. In our email
address programme above, for example, we
could grab the last  f ive characters f rom the
address and see if  it  is co.uk.

To get some pract ice with substring, we'll write a
small Name Swapper game. For this game, we
want to change the f irst  two let ters of  a family
name and swap them with the f irst  two let ters of
a personal name, and vice versa. So if  we have
this name:

"Bill Gates"

we would swap the "Ga" of  "Gates" with the "Bi"
of  "Bill" to make "Bites". The "Bi" of  "Bill" will then be swapped with the "Ga" of  "Gates" to make
"Gall". The new name printed out would be: "Gall Bites"

We'll use substring for most of  this programme. Substring works like this:

String FullName = "Bill Gates";
String FirstNameChars = "";

FirstNameChars = FullName.substring( 0, 2 );
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You set up a string to search, in this case the string "Bill Gates". The string you're t rying to search
goes af ter an equals sign. After a dot, type the name of the method, substring. There are two
ways to use substring, and the dif ference is in the numbers between the round brackets. We have
two numbers in the code above, 0 and 2. This means start  grabbing characters at  posit ion 0 in the
string, and stop grabbing when you have two of  them. The two characters are then returned and
placed in the variable FirstNameChars. If  you always want to go right  to the end of  the string, you
can just  do this:

String test  = FullName.substring( 2 );

This t ime, we only have 1 number between the round brackets of  substring. Now, Java will start  at
character two in the string FirstName, and then grab the characters f rom posit ion 2 right  to the
end of  the string.

Start  a new programme to test  this out. Add a print  line to the end and your code should be this:

When the programme runs, the Output window should look like this:
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So the substring method has allowed us to grab the f irst  two characters of  the name "Bill".

To get the f irst  characters, we had a 0 and a 2 between the round brackets of  substring. You
might think that to get the "Ga" of  "Gates" that we could just  do this:

= FullName.substring(5, 2);

We st ill want two characters, af ter all. Only this t ime, the 5 would tell Java to start  f rom the "G" of
"Gates". (The f irst  posit ion in a string is posit ion 0 not posit ion 1.) So, start  at  posit ion 5 in the
string and grab 2 characters.

However, running that code would get you an error. That 's because the second number between
the round brackets of  substring doesn't  mean how many characters you want to grab. It  means
the posit ion in the string that you want to end at . By specifying 2 we're telling Java to end at  the
character in posit ion 2 of  the string. As you can't  go f rom posit ion 6 backwards to posit ion 2 you
get an error instead.

(NOTE: If  you start  the count at  0 in the string "Bill", you might think that posit ion 2 is the let ter "l".
And you'd be right . But substring starts before the character at  that  posit ion, not af ter it .)

To get the "Ga" of  "Gates", therefore, you could do this:

FullName.substring( 5, FullName.length( ) - 3 );

The second number is now the length of  the string minus 3 characters. The length of  a string is
how many characters it  has. "Bill Gates" has 10 characters, including the space. Take away 3 and
you have 7. So we're telling substring to start  at  character 5 and end at  character 7.

And that would work perfect ly well for people called "Bill Gates". But the programme wouldn't
work if  you name was, say, "Billy Gates". The code above would then grab the space character
plus the let ter "G", which is not what we want at  all. We want the programme to work whichever
two names are entered. So we have to get a bit  clever.

One thing we can do is to note the posit ion of  the space in the two names. The 2 characters we
want to grab from the second name always come right  af ter the space character. We want some
code that grabs those f irst  two characters af ter the space.

We can use indexOf to note the posit ion of  the space:
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int  spacePos = FullName.indexOf(" ");

To specify a space character you can type a space between two double quotes (or single
quotes). This then goes between the round brackets of  indexOf. The value returned will be an
integer, and it  is the posit ion of  the f irst  occurrence of  the space character in the string FullName.

Test it  out  by adding the line above to your code: Add a print  line to check the Output:

Run the programme to see the following Output:

So the space is at  posit ion 4 in the string. We can use this fact  to grab the f irst  two characters of
"Gates", or indeed any second name. We tell Java to go from the f irst  character af ter the space,
and end at  the next two characters:

FullName.substring( spacePos + 1, (spacePos + 1) + 2)

So the two numbers between the round brackets of  substring are these:
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spacePos + 1, (spacePos + 1) + 2

We want to start  at  the f irst  character af ter the space (space + 1), and end two characters af ter
this posit ion, which is (spacePos + 1) + 2.

Add the following lines to your code (The ones highlighted. Our new substring method spills over
on to two lines, but you can keep your on one, if  you prefer):

When you run the programme, the Output window is this:

So we now have the "Bi" f rom Bill and the "Ga" f rom Gates. What we now need to do is get the
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rest  of  the characters f rom the two names, and then swap them around.

Again, we can use substring to get the remaining characters f rom the f irst  name:

String OtherFirstChars = "";
OtherFirstChars = FullName.substring( 2, spacePos );
System.out.print ln( OtherFirstChars );

And the remaining characters f rom the second name:

String OtherSurNameChars = "";
OtherSurNameChars = FullName.substring((spacePos + 1) + 2,
FullName.length() );

System.out.print ln( OtherSurNameChars );

Not the numbers in between the round brackets of  substring. To get the other f irst  name
characters, the numbers are these:

2, spacePos

This tells Java to start  at  posit ion 2, and go right  up to the posit ion of  the space. To get the rest
of  the second name, however, it 's a lit t le bit  t rickier:

(spacePos + 1) + 2, FullName.length( )

The (spacePos1 + 1) + 2 is the start ing posit ion of  the third character of  the second name. We
want to end at  the length of  the string, which will get  us the rest  of  the characters.

Add the following to your code (highlighted):
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The Output is this:
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We now have all the parts of  the name. To join them together, we can use concatenat ion:

Add the new lines to your own code. When you run your programme, the Output window should
display the following:

We can get rid of  the print  lines, though, and invite a user to enter a f irst  name and second name.
Here's the new programme (the only addit ion is for the keyboard input, which you've used
before):
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The Output window should look something like this, when you run your programme and enter a
f irst  name and surname:
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We should, of  course, add some error checking. But we'll assume the user can enter a f irst  name
and surname with a space between the two. If  not , the programme will crash! Let 's move on,
though, and have a look at  the equals method.

<-- indexOf | The equals Method -->
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The equals Method in Java

You can check two strings to see if  they are the same. For this, use the equals method in Java.
Here's some code:

In this code, we want to check if  one email address is the same as another. The f irst  two lines set
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up two string variables, one for each email address. The third line sets up a Boolean variable.
That 's because the equals method returns a value of  t rue or false. The fourth line is where we
use the method:

isMatch = email_address1.equals( email_address2 );

In between the round brackets of  the equals method, you place the string you're t rying to check.
The other string goes before the equals method. Java will then tell you (t rue or false) whether
the two are the same. The IF statement checks which one it  is.

The equals method only compares objects, however. It 's OK for strings, because they are objects.
But you can't  use the equals method to compare int  variables. For example, this code would get
you an error:

int  num1 = 12;
int  num2 = 13
Boolean isMatch = false;

isMatch = num1.equals(num2);

The int  variable is a primit ive data type, and not an object . You can turn the primit ive int  data type
into an object , though:

int  num1 = 12;
Integer num_1 = new Integer(num1);

Here, the int  variable called num1 is being turned into an Integer object . Note the use of  the new
keyword. In between the round brackets of  Integer, you put the primit ive int  data type you want to
convert  to an object .

Another useful Java string method is charAt. You'll meet this in the next lesson.

<-- Substring | The charAt Method -->
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The charAt method in Java

You can check to see which single character is in a part icular string. The charAt  method is used
for this in Java. Here's some code to t ry:

String email_address = "meme@me.com";

char aChar = email_address.charAt( 4 );
System.out.print ln( aChar );

This code checks which let ter as at  posit ion 4 in the email address string. The return value is a
variable of  type char:

char aChar = email_address.charAt( 4 );

When the above code is run, the output is the character @. The number between the round
brackets of  charAt is the posit ion in the string you're t rying to check. Here, we want to get at  the
character in posit ion 4 of  the email_address string. Again, the count starts at  0, just  like substring.

One good use for charAt is for taking a let ter f rom a string variable that is typed by a user, and
then convert ing it  to a single char variable. For example, you could ask the use to type Y to
cont inue or an N to exit . Have a look at  this code:
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We can't  use the Scanner class direct ly to get a single let ter to store in a char variable. So we use
the next( ) method to get the next string that the user inputs. There's a next integer, next long,
next double - even a next Boolean. But there's no next char. Even if  the user inputs a single
character it  will st ill be a string and not a char. (Remember: a char variable stores a Unicode
number as an integer.)

We can use charAt to get a character f rom any string that the user inputs, even if  the user inputs
a single let ter:

char aChar = aString.charAt( 0 );

All we're saying is "Get the character at  posit ion 0 in the string called aString, then store it  in the
aChar variable".

We've added an IF statement to test  what is in the aChar variable. (Note the use of  single quotes
around the let ter Y.)

<-- The equals Method | The replace Method -->
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The replace Method in Java

The replace method in Java is used to replace all occurrence of  a character/s in a part icular string.
Take this sentence:

"Where are you books?"

We want to replace "you" with "your". Here's the code:

There are several ways to use the replace method, and they dif fer in what you put between the
round brackets of  the method. We're replacing one sequence of  characters with another. Think of
the comma separat ing the two as the word "with". You'd then have "Replace you with your".

You can also replace single character:
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aString.replace( '£', '@' )

The above code reads "Replace £ with @".

(You can also use something called a regular expression in your replace methods, but that  is
outside the scope of  this book.)

 

Trim

You can trim white space from your strings White space is things like space characters, tabs, and
newline characters - the characters you can't  see, in other words. The trim method is easy to use:

String amend = " white space ";
amend = amend.trim( );

So the trim method goes af ter the string you want to amend. The blank characters before the
word "white" and af ter "space" in the code above will then be deleted.

If  you're gett ing input f rom a user then it 's always a good idea to use trim on the inputted strings.

 

OK, we'll leave string manipulat ion there and move on. Next up - formatted strings of  text .

<-- The charAt Method | Formatted Text -->
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Formatted Strings

Strings of  text  can be formatted and output with the printf  command. The print f  command
understands a series of  characters known as a format specif icat ion. It  then takes a string of
text  and formats it , based on the format specif icat ion passed over. As an example, supposed we
wanted the Output window to display text  in neat columns, like this:

The f irst  column is lef t -just if ied, and the second column is right-just if ied. The code for the
Exam_Name and Exam_Grade headings was this:

String heading1 = "Exam_Name";
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String heading2 = "Exam_Grade";

System.out.printf ( "%-15s %15s %n", heading1, heading2);

To get the lef t -just if ied column, you need a percentage symbol, a minus symbol, the number of
characters, and then the let ter "s" (lowercase). So ''%-15s'' means f if teen characters lef t -just if ied.

To get a right-just if ied column the same sequence of  characters are used, except for the minus
sign.

To get a newline %n is used. Note that the characters are surrounded with double quotes.

After a comma, you type the text  that  you want formatt ing. The f irst  comma in the code above
separates the format specif icat ion f rom the text  being formatted.

Here's some tables of  the various opt ions.

String Formatting

If  you want to format numbers then you can either use the "d" character or, for f loat ing point
numbers, the "f" character.

Integer Formatting

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


 

Floating Point Number Formatting
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Here are some code examples of  String, integer and f loat ing point  formatt ing. Try them out for
yourself .

Same as above but the numbers occupy 10 places, with spaces to the lef t  as padding.
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Finally, here's the table again f rom the start  of  this formatt ing sect ion:
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And here's the code for the above formatted output:

Have a play around with formatt ing, and see how you get on. If  you get error messages you may
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have gotten your "s" formatt ing confused with your "d" formatt ing!

In the next sect ion, we'll move on and tackle Java Methods.

<-- Replace | Java Methods -->
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Writing you own Java Methods

You have been using methods in the previous sect ion, and have seen how useful the inbuilt  ones
can be. In this sect ion, you'll learn to write your own methods.

The Structure of a Method

A method is just  a chunk of  code that does a part icular job. But methods are set out in a certain
way. You have a method header, and a method body. The header is where you tell Java what
value type, if  any, the method will return (an int  value, a double value, a string value, etc). As well
as the return type, you need a name for your method, which also goes in the header. You can
pass values over to your methods, and these go between a pair of  round brackets. The method
body is where you code goes.
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The method's return type goes f irst , which is an int  type in the code above. After the method
type, you need a space followed by the name of your method. We've called the one above total.
In between a pair of  round brackets we've told Java that we will be handing the method a variable
called aNumber, and that it  will be an integer.

To separate this method from any other code, you need a pair of  curly brackets. Your code for
the method goes between the curly brackets. Note the word return in the method above. This is
obviously the value that you want to return f rom your method, af ter your code has been
executed. But it  must be of  the same type as the return type in the method header. So the return
value can't  be a string if  you started the method with int  total.

Sometimes you don't  want Java to return anything at  all. Think of  Trim in the previous sect ion.
You may only want the Trim method to get on with its job, and not return anything to you. A
method that doesn't  return any value at  all can be set up with the word void. In which case, it
doesn't  need the return keyword. Here's a method that doesn't  return a value:

All the method above does is to print  some text . It  can just  get on with its job, so we've set it  as a
void method. There's no return value.

Methods don't  need to have values passed to them. You can just  execute some code. Here's a
void method without any values being passed over:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


And here's an int  method that has no values being passed:

As you can see, the round brackets are empty in both methods. But they are st ill needed. Miss the
round brackets out and you'll get  an error message.

In the next lesson, you'll learn how to call your methods into act ion.

<-- The replace method | Calling your Methods -->
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Java Method Calling

Methods don't  do anything unt il you call them into act ion. Before we see how, let 's add another
class to the project . We can then put all the methods there, instead of  clogging up the main class.
(You'll start  learning more about classes in the next sect ion.)

Start  a new Java Applicat ion project . Give your project  a name, and rename the Main method to
something else. Then click Finish. In the image below, we've called our project  prjmethods, and
the class TestMethods:

To add a new class to your project , click File f rom the NetBeans menu. From the File menu, select
New File . You'll see a dialogue box appear. In the Categories sect ion select  Java, and in the File
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Types sect ion select  Java Class. Then click the Next button at  the bottom. In step two, type a
name for your new class. We've called ours MyMethods. You can leave everything else on the
defaults:

So we're creat ing a second class called MyMethods which will be in the Project  prjmethods. Click
the Finish button and your new class f ile will be created. A new tab will appear in the NetBeans
software, with some default  comments about how to change templates. You can delete these
comments, if  you like. You should be lef t  with the following code window:

The thing to not ice is that  there's no Main method this t ime - just  a blank class with the name you
chose, and a pair of  curly brackets for your code. Let 's add one of  our methods. So add the
following code to your class:
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This is the int  method we met earlier with the name total. It  has nothing between the round
brackets, which means we're not going to be handing it  any values. All the method does is to add
up 10 + 10 and store the answer in a variable called a_Value. This is the value that will be returned
from the method. The value af ter the keyword return must match the return type from the
method header. Ours is OK because they are both int .

(It 's important to bear in mind that the a_Value variable can't  be seen outside of  the total
method: Any variable set  up inside of  a method can't  be accessed outside of  that  method. It 's
known as a local variable - it 's local to the method.)

To call the total method, select  your TestMethods tab in NetBeans, the one with your Main
method. We're going to call the total method from the Main method.

The f irst  thing to do is to create a new object  f rom our MyMethods class. Add the following line
to your Main method:
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To create a new object  f rom a class you start  with the name of the class, MyMethods in our
case. This is in place of  int , double, String, etc. In other words, the type of  variable you're creat ing
is a MyMethods variable. Af ter a space, you type a name for your new MyMethods variable. We've
called ours test1. (It 's underlined because we haven't  done anything with it  yet . This is a
NetBeans underline.)

An equals sign comes next, followed by the keyword new. This means new object . Af ter the
keyword new, type a space followed by your class name again. The class name needs a pair of
round brackets af ter it , this t ime. End the line in the usual manner, with a semi-colon.

What we've done here is to create a new MyMethods object  with the name test1. Our total
method inside of  the class MyMethods will now be available f rom the Main method of  the
TestMethods class.

To call the total method into act ion, add this line:
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We're sett ing up an int  variable with the name aVal. Af ter an equals sign comes the name of our
class, test1. To access methods in the class, type a dot. NetBeans will display a popup box with
the available methods:

Our total variable is on the list  (the others are built  in methods). The round brackets are empty
because our method doesn't  accept values, but the return type, int , is displayed to the right .

Double click total to add it  to your code. Then type a semi-colon to end the line.

Finally, add a print  line:

When the code is run, the Output window will display the following:
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So to call a method that returns a value, note what value is being returned by your method. Then
assign this value to a new variable, aVal in our case. But the method should be available when
you type a dot af ter your object  name.

If  your method is of  type void, however, you don't  need to assign it  to a new variable like aVal. As
an example, switch back to your MyMethods class, and add the void method you met earlier:

This new method is called print_text . Again, it  has an empty pair of  round brackets as we're not
handing it  any values. All it  does is to print  out some text .

Once you've added the void method, switch back to your TestMethods class. Add the following
line:

test1.print_text( )
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As soon as you type the dot, you should see the new method appear on the list :

Both of  our methods are now on the list , total and print_text . The values that they return are
displayed on the right , int  and void.

Because the print_text  method is a void method, you don't  need to set  up a return value. All you
need is the name of your object , a dot, and the void method you want to call. Java will then just
get on with execut ing the code inside of  your method.

Run your code and your Output window should display the following:

In the next part , we'll take a closer look at  passing values to methods.

<-- Java Methods | Passing Values to Methods -->
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You can pass values to your methods so that something can be done with this value. That value
goes between the round brackets of  the method.

Switch back to your MyMethods class. Now add the second of  our total methods:
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We now have two methods with the same name: total. The dif ference between the two is that
this new one has a value between the round brackets. Java allows you to do this, and it  is called
method overloading. You can have as many methods with the same name as you want, with any
return value. However, you can't  have the same type of  variables between the round brackets. So
you can't  have two total methods that return int  values with both of  them having int  values
between the round brackets. You can't  do this, for example:

int  total( int  aNumber ) {
int  a_Value = aNumber + 20;

return a_Value;
}

int  total( int  aNumber ) {
int  a_Value = aNumber + 50;

return a_Value;
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}

Although the two methods do dif ferent things, they have the same method headers.

Before you try out your new method, add some comments direct ly above the method:

You'll see what the comments do in a moment. But the param in the comments above is short  for
parameter. A parameter is the technical term for the value between the round brackets of  your
method headers. Our parameter is called aNumber, and it  has an integer values. Note the use of
the @ character before param and return.

All we're doing with the method itself  is passing it  an integer value and adding 20 to this passed
value. The return value is the total of  the two.

Now switch back to your code and add the following line:

int  aVal2 = test1.total(30);

As soon as you type the dot af ter your test1 object , you'll see the popup list  again. Your new
total method will be on it . Click on the new method to highlight  it  and NetBeans will display the
following:
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The comments that we added are now displayed in the blue box underneath the list  of  methods.
Anyone else coming across your method should be able to f igure out what it  does. The @param
and @return lines f rom the comments are now f illed out, and made bold.

But once you have added the total2 method, type the number 30 between the round brackets.
Then type a semi-colon to end the line. You main method should now look like this:
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The 30 between the round brackets of  the new total method will be handed over and placed in
the variable aNumber, which is in the round brackets of  the method header:

Once you have handed the value over, the method can get to work.

Add a print  line to your code:

System.out.print ln( "Method result2= " + aVal2 );
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Then run your programme. The Output window should display the following:

So our new total method has added 30 to 20, and then returned the answer to the variable called
aVal2.

In the next lesson, you'll learn how to pass more than one value over to your methods.

<-- Method Calling | Passing Mult iple Values to Methods -->
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Passing Multiple Values to Methods

You can pass more than one value over to your methods. Add the following method to your
MyMethods class:

All this method does is to print  something out. Between the round brackets of  the method name
we have two values, a String variable called aString and an int  variable called aVal. When we call
this method, we need a string f irst  and then a number. Try to do it  the other way round and you'll
get  error messages.

Go back to your TestMethods class and make the following call to the method:

test1.print_text( "The value was ", aVal2 );

Again, the print_text  method should show up on the NetBeans popup list .
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The values (parameters) that  we specif ied are between the round brackets, along with the return
method, void.

But your main coding window should now look like this:

The two values that we are passing over are separated by a comma. Not ice that the value inside
of aVal2 is being passed over. However, the variable name inside of  the round brackets of
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print_text  is called aVal. Although the two variable names are dif ferent, this doesn't  matter. What
you are doing is passing values over to the method. So the variable aVal will end up with the same
value as aVal2.

If  you run your programme now, you should see the following in the Output window:

We'll leave methods there for the t ime being. We'll be writ ing more methods as we go along, so
you should get plenty of  pract ice. The next sect ion is about Classes - Object  Oriented
Programming.

<-- Parameters | Writ ing your own Java Classes -->
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Java Classes
Java Classes: parts 1 2 3 4 5 6

 

In this sect ion, you'll learn how to write your own
Java classes, and how to create objects f rom
them. You've already made a start  on classes in
the previous sect ion. But we'll go into more detail
now. In case you're confused about the
dif ference between an object  and class, though,
when we talk about a class we're talking about
the code itself , the code that sits around doing
nothing. When you put the code to work it 's an
object .

When you create a class, you're writ ing code to
do a part icular job. That job might be to do with
an employee, but not the company's sales
f igures at  the same t ime. You would write a
separate class for the sales f igures. That way,

you can re-use the employee class in another project . The sales f igures would be redundant data.

When you're t rying to come up with your own ideas for classes you should bear in mind that
redundancy issue and ask yourself , "Is there any code in this class that doesn't  need to be here?"

For this sect ion's example, we'll write a class that deals with exams. On our website we have
some exams that you can take for f ree (www.homeandlearn.org). Quest ions are taken 10 at  a
t ime, and there are 50 quest ions in an exam. We have a number of  dif ferent exams you can take.
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t ime, and there are 50 quest ions in an exam. We have a number of  dif ferent exams you can take.
For our example class, we'll make things simple. We'll record the name of the person taking the
exam, which exam it  was, the score out of  50, and a grade.

Let 's make a start .

Create a new Java project  for this. Call the package exams, and then change the name of the
Main method to ExamDetails. You should then have the following code:

We'll create a second class to handle the exam data. So, in NetBeans, click File f rom the menu
bar at  the top. From the File menu, select  New File. Highlight  Java f rom the Categories list , and
Java Class f rom the File Types list . Then click Next. On the next screen, enter StudentResults
as the class name. Then click Finish. NetBeans will create a second class in your project . You can
delete any default  comments.

In the next lesson, you'll learn about Field Variables.

 

<-- Parameters | Field Variables -->
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Java Field Variables
Java Classes: parts 1 2 3 4 5 6

In a previous sect ion, we talked about variables inside of  methods. The variables you set up inside
of methods are only available to those methods. They are not available to other methods. They
are said to have local scope.

However, you can set up variables outside of  methods that all the methods in your class can see.
These are known as Field variables (or Instance variables). You set them up in exact ly the same
way as any other variable. Add the following four f ields to your new StudentResults class:
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We're sett ing up four string variables (four string f ields). As the names of  the f ields suggest, the
string will hold a person's name, an exam name, a score, and a grade. These four f ields will be
available to all the methods that we write in this class, and won't  be local to any one method.
They are said to have global scope.

To see just  how global they are, click back on to your ExamDetails class, the one with the main
method. Add the following line of  code to create a new object  f rom your StudentResults class:

This is the same as we did in the previous sect ion - used the new keyword to create a new object .
The name of the object  will be aStudent , and it  is of  type StudentResults, which is our class.

On the next line, type the name of the variable (aStudent), followed by a dot. As soon as you
type the dot NetBeans display a popup list  of  methods and propert ies available to your object :
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The four f ields that we set up are on the list . They are not methods, but something called a
property. The fact  that  they are on the list  at  all means that they have global scope. If  they had
local scope they wouldn't  be on the list .

You can set values for propert ies. Try this: add the following highlighted code to your main
method:
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We've selected the Exam_Name f ield f rom the list  and assigned it  the value "VB NET". The next
line then gets the value of  Exam_Name from the aStudent object . The result  is stored in a
variable called exam, and then printed out. When you run the programme, the output is the string
"VB Net".

So the four variables we've set up are now available to both classes.

However, it 's not a good idea to make f ield variables global like this. You tend to lose track of  just
what values are being held in them, and it  therefore makes debugging your code a lot  harder. It 's
considered good coding to narrow the scope of  f ield variables.

To make a f ield variable available only to a part icular class, you add the Java keyword private just
before the f ield declarat ion. Change the code in your StudentResults class to this:
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Now, only code within the StudentResults class can see these f ield variables. To check, go back
to your main method. You should see some warnings and red underlines:

Delete the three lines at  the bottom. Type aStudent  and then a dot again to see the NetBeans
popup list :

As you can see, the four f ield variables have now vanished. They have vanished because they no
longer have global scope, and therefore can't  be seen from the ExamDetails class.

In the next part , you'll learn about something called a class constructor.

 

<-- Java Classes | Class Constructor -->
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Because we've made the f ield variables private, we need another way to assign values to them.
One way to do this is with something called a constructor. This is a method you can use to set
init ial values for f ield variables. When the object  is created, Java calls the constructor f irst . Any
code you have in your constructor will then get executed. You don't  need to make any special
calls to a constructor method - they happen automat ically when you create a new object .

Constructor methods take the same name as the class. Add the following constructor to your
StudentResults class:
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So the name of the constructor is StudentResults. This is exact ly the same name as the class
itself . Unlike normal methods, class constructors don't  need a return type like int  or double, nor
any return value. You can, however, pass values over to your constructors. If  we want to pass
values over to our f ield variables, we can do this:

Here, we've added two String variables to the round brackets of  the constructor. Inside the curly
brackets we've assigned these values to the Full_Name and Exam_Grade f ields. When you
create a new object , you'd then need two strings between the round brackets of  the class name:
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StudentResults aStudent = new StudentResults( "Bill Gates", "A" );

When the object  is created, the values "Bill Gates" and "A" will be handed over to the constructor.

However, it 's a good idea to just  set  some default  values for your f ield variables. These values will
then be assigned when the object  is created. Add the following to your constructor:

All four of  our f ield variables will now have default  values whenever a new StudentResults object
is created. Not ice that we now don't  have anything between the round brackets of  the class
constructor.

In the next part , we'll take a look at  accessing class variables.

 

<-- Field Variables | Accessing Class Variables -->

 PDFmyURL.com

http://www.homeandlearn.co.uk/java/field_variables.html
http://www.homeandlearn.co.uk/java/accessing_class_variables.html
http://www.homeandlearn.co.uk/java/java.html
http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


Back to the Home Page

© All course material copyright Home and Learn

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


 

 

COMPUTER COURSES

Home

Beginners Computing

Word 2007 to  2010

Word 2000 to  2003

Excel 2007 to  2010

Excel to  2003

Accessing Class Variables
Java Classes: parts 1 2 3 4 5 6

Now that we have some default  values, we can add a method that sets some dif ferent values for
them. Add the following method to your StudentResults class:
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This new method is called fullName, and has a String variable called aName between its round
brackets. The method doesn't  do a great deal, and is here for simplicity's sake. We could have
had the method do more work, like checking it  for errors, making sure it 's proper case, checking
for blank strings, etc. But the important point  is that  it  sets a value for the Full_Name f ield, and
returns this f ield as a value. When we call this method, it  will overwrite the default  value for
Full_Name and insert  a new value. Whatever is in the variable aName will be the new Full_Name
value. Let 's see it  in act ion.

Click back to your ExamDetails class. Add the following two lines:

String sName = aStudent.fullName("Bill Gates");
System.out.print ln( sName );

The code for your ExamDetails class should look like the one below:
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What we're doing here is calling the fullName method of  our aStudent  object . We're handing
over a value of  "Bill Gates". This will then be the value for the Full_Name f ield. (It  could have been
checked for errors, amended, and then stored in the f ield.) The Full_Name value is then returned
and stored in the variable sName.

Just  like the methods we created in the previous sect ion, though, our fullName method is on the
NetBeans popup list . Not ice that the constructor is not there, however:

Run your code to test  it  out . The Output window should display the following:
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What we've done, then, is to set  a value for a f ield variable in a class called StudentResults.
We've then accessed that value and printed it  out .

Let 's now add a method that actually does something useful. What we'll do is to allow a user to
enter a two let ter exam code. We'll then pass those two let ters over to a method that turns the
two let ters into an exam name. For example, if  a user enters the let ter "VB", the method will
return the string "Visual Basic .NET". The longer string will be stored in the Exam_Name f ield
variable.

Add the following code to your StudentResults class, just  below your fullName method:
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The examName method has a string variable called examCode between its round brackets. This
string will be the two let ters. The IF … ELSE IF lines check to see which two let ters are in the
string. If  we f ind a match for the two let ters then a longer exam t it le is placed into the
Exam_Name f ield. If  no match is found then the text  will be "No Exam Selected".

Go back to your ExamDetails class and add the following line:

String exam = aStudent.examName("VB");

Again, we're just  making a call to the method. We hand over to the two let ters "VB". The method
returns the value "Visual Basic .NET", and then stores it  in the string variable we've called exam.
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Add a new print  line and your code should look like this:

Run your code and the Output should be this:

 

We'll cont inue this lesson in the next part , as the page is gett ing a bit  too long!

 

<-- The Class Constructor | More Java Class Methods -->
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More Java Class Methods
Java Classes: parts 1 2 3 4 5 6

So we now have a student name and an exam name. Both are stored in the f ield names in the
StudentResults class. We can now add an exam score.

Add the following new method to your class, just  af ter your examName method:

This new method has the name examScore, with an int  variable called aScore between its round
brackets. It 's set  to return a String value. The method itself  just  combines the score with the string
" out of  50". So if  the value in aScore is 30, the text  "30 out of  50" will be stored in the
Exam_Score f ield.

In your ExamDetails class, add the following line:

String score = aStudent.examScore(30);
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So we call the new examScore method and hand it  a value of  30. The value in the Exam_Score
f ield is returned, and then stored in a string variable that we've called score.

Add a new print  line method so that your code looks like ours below:

When the programme is run, the Output window now looks like this:

So we have the student name, the exam name, and the score out of  50. We can now add a grade
to the output.

We'll use a single let ter for the grade: A, B, C, D, or E. If  the students gets 41 or over, we'll an
award an A; if  the score is between 31 and 40, the grade will be B; for a score of  21 to 30 a C
grade will be awarded; a D grade is between 11 and 20; and an E is for scores between 0 and 10.

Add the following method to calculate the above grades (add it  to your StudentResults class):
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Notice that this method is private. Just  like f ield variables, making a method private means it  can
only be seen inside of  this class. It  can't  be seen by the ExamDetails class.

To get the grade, we'll set  up another method inside of  the StudentResults class. We'll use this to
get the grade. Add the following method just  above the getGrade method (though you can add
it  below, if  you prefer: it  doesn't  make any dif ference to Java!):

String examGrade(int  aScore) {

Exam_Grade = this.getGrade( aScore) ;
return Exam_Grade;

}

This is the method we'll call f rom the ExamDetails class, rather than the getGrade method. The
name of this new method is examGrade, and again we're passing in the student 's score. Look at

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


this line, though:

Exam_Grade = this.getGrade( aScore );

The getGrade method is being called, here, and we're passing it  the score that was handed over.
Calling one method from another is standard pract ice, and it  allows you to simplify your code.
The alternat ive is to have very long methods that are hard to read.

Another thing to not ice in the line above is the Java keyword this. The this keyword means "this
class", rather than another class that may have the same method name. It  avoids any confusion.
It 's strict ly not necessary, and we could have lef t  it  out . The method call would st ill work without it :

Exam_Grade = getGrade( aScore );

The end result , though, is st ill the same: we're storing something in the Exam_Grade f ield variable,
and that something will be the text  "Grade is" plus a grade let ter.

Add the following line to your ExamDetails class, to test  out your new methods:

String grade = aStudent.examGrade(30);

This line hands a value of  30 over to the examGrade method. The value in the Exam_Grade f ield
variable is then returned, and stored in a variable called grade.

With a print  line, your ExamDetails class should look like this:
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Run your programme to see the Output window:

If  your programme is not working properly, here's the full code for the StudentResults class:
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In the next lesson, you'll learn about Inheritance.
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Java and Inheritance
Java Classes: parts 1 2 3 4 5 6

 

Another important concept in Object  Oriented
programming is Inheritance. Just  what
Inheritance is will become clearer with some
programming examples. But essent ially, it 's
having one class as a parent class (called a
super class) and another class as a child of  the
parent (the sub class). The child class is said to
be derived from the parent class. The reason to
have a child class, though, is to keep informat ion
separate. The child can inherit  all the methods
and f ields f rom its parent, but  can then do its
own thing.

As an example of  inheritance, we'll create a sub
class that handles informat ion about cert if icates.
If  the student gets an "A" grade, we'll award a

Cert if icate of  Excellence; if  the student gets a "B" or a "C" we'll award a Cert if icate of
Achievement. Any other grade and no cert if icate will be awarded. But the point  about the sub
class is to keep the cert if icates data separate f rom the exam data. However, we may st ill want to
access some of the informat ion about the exam, such as which exam it  was. We can even access
the methods that turn a score into a grade, and all f rom the sub class.

So, create a new class by clicking File > New File  f rom the NetBeans menu. When the dialogue
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box appears, select  Java under the Categories heading, and Java Class under File Types. Click
Next, and enter Cert if icates as the name of your new class. Click Finish.

When your new class is created, add a private String f ield and call it  cert if icate. Your new class
should then look like this:

To create a sub class (child) f rom a Java super class (parent), the keyword extends is used.
You then follow the "extends" keyword with the parent class you want to extend. We want to
create a sub class f rom the StudentResults class. The StudentResults class will be the super
class and the Cert if icates class will be the sub class.

After "public class Cert if icates" in your code add "extends StudentResults". Your code should
then look like this:

You have now created a sub class that inherits the code from the StudentResults class.

Just like the StudentResults class we can create a constructor for this new Cert if icates class.
When we create an object  f rom the class, Java will f irst  of  all call our constructor.

However, only one constructor can be called. If  we call a new constructor f rom the Cert if icates
class all those default  values we set up for the StudentResults class f ields won't  get  set . To get
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around this, there is a keyword called super. This makes a call to the constructor f rom the super
class. Add the following constructor to your Cert if icates class:

The name of the constructor is the same as the name of the class: Cert if icates. The f irst  line of
the code between curly brackets is the super call (note the round brackets af ter super). When this
line executes, all the default  f ields we set up in StudentResults will be set.

The second line of  code in the constructor sets a default  value for the String f ield called
cert if icate. (You can actually set  up more than one constructor. You'll see how to do this in a later
sect ion.)

To test  out your new class, go back to your ExamDetails class, the one with the main method.
Comment out any code you have so far. A quick way to do this is to highlight  all the code, and
then click the comments icon on the NetBeans toolbar:

To get rid of  comments, highlight  the code again and click the uncomment icon.

Now add the following line to create a new object  f rom your class:

Cert if icates c1 = new Cert if icates();

Your code window should look something like this:
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The object  name is simply c1. The type of  object  is a Cert if icates object .

To check that you can access the methods from the StudentResults class, add this line below
you new c1 object :

String exam = c1.examName("VB");

This is exact ly the same as you did before: called the examName method of  the StudentResults
class. This t ime, however, you're using a Cert if icates object  rather than a StudentResults object .

Add a print  line and your code should look like this:
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Run the programme to see the following Output window:

So the method from the parent class (the super class) has been called into act ion. We can now
add a method to the child class (the sub class). Add the following method to your Cert if icates
class, just  below the constructor:
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The method is called cert if icateAwarded, and is set  up to return a String value. Inside the round
brackets of  the method, we're handing over an exam score.

The f irst  line of  the method is this:
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String aGrade = examGrade(aScore);

The method examGrade is a method in the parent class. It 's the one we set up in StudentResults.
This method, remember, was set up to return a grade and some extra text , "Grade is A", "Grade is
B", etc. We're now calling it  f rom the child class. The IF Statement checks the value of  the aGrade
string to see what 's in it . Depending on the value a new string is returned, awarding a part icular
cert if icate: Excellence, Achievement, or no cert if icate.

Click back on your ExamDetails class, and add the following line:

String award = c1.cert if icateAwarded(50);

This line calls the new method, and hands it  a value of  50. The result  is returned to the String
we've called award.

Adapt the print  line method in your code to this:

System.out.print ln( exam + " " + award );

Your ExamDetails class should look like this (we've deleted all the comments):

And here is the Output window when the programme is run:
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So we've used Inheritance to keep the exam details separate f rom the cert if icate details. The
child class (sub) accessed the methods of  its parent (super). We were then able to output data
from both.

Inheritance, then, is enhancing (extending) the usefulness of  a parent class. You keep data
separate by putt ing it  in a child class. But the child is related in some way to the parent, and can
access some or all of  its code. Like children everywhere, however, it  does its own thing!

In the next sect ion, you'll learn how error handling in Java.

 

<-- Class Methods | Java Error Handling -->
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Java Error Handling
 

In general, errors can be broken up into two
categories: Design-t ime errors and Logical errors.
Design-t ime errors are easy to spot because
NetBeans usually underlines them. If  the error will
prevent the programme from running, NetBeans
will underline it  in red. Logical errors are the ones
that you make as a programmer. The programme
will run but, because you did something wrong
with the coding, there's a good chance the ent ire
thing will crash. You'll see examples of  run-t ime
errors short ly. You'll also see how to handle them.
But f irst  a word on how Java handles errors.

Exceptions

In Java, errors are handled by an Exception object . Except ions are said to be thrown, and it 's
your job to catch them. You can do this with a t ry … catch block. The try … catch block looks like
this:

t ry {

}

catch ( Except ionType error_variable ) {
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}

The t ry part  of  the t ry … catch block means "t ry this code". If  something goes wrong, Java will
jump to the catch block. It  checks what you have between the round brackets to see if  you have
handled the error. If  you have the correct  Except ion type then whatever code you have between
the curly brackets of  catch will get  executed. If  you don't  have the correct  Except ion type then
Java will use its default  except ion handler to display an error message.

As an example, create a new console applicat ion. Call it  anything you like. In the code for the Main
method, enter the following:

t ry {
int  x = 10;
int  y = 0;
int  z = x / y;

System.out.print ln( z );
}
catch ( Exception err ) {

System.out.print ln( err.getMessage( ) );
}

In the t ry part  of  the t ry … catch block, we have set up three integers, x, y and z. We are t rying
to divide y into x, and then print  out the answer.

If  anything goes wrong, we have a catch part . In between the round brackets of  catch we have
this:

Exception err

The type of  Except ion you are using comes f irst . In this case we are using the Except ion error
object . This is a "catch all" type of  Except ion, and not very good programming pract ice. We'll
change it  to a specif ic type in a moment.

After your Except ion type you have a space then a variable name. We've called ours err, but  you
can it  almost anything you like.

In the curly brackets of  catch we have a print  statement. But look what we have between the
round brackets of  print ln:
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err.getMessage( )

getMessage is a method available to Except ion objects. As its name suggests, it  gets the error
message associated with the Except ion.

Run your programme and test  it  out . Your code should look something like this:

And the Output window should display the following:

run:
/ by zero
BUILD SUCCESSFUL (total t ime: 1 second)

The error itself , the one generated by getMessage, is the line in the middle:

/ by zero

In other words, a divide by zero error. Java won't  let  you divide a number by zero, hence the error
message.

Change your code to this:
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double x = 10.0;
double y = 0.0;
double z = x / y;

The rest  of  the code can stay the same. Run your programme and test  it  out .

Again, an error message will be displayed in the Output window. This one:

run:
Inf inity
BUILD SUCCESSFUL (total t ime: 1 second)

This t ime, Java stops the programme because the result  will be an inf initely large number.

Errors that involve numbers shouldn't  really be handled by a "catch all" Except ion type. There is a
specif ic type called Arithmet icExcept ion. Delete the word Except ion between the round brackets
of your catch block. Replace it  with Arithmet icExcept ion. Now run the programme again.

You should f ind no dif ference in the error message displayed in the Output window. But you're
using good programming pract ice by narrowing down the type of  error you expect.

In the next part , you'll learn what a Stack Trace is.

<-- Inheritance | Stack Trace -->
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The Java Stack Trace

In the normal f low of  a programme, when the Java Virtual Machine is running your code, one
method af ter another will be executed, start ing with the main method. When a method has its
turn at  the head of  the programming queue it  said be on top of  the stack. Af ter the whole of  the
method has been executed, it  is taken of f  the stack to be replaced by the next method in the
queue. To illustrate the principal, change your programme code to this:
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We now have a Main method and two others: a method called m1, and a method called m2. When
the programme f irst  starts, the Main method is on top of  the stack. However, inside of  the Main
method we have a call to the m1 method. When this method is called it  jumps to the top of  the
stack. The m1 method in turn calls the m2 method. When m2 is called, it  jumps to the top of  the
stack, pushing m1 aside temporarily. Af ter m2 f inishes, control is given back to m1. When m1 is
f inished, it  gets pushed of f  the top of  the stack, and control is handed back to the Main method.

Run your programme and watch the Output window to see what gets printed out:

If  something goes wrong in method m2, the JVM will look for any error handling, like a t ry …
catch block. If  there is no error handling, the Except ion will get  handed to m1 to see if  it  is dealing
with the error. We don't  have any error handling in m1 so again the Except ion gets passed up the
stack, this t ime to the Main method. If  the Main method doesn't  deal with the Except ion then
you'll get  a strange error message printed to the Output window. As an example, adapt your m2

 PDFmyURL.com

http://www.homeandlearn.co.uk/NET/vbNet.html
http://www.homeandlearn.co.uk/php/php.html
http://www.homeandlearn.co.uk/csharp/csharp.html
http://www.homeandlearn.co.uk/java/java.html
http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


method to this:

stat ic void m2( ) {

int  x = 10;
int  y = 0;
double z = x / y;

System.out.print ln( z );
System.out.print ln("Method Two - m2");

}

The method contains the divide by zero error again. Your code should now look like ours below:

Run the programme and watch what happens in the Output window:
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What you're looking at  is something called a stack t race. The three lines in blue underline refer to
your methods, and where they can be found:

package_name.class_name.method_name

The one at  the top is where the error f irst  occurred, in m2. Java was looking for this to be
handled by an ArithmeticException, which is where divide by zero errors should be caught.
There was no error handling in m2, m1, or main. So the programme outputted to the default  error
handler.

Change you m1 method to this:

t ry {
System.out.print ln("Method One - m1");
m2( );

}
catch (ArithmeticException err) {

System.out.print ln( err.getMessage( ) );
}

We've now wrapped up the method called m2 in a t ry block. In the catch part , we've used the
Except ion type that was reported in the stack t race - Arithmet icExcept ion.

Run the code again, and the Output window will display the following:
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Notice that the error message is printed out: "/ by zero". The whole of  the m2 method was not
executed, but was stopped where the error occurred. Control was then passed back to m1.
Because there was a catch block to handle the error, the JVM saw no need to a default  error
handler, but  printed out the message between the curly brackets of  catch.

The programme itself  was not stopped, however. Control was passed back to the Main method,
where the m1 method was called. The f inal line in the Main method, print ing out "End Main
method", was executed. This has important implicat ions. Suppose you needed the value from m1,
because you were going to do something with it  in Main. The value wouldn't  be there, and your
programme may not behave as expected.

But if  you see a stack t race in the Output window, just  remember that f irst  line is where the
problem occurred; the rest  of  the lines, if  any, are where the Except ion was handed up the stack,
usually f inishing at  the main method.

In the next part , we'll look at  Logic Errors.

<-- Errors and Except ions | Logic Errors -->
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Logic Errors in Java

Logic errors are the ones you make as a programmer, when the code doesn't  work as you
expected it  to. These can be hard to t rack down. Fortunately, NetBeans has some built -in tools to
help you locate the problem.

First , examine this code:
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Type it  out  for yourself , using either the programme you already have, or by start ing a new
project . What we're t rying to do here is count how many t imes the let ter "g" occurs in the word
"Debugging". The answer is obviously 3. However, when you run the programme the Output
window prints:

"G was found 0 t imes."

So we've made an error somewhere in our code. But where is it? The programme executes OK,
and doesn't  throw up any Except ions for us to study in the Output window. So what to do?

To track down problems with your code, NetBeans allows you to add something called a
Breakpoint .

Click in the margins of  the code window to add a new Breakpoint :
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From the NetBeans menu, click Debug > Debug errorhandling2 (or whatever you called your
project). NetBeans will jump to the breakpoint . It 's has now halted code execut ion at  that  point .
You should also see a new toolbar appear:

The f irst  three buttons allow you to stop the debugging session, pause, and cont inue. The next
f ive buttons allow you to step into code, step over code, step out, or jump to the cursor.

You can also press the F5 key to cont inue. The code should run as normal with the Breakpoint
where it  is. The debugging session will then end.

When the debugging session ends, click back on the Breakpoint  to get rid of  it . Now add a
Breakpoint  to your for loop:

Now click Debug > New Watch. A Watch allows you to keep track of  what 's in a variable. So type
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the let ter i in the Watch dialogue box and click OK:

Add another Watch and then type single_letter. Click OK. Add a third Watch and type
LetterCount . You should these three variables at  the bottom of your screen:

Now press the Step Into icon on the toolbar:

Or just  press the F7 key on your keyboard. Keep pressing the F7 key and see what happens in the
Watch window. You should f ind that the i variable goes up by 1 each t ime. But the other two
variables stay the same:
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Because there's nothing in the single_let ter variable then LetterCount can't  go beyond zero. So
we've found our problem - our use of  substring must be wrong, as it 's not grabbing any
characters.

Stop the debugging session and change your substring line to this:

single_letter = check_word.substring( i, i + 1 );

Now start  the debugging session again. Keep pressing the F7 key to go over each line of  the for
loop. This t ime you should see the sinle_let ter and LetterCount variables change.

When the code ends, you should see the Output window display the following:

"G was found 3 t imes."

We now have the correct  answer.

So if  things are not going as planned with your code, t ry set t ing a Breakpoint  and some Watches
for your variables. Then start  a debugging session.

In the next sect ion, we'll tackle a dif ferent subject  altogether: How to open up text  f iles in Java.

<-- Stack Trace | How to Read a Text File in Java -->
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How to Read a Text File in Java
 

Manipulat ing text  f iles is a skill that  will serve you
well in your programming career. In this sect ion,
you'll learn how to open and how to write to a
text  f ile. But by text  f ile, we just  mean a f ile with
text  in it  - simple as that! You can create a text
f ile in programmes like Notepad on a Windows
computer, TextEdit  on a Mac, Gedit  in a
Linux/Gnome environment.

The f irst  thing we'll do is to open up a text  f ile
and read its contents.

 

Read a Text File

Start  a new project  for this. Call the package textf iles and the class FileData. Add an import
statement just  below the package line and before the class name:

import  java.io.IOException;

Your coding window will then look like this:
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To deal with anything going wrong with our f ile handling, add the following to the main method
(the text  in bold):

public stat ic void main(String[ ] args) throws IOException {

}

We're telling Java that the main method will throw up an IOException error, and that it  has to be
dealt  with. Later, we'll add a t ry … catch block to display an appropriate error message for the
user, should something go wrong.

To open the text  f ile, let 's create a new class. So click File > New File f rom the NetBeans menu
at the top. Create a new Java Class f ile and give it  the name ReadFile. When your new class is
created, add the following three import  statements:

import  java.io.IOException;
import  java.io.FileReader;
import  java.io.BufferedReader;

Your new class should then look like this one:
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(The import  lines are underlined because we haven't  done anything with them yet. This is a
NetBeans feature.)

We'll create a new object  f rom this class to read a f ile. Add the following constructor to your
code, along with the private String f ield called path:

All we're doing here is passing in the name of a f ile, and then handing the f ile name over to the
path f ield.

What we now need to do is create a method that returns all the lines of  code from the text  f ile.
The lines will be held in an array. Add the following method declarat ion that will open up the f ile:
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Don't  worry about the red underline: it  will go away once we've added some code. NetBeans has
just  added it  because we have no return statement.

Not ice that the method is set  up to return a String array, though:

public String[ ]

The array will contain all the lines f rom the text  f ile.

Not ice, too, that  we've added "throws IOExcept ion" to the end of  the method header. Every
method that deals with reading text  f iles needs one of  these. Java will throw any errors up the
line, and they will be caught in our main method.

To read characters f rom a text  f ile, the FileReader is used. This reads bytes f rom a text  f ile, and
each byte is a single character. You can read whole lines of  text , rather than single characters. To
do this, you can hand your FileReader over to something called a BufferedReader. The
BufferedReader has a handy method called ReadLine. As its name suggests, it  is used to read
whole lines, rather than single characters. What the BufferedReader does, though, is to store
characters in memory (the buffer) so that they can be manipulated more easily.

Add the following lines that set  up a FileReader and a BufferedReader:
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We're creat ing two new objects here: one is a FileReader object  which we've called f r; the other is
a BufferedReader object  with the name textReader.

The FileReader needs the name of f ile to open. For us, the f ile path and name is held in the f ield
variable called path. So we can use this.

The BufferedReader is handed the FileReader object  between its round brackets. All the
characters f rom the f ile are then held in memory wait ing to be manipulated. They are held under
the variable name textReader.

Before we can read the lines of  text , we need to set  up an array. Each posit ion in the array can
then hold one complete line of  text . So add the following two lines to your code:

int  numberOfLines = 3;
String[ ] textData = new String[numberOfLines];

For now, we'll set  the number of  lines in the text  f ile to just  3. Obviously, text  f iles can hold any
number of  lines, and we usually don't  know how many. So we'll change this soon. We'll write a
separate method that gets the number of  lines in a text  f ile.

The second line of  new code, though, sets up a String array. The number of  posit ions in the array
(its size) is set  to the number of  lines. We've put this between the square brackets.

To put all the lines of  text  f rom the f ile into each posit ion in the array, we need a loop. The loop
will get  each line of  text  and place each line into the array. Add the following to your code:

int  i;

for (i=0; i < numberOfLines; i++) {
textData[ i ] = textReader.readLine();

}
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Your coding window should now look like this:

The for loop goes from 0 to just  less than the number of  lines. (Array posit ions, remember, start
at  0. The 3 lines will be stored at  posit ions 0, 1, and 2.)

The line that accesses the lines of  text  and stores them in the array is this one:

textData[i] = textReader.readLine( );

After the equals sign we have this:

textReader.readLine( );

The textReader object  we set up is holding all the characters f rom the text  f ile in memory (the
buffer). We can use the readLine method to read a complete line f rom the buffer. Af ter the line is
read, we store the line in an array posit ion:

textData[i]

The variable called i will increment each t ime round the loop, thus going through the ent ire array
storing lines of  text .
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Only two more lines of  code to add to the method, now. So add these lines to your code:

textReader.close( );
return textData;

The close method f lushes the temporary memory buffer called textReader. The return line returns
the whole array. Not ice that no square brackets are needed for the array name.

When you've added the code, all those ugly underlines should disappear. Your method should
then look like this:

There's st ill the problem of the number of  lines, however. We've hard-coded this to 3. What we
need is to go through any text  f ile and count how many lines it  has. So add the following method
to your ReadFile class:
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The new method is called readLines, and is set  to return an integer value. This is the number of
lines a text  f ile has. Not ice this method also has an IOException part  to the method header.

The code for the method sets up another FileReader, and another BufferedReader. To loop
round the lines of  text , we have this:

while ( ( aLine = bf .readLine( ) ) != null ) {
numberOfLines++;

}

The while loop looks a bit  messy. But it  just  says "read each line of  text  and stop when a null value
is reached." (If  there's no more lines in a text  f ile, Java returns a value of  null.) Inside the curly
brackets, we increment a counter called numberOfLines.

The f inal two lines of  code f lush the memory buffer called bf , and returns the number of  lines.

To call this new method into act ion, change this line in your OpenFile method:

int  numberOfLines = 3;

Change it  to this:
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int  numberOfLines = readLines( );

So instead of  hard-coding the number of  lines, we can call our new method and get the number
of lines in any text  f ile.

OK, t ime to put the new class to work and see if  it  opens a text  f ile.

Go back to your FileData class, the one with the main method in it . Set up a string variable to
hold the name of a text  f ile:

At this stage, you need to create a text  f ile somewhere on your computer. We created this simple
one in Notepad on a Windows machine:
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The name of the text  f ile is "test .txt". Create a similar text  f ile on your own computer. Note where
you saved it  to because you need the f ile path as well:

String f ile_name = "C:/test .txt";

So our test .txt  f ile is saved on the C drive. If  we had created a folder called MyFiles to hold the
f ile then the path would be "C:/MyFiles/test .txt". Change you f ile path, if  need be.

The next thing to do is to create a new object  f rom our ReadFile class. We can then call the
method that opens the f ile. But we can do this in a t ry … catch block. Add the following code,
just  below your String variable line:
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Don't  forget all the curly brackets for the t ry … catch block. You need one pair for the t ry part
and another pair for the catch part . For the t ry part , we have this:

ReadFile f ile = new ReadFile( f ile_name );
String[ ] aryLines = f ile.OpenFile( );

The f irst  line sets up a new ReadFile object  called f ile. In between the round brackets of  ReadFile,
we added the f ile_name variable. This is enough to hand the constructor the f ile path it  needs.

The second line of  code sets up a String array called aryLines. Af ter the equals sign, we've called
the OpenFile method of  our ReadFile class. If  it  successfully opens up the text  f ile, then the array
of text  lines will be handed over to the new array aryLines.

If  something goes wrong, however, an error is thrown up the line, and ends up in the catch part  of
the t ry … catch block:

catch ( IOExcept ion e ) {
System.out.print ln( e.getMessage() );

}

After the word "catch" we have a pair of  round brackets. Inside the round brackets, we have this:

IOException e

What this does is to set  up a variable called e which is of  type IOException. The IOExcept ion
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object  has methods of  its own that you can use. One of  these methods is getMessage. The will
give the user some informat ion on what went wrong.

Before we see an example of  an error message, let 's loop through all the lines of  the text  f ile,
print ing out each one. Add the following loop code to the t ry part  of  the t ry … catch block:

int  i;
for ( i=0; i < aryLines.length; i++ ) {

System.out.print ln( aryLines[ i ] ) ;
}

Your coding window should now look like this:

When the programme is run, the Output window will print  the following:
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As you can see, each line f rom our text  f ile has been printed out.

To test  the error checking part  of  the code, change the name of your text  f ile to one you know
has not been created. Then run your code again. In the Output window below, you can see that
our text  f ile was changed to testB, and that it  couldn't  be found:

If  you prefer, you can add your own error message to the catch block:

It 's probably better to leave it  to Java, though!

In the next part , you'll learn how to write to a text  f ile using Java code.

<-- Logic Errors | Write to a Text File -->
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Write to a Text File in Java

Writ ing to a f ile is a lit t le easier than reading a f ile. To write to a f ile, we'll use two more inbuilt
classes: the FileWriter class and the PrintWriter class.

Create a new class in your project  by clicking File > New File  f rom the NetBeans menu. Select
Java in the Categories sect ion of  the dialogue box and Class f rom the File Types list . Click the
Next button at  the bottom. For the Class name type WriteFile, then click Finish. Add the
following three import  statements your new code:

import  java.io.FileWriter;
import  java.io.PrintWriter;
import  java.io.IOException;

Your new class should look like this:
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Again, the underlines are because we haven't  used the imported classes yet.

When you write to a f ile, you can either start  f rom the beginning and overwrite everything. Or you
can start  at  the end and append to the f ile. The FileWriter class allows you to specify which. We'll
add a f ield that sets the append value for the FileWriter class. We'll also add a f ield to set  the
name of the f ile.

So add the following two f ields to your code, plus the constructor:

The boolean f ield is called append_to_f ile and has been set to a value of  false. This is the
default  value for the FileWriter class, and means you don't  want to append, but erase everything
in the f ile.

The constructor sets a value for the path f ield (instance variable), which is the name and locat ion
of the f ile. This will get  handed over when we create a new object  f rom our WriteFile class.

As was ment ioned in the previous sect ion, however, you can set up more than one constructor in
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your code. We can set up a second one and pass in an append value. That way, a user can either
just  use the f irst  constructor and hand over a f ile name, or a f ile name and an append value. So
add the following constructor below the f irst  one:

public WriteFile( String f ile_path , boolean append_value ) {

path = f ile_path;
append_to_f ile = append_value;

}

This second constructor now has two values between the round brackets, a f ile path and an
append value. If  you want to append to the f ile you can use this constructor when creat ing a new
object . If  you just  want to overwrite the text  f ile then you can use the f irst  constructor.

Your code window should now look like this:
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To write to the f ile, add the following method below your two constructors:

public void writeToFile( String textLine ) throws IOException {

}

This method doesn't  need to return a value, so we've made it  void. In between the round brackets
of the method name we have a String variable called textLine. This is obviously the text  we want
to write to the f ile. Again, though, we need to add "throws IOExcept ion" as we need to do
something to handle f ile-writ ing errors.

The f irst  thing we need in the method is a FileWriter object . The FileWriter takes care of  opening
the correct  f ile, and of  storing the text  as bytes. Add the following line to your writeToFile
method:

FileWriter write = new FileWriter( path , append_to_f ile);

So we're creat ing a new FileWriter object  with the name write. In between the round brackets of
FileWriter we pass the name and locat ion of  the f ile, plus the append value. This will either be
t rue (append to the f ile) or false (don't  append). If  a f ile of  the name you pass over does not
exist , the FileWriter creates one for you.

The FileWriter write bytes, however. But we can hand the FileWriter plain text  with the aid of  the
PrintWriter class. The PrintWriter has a few handy print  methods for this. But it  needs the name
of a FileWriter when creat ing the object  f rom the class. So add this line to your method:

PrintWriter print_line = new PrintWriter( write );

Our PrintWriter object  is called print_line. In between the round brackets of  PrintWriter, we've
added the name of our FileWriter object .

To add the text  to a f ile, type the name of the PrintWriter object  followed by a dot:

print_line.

As soon as you type the dot, NetBeans will display a list  of  available opt ions:
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There are an awful lot  of  print  opt ions on the list !

The one we'll use is one of  the printf  methods. This allows you to pass a formatted string of  text
to your PrintWriter. A good reason for using print f  is to handle new line characters. The new line
character dif fers, depending on which operat ing system you use. Windows will add the characters
\r\n for a new line. But Unix systems just  use \n. Using the print f  funct ion will ensure the correct
encoding, no matter what the plat form.

Add the following line to your code:

print_line.printf ( "%s" + "%n" , textLine);

We've handed the print f  method two things: a format for the text , and the string we want to write
to the f ile. The two are separated by a comma. Not ice the f irst  of  the two:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


"%s" + "%n"

The %s between double quotes means a string of  characters of  any length. The %n means a
newline. So we're telling the print f  method to format a string of  characters and add a newline at
the end. The actual text  that  needs formatt ing goes af ter the comma. The print f  method is quite
useful, and we'll go through the opt ions in more detail in a later sect ion. For now, let 's crack on.

Only one more line to add to your method:

print_line.close();

This line closes the text  f ile and frees up any resources it  was using.

Your WriteFile class should now look like this:
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To test  out your new class, go back to your FileData class (the one with the main method). Add
the following line to create a new object  f rom your WriteFile class:

WriteFile data = new WriteFile( f ile_name , t rue );

So we've set up a WriteFile object  called data. In between the round brackets of  WriteFile, we've
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added two things: the name of the f ile, and an append value of  t rue. This will ensure that the
second of  the constructors we set up gets called. If  we wanted to just  overwrite the f ile, then the
code would be this:

WriteFile data = new WriteFile( f ile_name );

Because we set the default  append value as false, we only need the f ile name if  we want to
overwrite the ent ire contents.

To call the writeToFile method of  your WriteFile object , add this line:

data.writeToFile( "This is another line of  text" );

Feel f ree to change the text  between the round brackets of  the method.

To let  the user know that something has happened, you can print  something to the Output
window:

System.out.print ln( "Text  File Writ ten To" );

Your FileData code should now look like this (we've added some comments):
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If  you like, add another t ry … catch part  for your text  writ ing. Instead of  the above, change it  to
this:
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Now run your code to test  it  out . You should see the contents of  your text  f ile in the Output
window followed by the message that the text  f ile has been writ ten to:

Run the programme again and you should see the new line appear. (You can comment out the
code that writes to the text  f ile.)

And that 's it  - you can now write to a text  f ile and read its contents. In the next sect ion, we'll
move on and tackle programming with Java Forms.
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<-- Read a Text File | Java Forms -->
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Creating a Java Form with the NetBeans IDE
Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

You don't  have to output everything to a terminal window in Java. In this sect ion, you'll be writ ing
a calculator programme that makes use of  forms. The form will have buttons and a text  box. We'll
start  of f  with a very simple calculator that  can only add up, and then extend its capabilit ies so
that it  can subtract , divide and mult iply. The calculator will look something like this:
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(The above screenshot was taken on a Windows XP machine. Your calculator will look dif ferent if
you have, say, a Linux operat ing system, or an Apple Mac.)

Let 's make a start .

NetBeans and Java Forms

Developing a Graphic User Interface (GUI) using Java can be an art-form in itself , as there's quite
a lot  to get used to: Components, Containers, Layout Managers, and a whole lot  more besides.
The NetBeans development environment, however, has great ly simplif ied the creat ion of  forms,
and we'll use this to drag and drop controls onto a f rame.

Rather than go through reams of  GUI theory, we'll just  jump straight into it .

Create a new project  for this by clicking File > New Project  f rom the NetBeans menu at  the top.
Select  Java > Java Applicat ion f rom the list  boxes, and then click the Next button.

On step 2 of  the wizard, type MyCalculator as the project  name. At the bottom, uncheck "Create
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main class". This is because a main method will be created for us by NetBeans when we add a
form. Step 2 of  the wizard should look like this:

Click the Finish button, and NetBeans will create the project , but  not much else. Have a look at
the Projects area on the lef t  in NetBeans and you should see this (If  you can't  see the Projects
area, click Window > Projects f rom the NetBeans menu at  the top):

Normally, there's a .java f ile under the Source Packages name. But because we unchecked the
"Create main class" box, there's no java class f ile there.

What we'll do is to add a Form to the project . When the form is created, it  will be created in its
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What we'll do is to add a Form to the project . When the form is created, it  will be created in its
own java class f ile.

To add a form, right  click the project  name in the Projects window. A menu will appear:

Select  New > JFrame  Form from the menu. When you do, you should see the following wizard
appear:

Here, you are being asked for a name for your Class, and a package name. We've already created
the project , and called it  MyCalculator. The package name and class will go into the project . So,
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for your Class Name type JavaCalculator. In the blank package text  box, type jCalculator. So
we're creat ing a class called JavaCalculator, which is in the jCalculator package, which is in the
MyCalculator project .

Click the Finish button to complete the process.

In the next part , you'll see what happens af ter you click f inish, and explore the various windows of
the NetBeans IDE.

 

<-- Write to a Text File | Exploring Form Views -->
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When the wizard f rom the previous sect ion has f inished, it  will create a blank form in the main
window:
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The form is a blank, at  the moment, and has an orange rectangle surrounding it . The orange
rectangle means that the form is the current ly selected object . Click away and you'll see a blue
rectangle instead. This means that the form is not selected. Click back onto the form to select  it ,
and you'll see the orange rectangle again.

Note the two buttons at  the top, Source and Design. You're in Design at  the moment. Click on
Source to see the following code:
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You can expand and contract  the plus symbols to reveal and hide code. Not ice, though, that  a
main method has been created. When the programme starts it 's the main method that will be
called. It 's creat ing a new object  f rom our form, and sett ing its visible property to t rue.

But NetBeans generates all this code for you. Otherwise, you'd have to do it  all yourself !

Have a look at  the Projects area on the lef t  again. You'll see that a package and a class f ile have
been added:
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Click back on the Design button at  the top. You'll see your blank form again. To the right , you'll
have not iced two areas: a Palet te with a lot  of  controls in it , and a Propert ies area. The Palet te
should look like this:

And the Propert ies area should look like this:
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(If  you can't  see them, click Window> Palette and Window > Propert ies f rom the NetBeans
menu.)

A property of  an object  is a list  of  the things you can do with it , like set  the background colour, set
the text , set  the font, and lots more. Let 's change the t it le.

Make sure your form is selected. If  it  is, it  will be surrounded with an orange rectangle. The
propert ies area will say JFrame at the top.

Click inside of  the t it le area and type Calculator:
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Then press the enter key.

To see what ef fect  changing the t it le property has, run your programme in the usual way. When
you run the programme for the f irst  t ime, NetBeans will display a dialogue box asking you which
main method you want to use:
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You only have one, which is in your JavaCalculator class, so just  click OK. Your form should then
appear:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


The form has the t it le you just  typed, plus some default  icons for minimize, maximize and close.
Click the X to close your programme, and return to the Design environment.

In the next part , we'll add a text  box to the form.

 

<-- Java Forms | Adding a Text Box to a Java Form -->
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What our form needs now is a text  box and some buttons. Let 's add the text  box f irst .

Locate the Text Field control in the Palet te:
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Controls in the NetBeans Palet te can be dragged onto a form. So click on Text Field to select  it .
Now hold you lef t  mouse button down on the Text Field. Keep it  held down and drag the control
onto the form:
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Let go anywhere on the form:

The squares around the text  f ield are sizing handles. You can hold down your lef t  mouse button
on one of  the squares and drag to a new width or height. The dotted lines are posit ion indicators,
one for the lef t  posit ion and one for the top posit ion. Not ice that the default  name for the text
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f ield is jTextField1. Let 's change that.

With the text  f ield selected, have a look at  the Inspector area in the bottom lef t : (If  you can't  see
an Inspector area, click Window > Navigat ing > Inspector f rom the NetBeans menu bar.)

As you can see, jTextField1 is selected in the Inspector. This area shows you what objects you
have on your forms. You can also rename an object  f rom here. To do so, right  click on jTextField1.
From the menu that appears, select  Change Variable Name.

When you click on Change Variable Name, a dialogue box appears. Type a new name for the Text
Field. Call it  txtDisplay:
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Click OK. When you do, NetBeans will rename your text  f ield:

Now have a look at  your code again by clicking the Source but ton in the main window. When
your code appears, scroll down to the bottom. You'll see that a new private f ield variable has
been added:

So a JTextField variable has been set up with the name txtDisplay. The "javax.swing" part  is a
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reference to a set  of  packages that are used for GUI development. Swing makes it  easier for you
to create forms and the controls on forms.

Click on the Design but ton at  the top to return to your form. The text  f ield has some default  text
in, at  the moment. You can add your own text  by changing the text  property of  the text  f ield.

Make sure your text  f ield is selected on the form. Now locate text  in the propert ies window:

Delete the default  text  of  jTextField1 and leave it  blank:
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Then press the enter key on your keyboard. Have a look at  your text  f ield object  on the form. It
may well have changed size. Use the sizing handles to resize it . You'll see that it  now has no text
in it  at  all:
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The text  f ield on our calculator will obviously be used for the output of  the calculat ion. But it
won't  work without buttons. You'll see how to add those in the next part  of  this tutorial.

 

<-- Form Views | Adding buttons to a Java Form -->
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You add a button to a form in the same way you do for text  f ields - drag and drop. However, as
we're going to be adding lots of  buttons, it 's a good idea to add the buttons to a control called a
Panel. If  you need to move the buttons, you can then just  move the Panel instead. All the buttons
will then move with the Panel.

So locate the Panel control in the Palet te:
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Drag one on to your form. You can't  see a Panel, as they'll have the same colour as the form. But
you can select  it :
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Drag the sizing handles so that the Panel f ills most of  the form:

We can now add a button.

Locate the Button control in the Palet te:
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Drag one on to your Panel control:
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You should then see a button with sizing handles and posit ion lines:

The default  name of the button is jButton1. Change this name just  like you did for the text  f ield:
right  click in the Inspector area, and select  Change variable name. Change the name of the
button to btnOne:
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The name of the button will have changed in the Inspector:

A new line of  code has also been added:

The new variable name is btnOne, and it  is a JButton object , which is a Swing control. Note, too,
that a variable has been set up for the panel (we've lef t  this on the default  name).

In the next part , you'll learn how to change the propert ies of  Java buttons.

 

<-- Text Boxes | Changing the Propert ies of  a Button -->
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How to Change the Properties of a Button on a Java
Form

Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

In the last  part , you saw how to add a button to your Java form. In this lesson, you'll see how to
change its propert ies.

Go back to Design view and make sure your button is selected. We can change the text  on the
button. What we want is a number, one number for each button on the calculator. The text
property is used for button text . So locate this property in the propert ies window. Delete the
default  and type the number 1 instead:
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Press the enter key on your keyboard and you should see the text  change on your button. It  will
also be resized:
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You can change the size of  the button in the propert ies window. Locate Horizontal Size and
Vert ical Size, under the Layout  heading:
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Change these values from the default  to 50, 30:

You can also change the font and font size in the propert ies window. Make sure your button is
selected. Now locate the font property. Click the small but ton to the right  of  the font row:
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When you click the font button, you should see a dialogue box appear. Change the font size to
14 points, and make it  bold:
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Your form should now look like this (to see the out line of  the panel, just  hover your mouse over
it ):
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You now need to add nine more buttons in the same way, for the numbers 2 to 9, and a 0.
Change each variable name to btnTwo, btnThree, btnFour, etc. Delete the default  text , and enter
a number instead. Then change the size of  each button to 50, 30. Finally, change the font
property of  each button.

When you're f inished, your Inspector area should look like this:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


(Note that the 0 button has the name btnZero.)

If  your buttons are in the wrong place, click a button to select  it . Hold down your lef t  mouse
button. Keep it  held down and drag to a new locat ion in the panel. To move all the buttons at
once, select  the panel and drag it  to a new locat ion:
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When you're happy with your form, it  should look something like this (We've resized the text  f ield):

Only three more buttons to add: a plus button, an equals button, and a clear button. We'll add
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these to a panel of  their own, and move them to the right  of  the calculator.

As you can see, our calculator doesn't  have any room on the right . But you can easily resize a
form.

Click on just  the form, and not the panel or the text  f ield. If  you do it  right , you should see an
orange rectangle surrounding the form. Now move your mouse to the edges of  the form. The
mouse pointer should change shape, as in the image below (bottom right):

Hold down your lef t  mouse button when the pointer changes shape. Now drag to a new size.

Add a panel in the space you've just  created:
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Add three buttons to the new panel. Change the variables names to: btnPlus, btnEquals, and
btnClear. For the text  for the buttons, type a + symbol for the Plus button, a = symbol for
equals button, and the word "clear" for the clear button. Change the font to the same as the
number buttons, 14 point  bold. The size for the plus and equals button should be the same as
the number buttons: 50, 30. For the Clear button, change it  to 70, 30. Your form should then look
like this:
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The Inspector area of  NetBeans should look like this:
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You can run your form at this stage, just  to see what it  looks like:
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Looking quite nice, hey! Nothing will happen when you click on the buttons, though. We'll add
some code short ly. First , a word about Events.

 

<-- Java Buttons | Java Events -->
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Java Form Events
Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

 

In the last  lesson, you design your Java
calculator. In the lesson, you'll learn about events
for Java form objects.

 

In programming terms, an event is when
something special happens. For forms, this
means things like buttons being clicked, the
mouse moving, text  being entered into text
f ields, the programming closing, and a whole lot
more.

Events are objects in Java. They come from a
series of  classes stored in java.ut il.EvenObject .
When a button is clicked, the button is said to be
the source of  the event. But the very act  of

clicking generates an event object . The event object  then looks for an object  that  is listening out
for, say, a mouse click, or a keystroke, or any other event that  can happen on a form. A text  f ield,
for example, can be listening out for key strokes. Or a drop down box could be listening out for
which item in the list  was clicked.

Dif ferent objects (sources) f ire dif ferent event. For a button, the event that  is f ired is the
ActionListener. For a text  f ield, it 's the KeyEvent . Think of  like this: the event object  is
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responsible for passing messages back and forward between form objects that have had
something happen to them, and objects that are wait ing for things to happen.

If  all this sounds a bit  complicated, then don't  worry - it  is complicated! But some programming
examples might clear things up. First , a word about how our calculator will work.

If  we want to add 3 + 2, we f irst  need to click the 3 button. The number 3 will then appear in the
text  f ield. The plus button is clicked next, and this alerts the programme to the fact  that  we want
to add things. It  will also clear the text  f ield ready for the next number. The next number is 2, and
we store this value along with the 3. The equals button is clicked to get the total, and this is
where we take the stored numbers (3 and 2) and add them together. Finally, the answer is stored
in the text  f ield.

The f irst  problem is how to get at  the numbers on the buttons. We can do this by returning the
text  property of  the button. Once we have the text , we can put it  into the text  box. But we need
an Act ionEvent for when the button is clicked.

In Design view in NetBeans, select  your number 1 button. Now have a look at  the Inspector
window in the bottom lef t . Locate your btnOne button. Now right  click to see the following menu
appear:
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Select  Event  f rom the menu. From the submenu, click on Action, and then actionPerformed:
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When you click on actionPerformed, you will create a code stub for btnOne:

private void btnOneActionPerformed(java.awt.event.Act ionEvent evt) {

// TODO add your handling code here:

}

The f irst  line is a bit  long. But it 's just  a method with an Act ionEvent object  between the round
brackets. When the button is clicked, whatever code we write between the curly brackets will get
executed.
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Writing code for the numbers buttons on our Java Calculator

To get text  f rom a form object , you can use the getText method of  the object  (if  it  has one). So
to get the text  f rom btnOne we could use this code:

String btnOneText = btnOne.getText( );

To get text  f rom our text  f ield, we could do this:

String textf ieldText  = txtDisplay.getText( );

However, if  wanted to put something into the text  f ield, the method to use is setText:

txtDisplay.setText( btnOneText );

Try it  out . Add this code to your code stub:

private void btnOneActionPerformed(java.awt.event.Act ionEvent evt) {

String btnOneText = btnOne.getText( );
txtDisplay.setText(btnOneText);

}

Run your programme and test  it  out . Click your 1 button and you should f ind that the number 1
appears in the text  f ield:
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There is a problem, however. What if  you want to enter the number 11, or the number 111? When
you click the button repeatedly, nothing else happens. It 's always a 1, no matter how many t imes
you click.

The reason is that  our code doesn't  keep whatever was in the text  f ield previously. It  just  puts the
number 1 there. If  we wanted the number 11, we would have to keep the f irst  1. To do that, you
can simply get the text  f rom the text  f ield and combine it  with the button text . Amend the f irst  line
of your code to this:

String btnOneText = txtDisplay.getText() + btnOne.getText();

Now we're saying get the text  f rom the text  f ield and combine it  with the button text . Store the
result  in the variable called btnOneText.

Run your programme again, and click your number 1 button a few t imes. You should f ind that the
text  f ield will display a series of  1's:
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We can add the same code for all the number buttons on the calculator. Go back to design view.
Instead of  right-clicking in the Inspector area, another way to add an Act ion for a button is to
simply double click it . So double click your number 2 button. A code stub will be created, just  like
last  t ime.

Add the following code to it :

private void btnTwoActionPerformed( java.awt.event.Act ionEvent evt  ) {

String btnTwoText = txtDisplay.getText() + btnTwo.getText();
txtDisplay.setText( btnTwoText );

}

The only dif ference with the code is the name of the String variable (now called btnTwoText ),
and the fact  that  we're gett ing the text  f rom btnTwo. In between the round brackets of  setText ,
we pass the name of the String variable.

Run your programme again. You should now be able to click the 1 and the 2 buttons and have the
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text  appear in the text  f ield:

Add the same code for all of  your calculator buttons. So double click each button to get the code
stub, and add the two lines of  code for each button. You will need to change the name of the
String variable. Here's the code for button 3:

String btnThreeText = txtDisplay.getText() + btnThree.getText();
txtDisplay.setText( btnThreeText );

You can copy and paste the code you already have. Then just  change the String variable name,
the name of the button af ter the btn part , and the part  between the round brackets of  setText. If
you see any underlines then you know you've done something wrong.

When you've f inished, the code for all the number button should look like this:
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Run your calculator and test  it  out . You should be able to enter all the numbers f rom 0 to 9:

In the next part , you'll write the Java code for the Plus button on your calculator.

 

<-- Button Propert ies | The Calculator Plus Button -->
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Coding the Plus Button of our Java Calculator
Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

 

Now that the number buttons are working on
your Java calculator, the next thing to do is to
handle the plus button. The only thing our plus
button needs to do is to store whatever number
is current ly in the text  f ield. It 's just  a record of
the f irst  number to be added. Later, we'll also
record the fact  that  it  was the plus button that
was clicked, rather than the minus, or the divide,
or the mult iply button.

To store the value, we need to set  up a f ield
variable, that 's a variable outside of  any button
code. This is so that all the buttons can see what
has been stored in it .

Add the following variable near the top of  the
coding window: (You can place it  near the bottom, with the f ield variables NetBeans has set up
for the form objects, but we'll keep our variables separate.)

private double total1 = 0.0;

Here's the code window:
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So we're set t ing up a variable called total1. The type of  variable is a double. Its default  value is
0.0.

To store the value from the text  f ield, we need to get the text . But we'll need to convert  it  f rom a
String to a Double. You can do so with the parseDouble method of  the Double object :

Double.parseDouble( txtDisplay.getText( ) )

In between the round brackets of  parseDouble we get the text  f rom the txtDisplay text  f ield.

However, when we store the value from the text  f ield into the total1 variable, we need to retain
what is already in total1. We can also clear the text  f ield, ready for the second number.

So return to Design view in NetBeans. Double click your Plus button to generate the code stub.
Now add the following two lines to your plus button:

total1 = total1 + Double.parseDouble( txtDisplay.getText( ) ) ;
txtDisplay.setText("");

In between the round brackets of  setText, we have a pair of  double quotes, with no space
between them. This is enough to clear the text  f ield.

And that 's it  for the Plus button, for the moment. We'll come back to it  later. All we're doing,
though, is storing a number in the total1 variable, and keeping what is already there. Once the
number is stored, we've cleared the text  f ield. The user can now enter a second number to be
added to the f irst .

in the next part , we'll add code for the equals button on our calcualtor.
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<-- Java Events |The Equals Button -->
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Coding the Equals Button of our Java Calculator
Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

Now that you have some code for your Plus button, we can tackle the equals button.

 

After the user has chosen a second number, the equals button needs to be clicked. Clicking the
equals button will produce the answer to the addit ion.

To store the output of  the calculat ion, we can set up another f ield variable. Add the following line
to the top of  your code:

private double total2 = 0.0;

Your code window should look like this:
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To get the answer to the calculat ion, we take whatever is current ly stored in total1 and add it  to
whatever is current ly in the text  f ield. Again, though, we need to parse the string f rom the text
f ield and turn it  into a double.

Go back to Design view and double click your equals button. In the code stub that is created, add
the following line:

total2 = total1 + Double.parseDouble( txtDisplay.getText( ) );

This line gets the text  f rom the text  f ield and converts the string into a double. The result  is then
added to total1. The answer is then stored in the total2 variable.

The next thing we need to do is to display the answer to the calculat ion back into the text  f ield.
However, we now have to convert  the double back into a string, as text  f ields hold text  and not
numbers. If  you try to store a double value direct ly into a text  f ield you'll get  errors.

To convert  a double into text  you can use the toString method of  the Double object . Add the
following line just  below the f irst  one:

txtDisplay.setText( Double.toString( total2) );

The conversion is done between the round brackets of  setText. But you could set up a new
variable, if  you wanted:

String s1 = Double.toString( total2 );
txtDisplay.setText( s1 );

But the result  is the same: convert  a double to a string.

The f inal line for the equals button can clear the total1 variable. Once the total1 variable is
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cleared, a new calculat ion can be entered. Here's the line to add:

total1 = 0;

The three lines for your equals button should now be these:

total2 = total1 + Double.parseDouble( txtDisplay.getText( ) ) ;
txtDisplay.setText( Double.toString(total2) );
total1 = 0;

In the next part , we'll write code for the Clear button. You'll also get to t ry a few exercises.

 

<-- The Plus Button | The Clear Button -->
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Coding the Clear Button of our Java Calculator
Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

 

The only thing lef t  to code for now is the Clear
button. For this, we need to clear the total2
variable and set the text  in the text  f ield to a
blank string.

In Design view, double click your Clear button to
create the code stub. Now add these two lines to
your Clear button:

total2 = 0;
txtDisplay.setText("");

Once you've added the lines, you can try your
calculator out. Run the programme and try
adding numbers. You should f ind that your
calculator adds up f ine.

 

Exercise
There is one thing missing, however - a point  symbol. At  the moment, your calculator can't  handle
sums like 23.6 + 35.8. So add a point  button to your form. Write the code for it . (Hint  - it 's
pract ically the same code as for your number buttons.)
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Exercise
Set the font property for your text  f ield so that it 's 14 point  bold

When you've completed the above exercises, you calculator should look something like ours:

 

Congratulat ions - you have now writ ten a Java calculator programme! OK, it  can only add up, but
it 's a start .

What we'll do now is to make it  subtract , divide and mult iply.

 

<-- The Equals Button | Subtract , Divide, Mult iply Buttons -->
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Subtract, Divide and Multiply Buttons for our Java
Calcualtor

Java Calculator Project : 1 2 3 4 5 6 7 8 9 10

 

Now that the plus button is working on our Java
Calculator, we can add buttons to subtract ,
divide and mult iply. Just  like the addit ion button,
however, these buttons won't  do any
calculat ions: the equals button will st ill do all the
work. The only thing the operator buttons will do
is to record which button was clicked: add,
subtract , divide, or mult iply.

The f irst  thing to do is to place some more
buttons on your form. In the image below, we've
moved the Clear button, and put all the operator
buttons in the panel to the right . Feel f ree to
come up with your own design, though:
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Once you've added the new buttons, rename the default  variables to btnSubtract , btnDivide, and
btnMult iply. (Another way to rename the variable is to simply right-click the button. You'll then see
a menu appear. Select  "Change Variable Name".)

The technique we'll use to get which operator button was clicked is to store the button text  in a
f ield variable. We can then use a switch statement to examine which character is in the f ield
variable. If  it 's the + symbol we can add; if  it 's the ? symbol we'll subtract ; if  it 's the / symbol we'll
divide; and if  it 's the * symbol we'll mult iply.

So click the Source button to get back to your code. Add the following f ield variable to the top,
just  below your other two:

private char math_operator;

The top of  your code should then look like this:
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We can set up a method to get at  the character on the button that was clicked. Add the following
method to your code:

You can add the above method anywhere in your code, as long as it 's between the curly brackets
of the Class, and not between the curly brackets of  any other method.

We've called the method getOperator. It 's a void method, so won't  return any value - it  will just  get
on with execut ing the code. In between the round brackets of  the method header, we have a
String variable called btnText. This is obviously the text  f rom the button that was clicked.

The text  f rom the button is a string. However, switch statements in Java can't  handle strings, so
we need to convert  the string to a character. We do so with this line:

math_operator = btnText.charAt(0);

The charAt method of  strings will get  a character f rom a string. The character you want goes
between the round brackets of  charAt. The math symbol f rom our buttons is always at  character
0 in the string. This is then stored in the char f ield variable we've just  set  up at  the top of  the
code.

Not ice the other two lines in the code. They are exact ly the same as the lines f rom the plus
button, doing exact ly the same thing - storing the f irst  number in the variable called total1. Each
operator button needs to do this, so it  makes sense to have these two lines in our method,
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rather than in the operator button code.

So locate your btnPlus code and delete the following two lines f rom it :

total1 = total1 + Double.parseDouble(txtDisplay.getText( ) );
txtDisplay.setText("");

Replace them with these two lines:

String button_text  = btnPlus.getText();
getOperator(button_text);

The f irst  new line gets the text  f rom the plus button and stores it  in a string variable. This is then
handed over to our method getOperator.

The same two lines can be added to the other operator button, only changing the name of the
button.

Go back to design view and double click your subtract  button. For the code stub, add the
following:

String button_text  = btnMinus.getText();
getOperator(button_text);

(Although we've used the same name for the String variable Java won't  get  confused, as each
button_text  is local to its part icular button code.)

Double click your divide button and add this:

String button_text  = btnDivide.getText();
getOperator(button_text);

And here's the code for the mult iply button:

String button_text  = btnMult iply.getText();
getOperator(button_text);

Now that we have code for all four operator button, we can adapt the equals button.

For the equals button, we can set up a switch statement to examine what is in the
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math_operator variable.

switch ( math_operator ) {
case '+':

break;
case '-':

break;
case '/':

break;
case '*':

break;
}

The switch statement has a case for each of  the math operators: +, -, /, and *. We haven't  added
any code, yet . But have a look at  the code you already have for you equals button:

total2 = total1 + Double.parseDouble( txtDisplay.getText( ) ) ;
txtDisplay.setText( Double.toString(total2) );
total1 = 0;

The last  two lines are OK, and don't  need to be changed. The f irst  line, however, can be used in
the switch statement. This line, remember, is the one that adds up. 
It  can be moved up and used as the code for the + case:

case '+':
total2 = total1 + Double.parseDouble(txtDisplay.getText( ) );
break;

If  the minus button was clicked, then we can simply change the plus to a minus in the line above:

case '-':
total2 = total1 + Double.parseDouble(txtDisplay.getText( ) );
break;

The case for the divide is then this:

case '/':
total2 = total1 + Double.parseDouble(txtDisplay.getText( ) );
break;

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


And the case for the mult iply character is this:

case '*':
total2 = total1 + Double.parseDouble(txtDisplay.getText( ) );
break;

Here's the ent ire code for your equals button:

Once you've added the new code to your equals button, run your calculator and try it  out . Try the
following, to see if  it  works:

58. 6 + 37.5 (answer should be 96.1)
78 - 25.5 (answer should be 52.5)
68 / 8 (answer should be 8.5)
56.3 * 6.8 (answer should be 382.84)

And that 's it  - you now have a simple working calculator that  can add, subtract , divide, and
mult iply:
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Now that you've had some pract ice with form objects, let 's create a new programme that makes
use of  the more common controls you'll f ind on a form.

 

<-- The Clear Button | Java Combo Boxes -->
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Java Combo Boxes
Java Form Controls: 1 2 3 4 5 6 7

In this sect ion, you'll see how to use some of the more common controls you can add to a Java
form. You'll learn how to use the following:

Combo Box
Check Box

Radio Buttons
Text Areas

List  Box
Menus and Menu Items

Open File Dialogue boxes
Save File Dialogue boxes

We'll start  with Combo Boxes.

Create a new project  for this (Java > Applicat ion). Call the project  formcontrols, and uncheck the
"Create main class" box:
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Click the Finish button on the wizard to create the project . Now add a form by right-clicking the
project  name in Projects window and select ing New > JFrame Form:
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When the dialogue box appears, enter FormObjects as the Class name, and
form_controls_lesson as the package name:

You will then have a Class called FormObjects, which is in the package called
form_controls_lesson, which in the formcontrols project .

You will also have a new form on which to add controls.

 

The JComboBox Control

A combo box is a drop down list  of  items that can be selected by a user. It  can be found in the
NetBeans palet te, under Swing Controls:
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Locate the Combo Box control and drag one on to your form. Drag a Button onto the form, and a
Text Field. What we'll do is to place the item selected from the drop down list  into the text  f ield.
This will happen when the button is clicked.

Click back onto your Combo Box to highlight  it . Right-click and select  Change Variable Name
f rom the menu that appears. Type comboOne as the new name, and then click OK.

Change the name of the button in the same way, rename it  btnComboBox. Change the text  on
the button to Get Drop Down Item.

Change the name of the Text Field to txtComboBoxItem. Delete the default  text  and leave it
blank. Your form should then look something like this one:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


The default  items in the Combo Box are Item 1, Item 2, etc. We'll add our own items.

Click back onto your Combo Box to select  it . Now look at  the propert ies window on the right  of
NetBeans. Locate the model property:
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Click the small but ton to the right  of  the model row, the one with the three dots in it . The
following dialogue box appears:
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You can highlight  the items in the white text  area, and delete them. Replace them with the
following items: C Sharp, Java, PHP, Visual Basic .NET. Your dialogue box will then look like this:
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Click OK when you've made the changes. Your combo box will now be f illed with your own items.

Run your programme and test  it  out : (Just  click OK when it  asks you to choose the Main Class.)

Close the programme and return to design view.

When the button is clicked, we want the item chosen to appear in the text  f ield. So double-click
your button to create a code stub.

To get which item is selected there is a handy method of  combo boxes called getSelectedItem.
But this returns an Object  as a value. What we want is the text  f rom the list . You can do
something called casting to turn the Object  into a String. Add the following line to your code
stub:

String itemText = (String)comboOne.getSelectedItem( );

So we're set t ing up a string variable called itemText . Af ter the equals sign we use the
getSelectedItem method of  comboOne. But note how the cast ing is done - with the String
variable type between round brackets. This goes immediately before the object  or value you're
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t rying to cast (cast ing just  means convert ing f rom one variable type to another).

To display the selected item in the text  f ield, you just  need to set  the text  for the text  f ield. Add
this line just  below the line you have:

txtComboBoxItem.setText( itemText );

Run your programme again and try it  out . Select  an item from your drop down list . Then click your
button. The item you selected should appear in the text  f ield:

The combo box looks a lit t le dull, at  the moment. You can it  up with a bit  of  colour, and dif ferent
fonts.

Stop your programme and return to Design view in NetBeans. Click on your combo box to select
it . Now have a look at  the propert ies window again. Try set t ing the following:

Background Colour
Foreground Colour

Font
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Border

You'll need to play around with them for a while. For the colours, RGB seems to work best.

In the next lesson, you'll see how Java check boxes work.

 

<-- Calculator Operator Buttons  | Java Check Boxes -->
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A check box is a way to allow your users to select  and deselect  items. They can be a lit t le f iddly,
though, so it 's a good idea to add them to a panel. That way, you can move them all at  once just
by moving the panel.

So add a panel to your form, which can be found under Swing Containers in the NetBeans
palet te. Now locate the check box control. Drag a check box onto your panel.
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The text  jCheckBox1 is the default  text . You can change this either in the propert ies window, or
by right-clicking the check box. From the menu that appears, select  Edit  Text (we've chopped a
few menu items of f  the list , in the image below):

When you click on Edit  Text , the default  text  will be highlighted:
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Type C Sharp over the top of  the highlighted text :

Press the enter key on your keyboard to conf irm the change. The text  will change for your check
box:

However, this just  changes the text , and not the variable name. The variable name will st ill be
jCheckBox1, as you can see in the Inspector area to the lef t :
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Leave it  on the default  variable name. But just  be aware that changing the text  of  a control does
not change its variable name.

Now that you have added one check box to your panel, add three more. Change the text  of  the
three to: Java, PHP, and Visual Basic. Your check boxes will then look like this:

What we'll do is to get the items that a user has checked. We'll do this when a button is clicked.
To display the items, we'll use the Text Area control, rather than a text  f ield.

So add a button to your form. Change the variable name to btnCheckBoxes. Change the text  on
the button to Selected Items.

Locate the Text Area control in the NetBeans palet te, and drag one onto your form. Change the
variable name to taOne.

When you've aligned your new controls, your form should look something like this:
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Now for the code.

Java checkboxes have a property called isSelected. We can use this in a series of  IF Statements
to see if  each box is selected or not. If  they are, we can build up a string, adding the text  f rom
each check box.

Double click your new button to create a code stub. Add the following code:
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The string we're building up is called s1. If  a check box is selected then we get the text  f rom that
check box. This is then stored in the s1 variable, along with a new line character ( '\n') The last  line
of code sets the text  for the text  area. In between the round brackets of  setText, we have the s1
variable, which is the string we're building up.

When you've f inished typing the code, run your programme. Select  a few check boxes and then
click the button. You should f ind that the items you checked appear in the text  area:
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Deselect  a box or two and try again. Only the boxes selected should appear in the text  area.

 

In the next lesson, we'll take a look at  Radio Buttons.

 

<-- Combo Boxes | Radio Buttons -->
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Java Radio Buttons
Java Form Controls: 1 2 3 4 5 6 7

Radio buttons are usually used to select  just  one item from a list , rather than the mult iple items
available with check boxes. Let 's see how they work.

Drag and drop a panel onto your form. Then locate the Radio Button control in the NetBeans
palet te. Drag a Radio button onto your new palet te. It  should look like this:

The default  text  for the f irst  radio button is jRadioButton1. We'll use our radio buttons to allow a
user to select  a payment method. So change the text  of  your radio button to Credit  Card. (The
text  can be changed in the same way as you did for check boxes. Again, we'll leave the variable
name on the default  of  jRadioButton1.)
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Add two more radio buttons to the panel. Change the text  to Debit  Card, and PayPal:

There is, however, a problem with the radio buttons you've just  added. To see what the problem
is, run your programme again. Now select  one of  the radio buttons. Try select ing another radio
button and you'll f ind that you can indeed select  more than one at  the same t ime:

With our radio buttons, though, we only want the user to select  one payment opt ion. To solve
the problem, Java lets you to create something called a ButtonGroup. As its name suggest, this
allows you to group buttons under one name. You can then add radio buttons to the group. Once
you've added buttons to the group, only one opt ion is available for select ion.

To see how the ButtonGroup works, add the following method to your code, somewhere near
the top:

private void groupButton( ) {

ButtonGroup bg1 = new ButtonGroup( );
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bg1.add(jRadioButton1);
bg1.add(jRadioButton2);
bg1.add(jRadioButton3);

}

When you do, you'll see that NetBeans has alerted to you to a problem, and underlined some
code in red. It  has done this because it  can't  f ind a class called ButtonGroup, so can't  create a
new object  f rom it .

To solve this problem, you need to import  the relevant class f rom the Swing library. So scroll up to
the very top of  your code, and add the following import  statement:

import  javax.swing.ButtonGroup;

The red underline should now be gone.

Our groupButton method adds radio buttons to the ButtonGroup object , with the use of  the add
method:

bg1.add( radio_button_name );

There's one line for every radio button on our form.

We can call the groupButton method from the constructor. That way, the radio buttons will be
grouped when the form loads. Add the following method call to your constructor:

The top of  your code window should look like this:
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Run your form again, and try to select  more than one radio button. You should f ind that you can
only select  one in the group.

To get at  which radio button was selected, again there's an isSelected method we can use.

Add a normal button to your form. When we click this button we'll display a message box stat ing
which radio button was clicked.

Change the variable name of your button to btnRadios. Change the text  property to Payment
Opt ion.

Now double click your new button to create a code stub. Add the following:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


All we're doing here is checking which radio button is selected. We're then gett ing the text  f rom
the radio button and storing it  in a variable called radioText.

We can have a message box to display which payment opt ion was selected. Add the following line
to the bottom of your button code, just  below the f inal IF statement:

javax.swing.JOpt ionPane.showMessageDialog( FormObjects.this, radioText  );

This line is so long that we've had to reduce the font size! But you've met the JOpt ionPane in a
previous sect ion. The only dif ference is the f irst  item between the round brackets. Because we
were using a console, the f irst  item was null. Now we have:

FormObjects.this

The f irst  item between the round brackets is for the window in which you want to display the
message box. Null meant no window. FormObjects.this means this component (the form) of  the
FormObjects class.

Run your programme again, and select  an item from your radio button. Then click your button.
You should see something like the following:

In the next part , you'll see how to add menus to your Java Forms.

 

<-- Java Check Boxes | Java Menus -->
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Java Menus
Java Form Controls: 1 2 3 4 5 6 7

You can add menus to your Java forms, things like File, Edit , View, etc. Each menu has menu
items, and these in turn can have sub menus.

Return to Design view. In the NetBeans palet te, locate the Menu Bar item:
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Drag one to the top of  your form. When you let  the mouse button go, you'll have a default  File
and Edit  menu bar:

There's no menu items added by default , though. To add your own, click on the File menu item to
select  it . With the File menu item selected, right-click. A new menu will appear. Select  Add From
Palette > Menu Item:

A Menu Item will be added to your File menu:
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What we'll do is to add menu items to open and save a f ile.

Double click on the default  text  jMenuItem1. It  will then be highlighted, so that you can type over
it :

Type Open, then press the enter key on your keyboard:

Add another menu item in the way. This t ime, type Save as the menu item:

As you can see above, you can add shortcuts for your menu items. Click on to the Open menu
item, then onto the shortcut  for it :

With the shortcut  item selected, have a look at  the propert ies window:
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Locate the Accelerator item, and click the small but ton to the right  of  the row. A dialogue box
appears. You can set which shortcut  keys you want for a menu item from this dialogue box. An
open shortcut  is usually CTRL + O.

Type an O in the box, and Shif t  + O will appear. Uncheck the Shif t  item and check Ctrl instead:

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


Click OK, and the shortcut  will be added to your Java menu item:

To see if  all this works, click back on the Open menu item to highlight  it . Now right  click. From the
menu that appears, select  Events > Act ion > Act ion Performed. This will create a code stub for
the menu item. Enter the following for the code:

javax.swing.JOpt ionPane.showMessageDialog( FormObjects.this, "Open" );

This is just  a message box.
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Run your programme and try it  out . Click File > Open and you should see the message box
appear. Click OK to get rid of  it . Now try your shortcut . Hold down the Ctrl key on your keyboard.
Keep it  held down and press the let ter O. Again, the menu should appear.

Stop your programme and return to your code stub. Comment out the message box. What we'll
do is to write code to display a File Open dialogue box. A user can then select  a f ile to be opened.
We'll do that in the next part .

 

<-- Radio Buttons | File Open Dialogue Boxes -->
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The Java File Choser
Java Form Controls: 1 2 3 4 5 6 7

In this lesson, you'll see how to display Open File dialogue boxes in Java. This is done with the
File Choser control.

Go back to Design view. In the NetBeans palet te, locate the File Chooser item, which is under
Swing Windows:

Drag a File Chooser near your form, but not onto it . Drop it  just  below the form, in a white area. It
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won't  actually appear on the form, but you can see it  in the Inspector window:

The default  name for the File Chooser is jFileChooser1. Right click on jFileChooser1 in the
Inspector window. From the menu that appears, select  Change Variable Name. When the dialogue
box appears, type db as the name:

Click OK to conf irm the change. The Inspector window should look like this:
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You now have a File Chooser added to the project .

Displaying the File Chooser dialogue box is quite simple. Go back to the code stub for your Open
menu item, the one where you had the message box. Now type the following line:

int  returnVal = db.showOpenDialog( this );

Our File Chooser is called db. We're using the ShowOpenDialog method of  the File Chooser
class. In between the round brackets of  ShowOpenDialog you type then name of the window
that 's going to be holding the dialogue box. We've typed this, meaning "this form".

The ShowOpenDialog method returns a value. This value is an integer. The value tells you which
button was clicked on the dialogue box: open, cancel, etc. We're storing the value in a variable
called returnVal. We'll use this value in a moment.

But run your programme again. Click File > Open on your form. You should see a dialogue box
appear:
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Unfortunately, the only thing an Open Dialogue box does is to select  a f ile - it  doesn't  actually
open anything. If  you want to open a f ile, you have to write the code yourself . We'll do that soon.
But for now, we can get the name and path of  the f ile that  a user selects.

First , add the following IF Statement to your code, just  below your other two lines (the returnVal
one and your commented-out message box):

if  (returnVal = = javax.swing.JFileChooser.APPROVE_OPTION) {

}

So we're using a Swing class called JFileChooser. With this class, you can examine which button
was clicked. When you type the dot af ter JFileChooser you should see a popup list :
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The APPROVE_OPTION means things like the OK and Yes buttons. So we're test ing the
returnVal variable to see if  it  matches the APPROVE_OPTION (did the user click OK?).

To get at  the f ile chosen by the user there is a method called getSelectedFile. However, this
returns a File object , rather than a string. The File object  is part  of  the IO class in Java. So add the
following line to your IF Statement:

java.io.File f ile = db.getSelectedFile( );

So the f ile chosen by the user will end up in the File object  that  we've called f ile.

To do something useful with it  (open the f ile, for example), we need to convert  it  to a string:

String f ile_name = f ile.toString( );

This line just  uses the toString method of  File objects. We're placing the result  in a new variable
called f ile_name. Add the line to your IF Statement.

To display the f ile name, remove the comments f rom your message box and move it  as the last
line of  your IF Statement. Change the last  parameter between the round brackets to f ile_name:
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javax.swing.JOpt ionPane.showMessageDialog(FormObjects.this, f ile_name);

Because this line is so long, you can add an import  statement to the top of  your code,
underneath the one you already have:

import  javax.swing.JOptionPane;

The message box line can then just  be:

JOptionPane.showMessageDialog( FormObjects.this, f ile_name);

It 's a lit t le bit  easier to read, now!

But your code should now look like this:

Run your programme and test  it  out . Click File > Open to see the dialogue box. Select  any f ile on
your computer and click Open. Your message box should display:

Before we add the code to open up the selected f ile, you may have not iced that Files of  Type

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


on your Open f ile dialogue box is set  to "All f iles". You can f ilter the f iles on this list , so that the
user can open only, say, text  f iles, or just  images with certain extensions (jpeg, gif , png).

To f ilter the "Files of  Type" list , the dialogue box has an addChoosableFileFilter method. But
you need a Filter object  between the round brackets.

So that your code doesn't  get  unnecessarily long, add the following two import  statements to
the top of  your code, just  below the other ones:

import  javax.swing.f ilechooser.FileFilter;
import  javax.swing.f ilechooser.FileNameExtensionFilter;

To set up a f ile name extension f ilter, you need to create a new FileFilter object . Add the following
line just  before the f irst  line of  your code (before the int  returnVal line):

FileFilter f t  = new FileNameExtensionFilter("Text  Files", "txt");

In between the round brackets of  FileNameExtensionFilter you f irst  need the text  that  will
appear on the Files of  Type list . Af ter a comma you type the name of f iles that you want to
display. A proper f ile extension is needed, here, but without the dot. Note the double quotes
above.

You can add more than one extension. Just  type a comma and then the f iles you want to display:

FileNameExtensionFilter("Text  Files", "txt", "html");

Once you have a f ilter object  set  up, you can use the addChoosableFileFilter method of  your
dialogue box:

db.addChoosableFileFilter( f t  );

Add the line to your code, just  below the FileFilter line:
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Run your programme again, and have a look at  your dialogue box. Click the arrow on the
dropdown list :

Select  the Text Files opt ion. Your dialogue box will then only displays f iles with the extension .txt .

If  you want another line on the list , (to display html f iles, for example), you can set up another
FileFilter object :

When the programme is run, the Files of  Type list  would then look like this:
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We can now write the code to actually open the f ile. We'll do that in the next part .

 

<-- Java Form Menus | Opening Files in Java -->
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Actually, you have already writ ten code to open a f ile. The process is no dif ferent for the open f ile
dialogue box. And because you have already writ ten the classes that open and write to a f ile, you
can just  import  them into the current project .

To import  a class that you have already writ ten, have a look at  the Propert ies window on the lef t
of  NetBeans. (If  you can't  see the propert ies window, click the Window menu item at the top of
NetBeans. From the Window menu, select  Propert ies.)

Expand the entry for your current project , and right-click the Libraries item:
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From the menu that appears, select  Add Project . When you do, you'll see the following dialogue
box:
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Make sure that the Look in box at  the top says "NetBeans Projects". Now scroll down and locate
your TextFiles project . This is where your classes are that open and write to a f ile. Now click the
"Add project  JAR f iles" button. The dialogue box will close and you'll be returned to NetBeans.
Have a look at  the Libraries entry for your current project  and you'll see that it  has been imported:

Now that you've added the classes to your project , you can add an import  line to the top of  your
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code:

import  textf iles.ReadFile;

If  your recall, ReadFile was what we called the class that opened a f ile. The package name we
came up with was called text f iles. We're now import ing the ReadFile class, and can now create
new objects f rom it .

ReadFile f ile_read = new ReadFile( f ile_name );

Adapt your IF Statement to add the following t ry …catch code:

The code is just  about the same as when we opened a text  f ile previously: get the name of the
f ile and create a new ReadFile object , call the openFile method we created, and return all the
lines as an array, then loop round reading each line. Not ice that we place all the lines in the text
area control on our form.
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Exercise
One thing missing, however, is a message in the catch part  of  the t ry … catch block. Move your
message box between the curly brackets of  catch. In between the round brackets of
showMessageDialog add a suitable message. Or you can simply use e.getMessage.

When you've completed the code, t ry it  out . You should be to open a f ile using your File > Open
menu. The text  f ile should then appear in your text  area f ield.

 

<-- File Choser | The Save File Dialogue Box -->
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The Save File Dialogue Box
Java Form Controls: 1 2 3 4 5 6 7

If  you want to display the Save File dialogue box instead of  the Open File dialogue box then you
can use your File Chooser again. This t ime, instead of  showOpenDialog you use
showSaveDialog:

int  returnVal = db.showSaveDialog( this );

Again, this is enough to display the dialogue box. You don't  have to do anything else, though you
can add a f ile f ilter, as well.

FileFilter f t  = new FileNameExtensionFilter( "Text  Files", "txt" );
db.addChoosableFileFilter( f t  );

int  returnVal = db.showSaveDialog(this);

To write the f ile, add an import  statement to the top of  your code:

import  textf iles.WriteFile;

You can then create a new WriteFile object . Again, you can place the code inside of  an IF
Statement, along with a t ry … catch block:
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The last  two lines in the code above get the data f rom the text  area. This is then placed into a
string variable called alltext . We then call the writeToFile method from our WriteFile class.

Exercise
Create a code stub for your File > Save menu item. Add the above code to it . Run your
programme and try it  out . Type some new text  into the text  area. Then click File > Save on your
menu. When the "Save File" dialogue box appears, type a f ile name and then click Save. Check
your f ile to see if  it  has indeed been created, and that it  contains the text  you wrote in the text
area.

 

And that 's it  for this introduct ion to forms and form objects. We'll move on. In the next sect ion,
we'll take a look at  databases.

 

<-- Opening Text Files | Java and Databases -->

 PDFmyURL.com

http://www.homeandlearn.co.uk/java/opening_files_part2.html
http://www.homeandlearn.co.uk/java/java_and_databases.html
http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


Back to the Home Page

© All course material copyright Home and Learn

 PDFmyURL.com

http://www.homeandlearn.co.uk/java/java.html
http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


 

 

COMPUTER COURSES

Home

Beginners Computing

Word 2007 to  2010

Word 2000 to  2003

Excel 2007 to  2010

Excel to  2003

Web Design

Visual Basic .NET

Beginners PHP

C# .NET

Java for Beginners

 

Java and Databases
Databases: 1 2 3 4 5 6

 

In this sect ion, you'll learn about Java databases.
You'll create a simple database with one table,
and learn how to connect to it  using Java code.

 

About Java and Databases

Java uses something called JDBC (Java
Database Connect ivity) to connect to
databases. There's a JDBC API, which is the
programming part , and a JDBC Driver Manager,
which your programmes use to connect to the
database.

JDBC allows you to connect to a wide-range of
databases (Oracle, MySQL, etc), but  we're going to use the in-built  database you get with the
Java/NetBeans software. The database is called Java DB, a version of  Apache Derby. It  runs on a
virtual server, which you can stop and start  f rom within NetBeans.

To check that have everything you need, have a look at  the Services tab in NetBeans. If  you
can't  see the Services tab, click Window from the NetBeans menu. From the Window menu, select
Services. You should see something like this:
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Expand the Databases item to see a Java DB item, and a Drivers sect ion:

The idea is that  you start  the Java DB virtual server, and then create and manipulate databases
on the server. There should be a database called sample already set up: (But don't  worry if  it 's
not there as we'll create our own database.)

In the image above, there are three databases: one is called sample, one is called test1, and the
other is called exams.

For the project  in this sect ion, we're going to set  up a new database. You'll then learn how to
connect to this database using Java code. The database we'll create will be a simple one-table
affair, rather than mult iple tables connected together. You can indeed create mult iple tables with
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Java DB, but we don't  want to complicate things unnecessarily.

 

Starting the Virtual Server

The f irst  thing to do is to start  the server. So right  click on Java DB. You'll see a menu appear.
Select  Start  Server:

Have a look at  the Output window and you'll see a few messages appear: (If  you have a f irewall
running, you'll need to let  the Java DB server through.)

Once the server is up and running you can create databases. You'll see how to do that in the next
lesson.
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<-- Save File Dialogue Box | Creat ing a Database -->
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Creating a Database with Java
Databases: 1 2 3 4 5 6

 

Now that your server has been started, you can go ahead and create a database.

To create a new database, right  click on Java DB again. From the menu that appears, select
Create Database:
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When you click on Create Database, you'll see a dialogue box appear:

Type a name for your database in the f irst  box. Call it  Employees. Type any User Name and
Password (something a bit  harder to crack than ours below!):

Click OK to create your database. It  should then appear on the list :
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Creating a Table in the Database

Now that the database has been created, you need to create a table in the database. To do so,
right  click on your database. From the menu that appears select  Connect :

When a connect ion is made, you'll see some default  folders for Tables, Views, and Procedures
(see further down if  your screen is not like this):
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To create a new table in your database, right  click the Tables folder. From the menu that appears,
select  Create Table:

If  you don't  see just  the three folders above, but have something like this instead:
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Click the APP entry, and then right-click on Tables.

When you click on Create Table, a dialogue box appears. Either this one:
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Or this one:
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From here, you not only type a name for your table, but you also set up the columns for the
table.

In the Table Name at the top, delete the default  name of Unt it led. Type a new name for your
table. Call it  Workers. You'll then have a table called Workers, which is in the Employees
database.

But you can't  click OK just  yet  as the table has no columns in it . We want to create columns with
the following names:

ID
First_Name
Last_Name
Job_Tit le

The ID column will hold a unique ident ifying number. This will ident ify a row in the table. A column
with unique data in it  is known as a Primary Key. Because it 's the Primary Key, the column has to
hold data: It  can't  hold a null value. (A null value just  means there's no informat ion there.)

If  your Create Table dialogue box is like the f irst  one, then put a t ick in the box for Key. When you
t ick the Key box, check marks will also appear for Index and Unique. Now enter a t it le in the
Column Name area. Type ID:
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You now need to specify what kind of  data is going in to the column. For our ID column, we'll have
Integers. So scroll along unt il you come to Data Type. Click on Data Type and a drop down list
will appear. From the drop down list , select  Integers:

If  your dialogue box is like the second one, then you need to click the Add Column button to add
your f irst  table column. You'll see another dialogue box appear. This one:
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The NAME is the name of the column in the table, like ID, First_Name, etc. The TYPE is the DATA
TYPE, Integer, VARCHAR, etc. Click the dropdown list  to see more. Then check or uncheck the
CONSTRAINTS boxes as indicated below:
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Click OK and you should be returned to the Create Table dialogue box:
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We now have enough for the ID column in the table. Click the Add Column button on the right  to
add a new column to the table. Enter the following values for this column (VARCHAR means a
variable number of  characters):

Key: Unchecked
Index: Unchecked
Null: Unchecked
Unique: Unchecked
Column Name: First_Name
Data Type: VARCHAR
Size: 20

For the third column in your table, enter the following values:

Key: Unchecked
Index: Unchecked
Null: Unchecked
Unique: Unchecked
Column Name: Last_Name
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Data Type: VARCHAR
Size: 20

For the f inal column, here are the values to enter:

Key: Unchecked
Index: Unchecked
Null: Unchecked
Unique: Unchecked
Column Name: Job_Tit le
Data Type: VARCHAR
Size: 40

When you're f inished, your Table dialogue box should look like this:

Click OK when you've entered all the informat ion. Your table and table columns will then be
created:
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The next thing to do is to add some records to the database table. We'll do that next.

 

<-- Java and Databases | Adding Records to a Database Table -->
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A database table is like a spreadsheet, in that  it  has rows and columns. Each row in our table has
cells (f ields) for an ID value, a First  Name, a Last Name, and a Job Tit le. Short ly, you'll learn how to
write code to add new rows of  informat ion to the table. But you can use the NetBeans IDE to add
rows as well.

To add a new row to your table, right  click on your table name. From the menu that appears,
select  View Data:

 

Free Java Course

 PDFmyURL.com

http://www.homeandlearn.co.uk/index.html
http://www.homeandlearn.co.uk/BC/BeginnersComputing.html
http://www.homeandlearn.co.uk/word2007_2010/Word-2007-2010.html
http://www.homeandlearn.co.uk/MW/MicrosoftWord.html
http://www.homeandlearn.co.uk/excel2007/Excel2007.html
http://www.homeandlearn.co.uk/ME/MicrosoftExcel.html
http://www.homeandlearn.co.uk/WD/WebDesign.html
http://www.homeandlearn.co.uk/NET/vbNet.html
http://www.homeandlearn.co.uk/php/php.html
http://www.homeandlearn.co.uk/csharp/csharp.html
http://www.homeandlearn.co.uk/java/java_and_databases.html
http://www.homeandlearn.co.uk/java/creating_a_database_with_java.html
http://www.homeandlearn.co.uk/java/sql_commands.html
http://www.homeandlearn.co.uk/java/connect_to_a_database_using_java_code.html
http://www.homeandlearn.co.uk/java/connecting_to_a_database_table.html
http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


Java for Beginners

 

When you click on View Data, you'll see a new window appear in the main NetBeans window
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You use the bottom half  of  window to enter new table rows. The top half  is for SQL Commands.
(You'll learn more about them soon, when we've f inished adding rows.)

To add a new row, click the icon with the green plus symbol, in the bottom half  of  the window:

When your click the new row icon, a dialogue box appears:
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As you can see, there are text  boxes for each column in our table. For the ID column, we'll use
sequent ial numbering, start ing with 1. The second row in the table will then have an ID of  2, the
third row 3, etc. The numbers are not the row numbers: they are just  unique values for each ID
f ield. We could have easily started with a value of  100 as the f irst  ID number. The second number
would then be 101, the third 102, etc.

Enter the following data as the f irst  row of  your table:

ID: 1
First  Name: Helen
Last Name: James
Job Tit le: IT Manager

Your dialogue box will then look like this:
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Click OK when you're done and you'll be returned to the NetBeans window. The f irst  row should
then be displayed:

Add three more rows with the following data:

ID: 2
First  Name: Eric
Last Name: Khan
Job Tit le: Programmer

ID: 3
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First  Name: Tommy
Last Name: Lee
Job Tit le: Systems Analyst

ID: 4
First  Name: Priyanka
Last Name: Collins
Job Tit le: Programmer

When you've f inished adding the new rows, your NetBeans window should look like this one:

In the next lesson, you'll a few SQL commands.

 

<-- Create a Database | SQL Commands -->
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SQL Commands
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In the previous lesson, you created records in
your Java DB database table. In this lesson, you'll
learn a few SQL commands so that you can
manipulate records in a table.

 

SQL stands for Structured Query Language,
and is a way to query databases. You can select
records, insert , delete, and update records,
create tables, drop tables, and more besides. It 's
quite a powerful tool.

SQL uses simple keywords to do the work. If  you
want to select  all the records f rom a table, the
words SELECT and FROM are used, along with
the "all records" symbol, which is *:

SELECT * FROM table_name

If  you look at  the top half  of  the NetBeans window, you'll see that a SELECT statement has
already been set up: (NOTE: SQL is not case sensit ive)

select  * f rom ADMIN.WORKERS
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This says "Select  all the records f rom the table called Workers". (The ADMIN part , before the dot
of  Workers, is something called a Schema. This describes the structure of  the database, but also
ident if ies things like users and the privileges they have. Don't  worry about schemas, as we won't
be going into them.)

In NetBeans, you run a SQL statement by clicking the Run but ton on the toolbar:

The results f rom the SQL statements are then displayed in the bottom half  of  the window:

 

The WHERE Clause

To narrow down your search results, you can use a WHERE clause with the SELECT statement:

SELECT * FROM table_name WHERE column_name=value

After the keyword WHERE you need the name of a column from your table. You then type an
equals sign, followed by a value. As an example, here's a SQL statement that returns all the
programmers in our table:

SELECT * FROM ADMIN.WORKERS WHERE JOB_TITLE='Programmer'

To try this SQL Statement out, right-click your table name in the Services area. From the menu
that appears, select  Execute Command:
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When you click on Execute Command, a new window appears. Type the above SQL Statement,
and then click the Run icon:

The results will be displayed in the bottom half  of  the window:

As you can see, two rows are returned from the query.

You can also use the keyword LIKE with the WHERE clause. This then replaces the equals sign.
LIKE is usually used with a wildcard character. The wildcard character % means "any characters",
for example, while an underscore is used for just  a single character.

Instead of  the equals sign or the keyword LIKE, you can also use the condit ional operators
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(Greater Than, Less Than, etc.). If  we had a salary column, we could search for all workers who
are gett ing paid more than 1000 a week:

SELECT * FROM ADMIN.WORKERS WHERE SALARY > 1000

Exercise
Try running the following SQL Statement:

SELECT * FROM ADMIN.WORKERS WHERE JOB_TITLE LIKE '%er'

How many results are displayed?

 

We'll leave SQL Statements there, as we now have enough to start  programming. Before doing
so, however, close down the connect ion to your table by right  clicking it  in the Services are. From
the menu, select  Disconnect:

We'll connect to this database and table again, using Java code this t ime

 

<-- Adding New Records | Connect to a Database Using Java Code -->
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Connect to a Database Using Java Code
Databases: 1 2 3 4 5 6

 

In a later sect ion, you'll create a Java form that
loads informat ion from a database. The form will
have Next and Previous to scroll through the
data. Individual records will then be displayed in
text  f ields. We'll also add button to Update a
record, Delete a record, and create a new record
in the database.

To get started, and for simplicity's sake, we'll use
a terminal/console window to output the results
from a database.

So start  a new project  for this by clicking File >
New Project  f rom the NetBeans menu. Create a
Java Applicat ion. Call the package
database_console, and the Main class

DBConnect :
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When you click Finish, your code should look like this:

 

Connecting to the Database
To connect to a database you need a Connect ion object . The Connect ion object  uses a
DriverManager. The DriverManager passes in your database username, your password, and the
locat ion of  the database.

Add these three import  statements to the top of  your code:
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import  java.sql.Connection;
import  java.sql.DriverManager;
import  java.sql.SQLException;

To set up a connect ion to a database, the code is this:

Connect ion con = DriverManager.getConnect ion( host, username, password );

So the DriverManager has a method called getConnect ion. This needs a host name (which is the
locat ion of  your database), a username, and a password. If  a connect ion is successful, a
Connect ion object  is created, which we've called con.

You can get the host address by looking at  the Services tab on the lef t  of  NetBeans:

The address of  the highlighted database above is:

jdbc:derby://localhost:1527/Employees

The f irst  part , jdbc:derby://localhost , is the database type and server that  you're using. The
1527 is the port  number. The database is Employees. This can all go in a String variable:

String host = "jdbc:derby://localhost:1527/Employees";
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Two more strings can be added for the username and password:

String uName = "Your_Username_Here";
String uPass= " Your_Password_Here ";

Add these three string before the connect ion object  and your code would look like this:

As you can see in the image above, there is a wavy underline for the Connect ion code. The
reason for this is because we haven't  t rapped a specif ic error that  will be thrown up when
connect ing to a database - the SQLExcept ion error.

It 's the DriverManager that at tempts to connect to the database. If  it  fails (incorrect  host address,
for example) then it  will hand you back a SQLExcept ion error. You need to write code to deal with
this potent ial error. In the code below, we're t rapping the error in catch part  of  the t ry … catch
statement:

t ry {

}
catch ( SQLException err ) {

System.out.print ln( err.getMessage( ) );
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}

In between the round brackets of  catch, we've set up a SQLExcept ion object  called err. We can
then use the getMessage method of  this err object .

Add the above t ry …catch block to your own code, and move your four connect ion lines of
code to the try part . Your code will then look like this:

Try running your code and see what happens.

You may get this error message in the console window:

"java.net .ConnectException : Error connecting to server localhost on port  1527 with
message Connection refused: connect."

If  you do, it  means you haven't  connected to your database server. In which case, right  click on
Java DB in the Services window. From the menu that appears, click Start  Server:
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You need to make sure that any f irewall you may have is not blocking the connect ion to the
server. A good f irewall will immediately display a message alert ing you that something is t rying to
get through, and asking if  you want to allow or deny it . When you allow the connect ion, your
NetBeans output window should print  the following message:

"Apache Derby Network Server - 10.4.1.3 - (648739) started and ready to accept
connections on port  1527 at  DATE_AND_TIME_HERE"

Once your server is started, run the programme again. There's a very good chance you'll get
another error message:

"No suitable driver found for jdbc:derby://localhost:1527/Employees"

The reason for this error is that  the DriverManager needs a Driver in order to connect to the
database. Examples of  drivers are Client  Drivers and Embedded Drivers. You can import  one of
these so that the DriverManager can do its job.

Click on the Projects tab to the lef t  of  the Services window in NetBeans. (If  you can't  see a
Projects tab, click Window > Projects f rom the menu bar at  the top of  NetBeans.)

Locate your project  and expand the entry. Right-click Libraries. From the menu that appears,
select  Add Jar/Folder :
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When you click on Add Jar/Folder a dialogue box appears. What you're doing here is adding a
Java Archive f ile to your project . But the JAR f ile you're adding is for the derby Client  Drivers. So
you need to locate this folder. On a computer running Windows this will be in the following
locat ion:

C:\Program Files\Sun\JavaDB\lib

The f ile you're looking for is called derbyclient .jar. If  you can't  f ind it , or are using an operat ing
system other than Windows, then do a search for this f ile. Note the locat ion of  the f ile.

In the dialogue box, select  the derbyclient .jar f ile:
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Click Open and the f ile will be added to your project  library:

Now that you have a Client  driver added to your project , run your programme again. You should
now be error f ree. (The Output window will just  say Run, and Build Successful.)

In the next lesson, we'll cont inue with this Java database tutorial.
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<-- SQL Commands | Connect ing to the Database Table -->
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Connecting to a Database Table
Databases: 1 2 3 4 5 6

 

Now that you have connected to the database, the next step is to access the table in your
database. For this, you need to execute a SQL Statement, and then manipulate all the rows and
columns that were returned.

To execute a SQL statement on your table, you set up a Statement object . So add this import
line to the top of  your code:

import  java.sql.Statement;

In the t ry part  of  the t ry … catch block add the following line (add it  just  below your Connect ion
line):

Statement stmt = con.createStatement( );

Here, we're creat ing a Statement object  called stmt . The Statement object  needs a Connect ion
object , with the createStatment  method.

We also need a SQL Statement for the Statement object  to execute. So add this line to your
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code:

String SQL = "SELECT * FROM Workers";

The above statement selects all the records f rom the database table called Workers.

We can pass this SQL query to a method of  the Statement object  called executeQuery. The
Statement object  will then go to work gathering all the records that match our query.

However, the executeQuery method returns all the records in something called a ResultSet .
Before we explain what these are, add the following import  line to the top of  your code:

import  java.sql.ResultSet;

Now add this line just  below your SQL String line:

ResultSet  rs = stmt.executeQuery( SQL );

So our ResultSet object  is called rs. This will hold all the records f rom the database table. Before
we go any further, though, here's an explanat ion of  what ResultSets are.

 

ResultSets in Java

A ResultSet is a way to store and manipulate the records returned from a SQL query. ResultSets
come in three dif ferent types. The type you use depends on what you want to do with the data:

1. Do you just  want to move forward through the records, f rom beginning to end?
2. Do you want to move forward AND backward through the records, as well as detect ing any

changes made to the records? 
3) Do you want to move forward AND backward through the records, but are not bothered
about any changes made to the records?

3. Do you want to move forward AND backward through the records, but are not bothered
about any changes made to the records?

Type number 1 on the list  above is called a TYPE_FORWARD_ONLY ResultSet. Number 2 on the
list  is a TYPE_SCROLL_SENSITIVE ResultSet. The third ResultSet opt ion is called
TYPE_SCROLL_INSENSITIVE.
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The ResultSet type goes between the round brackets of  createStement:

Statement stmt = con.createStatement( );

Because we've lef t  the round brackets empty, we'll get  the default  RecordSet, which is
TYPE_FORWARD_ONLY. In the next sect ion, we'll use one of  the other types. But you use them
like this:

Statement  stmt  = con.createStatement ( RecordSet .TYPE_SCROLL_SENSITIVE );

So you f irst  type the word RecordSet. Af ter a dot, you add the RecordSet type you want to use.

However, it  doesn't  end there. If  you want to use TYPE_SCROLL_SENSITIVE or
TYPE_SCROLL_INSENSITIVE you also need to specify whether the ResultSet is Read Only or
whether it  is Updatable. You do this with two built -in constants: CONCUR_READ_ONLY and
CONCUR_UPDATABLE. Again, these come after the word RecordSet:

ResultSet.CONCUR_READ_ONLY
ResultSet.CONCUR_UPDATABLE

This leads to a rather long line of  code:

Statement  stmt  = con.createStatement ( RecordSet .TYPE_SCROLL_SENSITIVE,
ResultSet .CONCUR_UPDATABLE);

One more thing to get used to with ResultSets is something called a Cursor. A Cursor is really
just  a pointer to a table row. When you f irst  load the records into a ResultSet, the Cursor is
point ing to just  before the f irst  row in the table. You then use methods to manipulate the Cursor.
But the idea is to ident ify a part icular row in your table.

 

Using a ResultSet

Once you have all the records in a Results set , there are methods you can use to manipulate your
records. Here are the methods you'll use most of ten:
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The ResultSet also has methods you can use to ident ify a part icular column (f ield) in a row. You
can do so either by using the name of the column, or by using its index number. For our Workers
table we set up four columns. They had the following names: ID, First_Name, Last_Name, and
Job_Tit le. The index numbers are therefore 1, 2, 3, 4.

We set up the ID column to hold Integer values. The method you use to get at  integer values in a
column is getInt :

int  id_col = rs.get Int("ID");

Here, we've set up an integer variable called id_col. We then use the getInt  method of  our
ResultSet object , which is called rs. In between the round brackets, we have the name of the
column. We could use the Index number instead:

int  id_col = rs.get Int(1);

Notice that the Index number doesn't  have quote marks, but the name does.

For the other three columns in our database table, we set them up to hold Strings. We, therefore,
need the getString method:

String f irst_name = rs.getString("First_Name");
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String f irst_name = rs.getString("First_Name");

Or we could use the Index number:

String f irst_name = rs.getString(2);

Because the ResultSet Cursor is point ing to just  before the f irst  record when the data is loaded,
we need to use the next method to move to the f irst  row. The following code will get  the f irst
record f rom the table:

rs.next( );
int  id_col = rs.get Int("ID");
String f irst_name = rs.getString("First_Name");
String last_name = rs.getString("Last_Name");
String job = rs.getString("Job_Tit le");

Notice that rs.next  comes f irst  in this code. This will move the Cursor to the f irst  record in the
table.

You can add a print  line to your code to display the record in the Output window:

System.out.print ln( id_col + " " + f irst_name + " " + last_name + " " + job );

Here's what your code should look like now (we've adapted the print  line because it 's a bit  too
long):
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If  you want to go through all the records in the table, you can use a loop. Because the next
method returns t rue or false, you can use it  as the condit ion for a while loop:

while ( rs.next( ) ) {

}

In between the round brackets of  while we have rs.next . This will be t rue as long as the Cursor
hasn't  gone past the last  record in the table. If  it  has, rs.next will return a value of  false, and the
while loop will end. Using rs.next like this will also move the Cursor along one record at  a t ime.
Here's the same code as above, but using a while loop instead. Change your code to match:
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When you run the above code, the Output window should display the following:

Now that you have an idea of  how to connect to a database table and display records we'll move
on and write a more complex programme using forms and buttons to scroll through the records.

 

<-- Connect to Database | Databases and Java Forms -->
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In this sect ion, you'll create a form with buttons and text  f ields. The buttons will be used to scroll
forwards and backwards through the records in a database table. We'll also add buttons to
perform other common database tasks. The form you'll design will look something like this:
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Start  a new project  for this by clicking File > New Project  f rom the NetBeans menu. When the
dialogue box appears, select  Java > Java Applicat ion. On step one of  the dialogue box, type
database_form as the Project  Name. Uncheck the box at  the bottom for Create Main Class.
Click the Finish button to create an empty project .

In the Project  area on the lef t  locate your database_form project , and right  click the entry. From
the menu that appears select  New > JFrame Form:
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When the dialogue box appears, type Workers for the Class name, and Employees as the
package name. When you click Finish, you should see a blank form appear in the main NetBeans
window.

Add a Panel to your form. Then place four Text Fields on the panel. Delete the default  text  for
the Text Fields, leaving them all blank. Change the default  variable names for the Text Fields to
the following:

text ID
textFirstName
textLastName
textJobTit le

Add a label to your panel. Posit ion it  just  to the lef t  of  the job t it le Text Field. Enter "Job Tit le" as
the text  for the label. Arrange the Text Fields and the Label so that your form looks something
like this:
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Now have a look at  the Inspector area to the lef t  of  NetBeans. (If  you can't  see it , click Window >
Inspector f rom the NetBeans menu.) It  should match ours:

What we want to do now is to have the f irst  record f rom the database table appear in the text
f ields when the form f irst  loads. To do that, we can call a method from the form's Constructor.

First , though, we can add Client  Driver JAR f ile to the project , just  like last  t ime. This will prevent
any "Driver Not Found" errors. So, in the Projects area, right  click the Libraries entry for your
project . From the menu that appears, select  Add JAR/Folder. When the dialogue box appears,
locate the derbyclient .jar f ile. Then click Open to add it  to your project .

In the main NetBeans window, click the Source button at  the top to get to your code. Now add

 PDFmyURL.com

http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


the following import  statements near the top:

import  java.sql.Connection;
import  java.sql.DriverManager;
import  java.sql.SQLException;
import  java.sql.Statement;
import  java.sql.ResultSet;
import  javax.swing.JOptionPane;

You've met all these before, the f irst  f ive f rom the previous sect ion. The last  one, JOpt ionPane, is
so that we can display error messages.

Inside of  the Class, add the following variable declarat ions:

Connection con;
Statement stmt;
ResultSet  rs;

Just below the Workers Constructor, add the following method:

public void DoConnect( ) {

}

Now add a call to this method from the Constructor:

public Workers() {
initComponents();
DoConnect();

}

Your code window will then look like this: (Don't  worry if  you have underlines for the import
statements. Unless they're red underlines. In which case, you may have made a typing error.)
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What we've done here is to set  up a Connect ion object  called con, a Statement object  called
stmt , and a ResultSet object  called rs. We've set them up at  the top because our buttons will
need access to these objects.

When the form loads, our DoConnect  method will be called. We can add code here to connect to
the database, and display the f irst  record in the text  f ields.

The code to add for the DoConnect method is almost ident ical to the code you wrote in the
previous sect ion. It 's this:
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One line that you may not have met is this one:

String id = Integer.toString( id_col );

Because the ID column is an Integer, we need to convert  it  to a String for the setText  method of
the Text Field. We need to do this because Text Field's don't  accept Integer values direct ly - you
need to convert  them to text .

All the other lines in the code should be familiar to you by now. Study the code to make sure you
know what 's happening. Then add it  your own DoConnect method.
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You can run your programme now. First , though, make sure to start  your Java DB server f rom the
Services window.

When you run your programme, you should see the f irst  record displayed in the Text Fields:

Now that we have the f irst  record displayed, we can add some buttons to scroll through the rest
of  the table data. We'll do that in the next lesson.

 

<-- Connect to a Table | Database Scrolling Buttons -->

Back to the Home Page
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Database Scrolling Buttons
Databases and Java Forms: 1 2 3 4 5 6 7 8

 

What we'll do now is to add four buttons to the form. The buttons will enable us to move forward
through the records, move back, move to the last  record, and move to the f irst  record.

So add a new panel to your form. Enlarge it  and then add for buttons to the panel. Change the
variable names of  the buttons to the following:

btnNext
btnPrevious

btnLast
btnFirst

Change the text  on each button the Next, Previous, Last, First . You form will then look something
like this:
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Move to the Next Record

Double click your Next button to create a code stub.

You need to do two things with the Next button: f irst , check if  there is a next record to move to;
and second, if  there is a next record, display it  in the Text Fields. We can create an IF Statement
for this. But it  needs to be wrapped up in a t ry … catch block. So add the following to your Next
button code stub:

t ry {
if  ( rs.next( ) ) {

}
else {

rs.previous( );
JOptionPane.showMessageDialog(Workers.this, "End of  File");

}
}
catch (SQLException err) {

JOptionPane.showMessageDialog(Workers.this, err.getMessage());
}
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The IF Statement moves the ResultSet on one record at  a t ime. If  there isn't  a next record then a
value of  false is returned. The Else part  moves the ResultSet back one record. That 's because
the Cursor will have moved past the last  record.

In the curly brackets for the IF Statement we can add the code to display the record in the Text
Fields:

int  id_col = rs.get Int("ID");
String id = Integer.toString(id_col);
String f irst  = rs.getString("First_Name");
String last  = rs.getString("Last_Name");
String job = rs.getString("Job_Tit le");

text ID.setText(id);
textFirstName.setText(f irst);
textLastName.setText(last);
textJobTit le.setText(job);

This is the same code we have in our DoConnect method. (We could create a new method, so as
not to duplicate any code, but we'll keep it  simple.)

The code for your Next button should now look like this:
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When you've added your code, run your programme and test  it  out . Keep clicking your next
button and you'll scroll through all the records in the table. However, there is a problem.

When you get to the last  record, you should see an error message appear:
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The problem is that  we've added an rs.previous line. However, we've used the default  ResultSet
type. As we explained in the last  sect ion, this gets you a ResultSet that  can only move forward.
We can use the type suggested in the error message.

Stop your programme and return to your coding window. In your DoConnect method, locate the
following line:

stmt = con.createStatement( );

Change it  to this (yours need to go on one line):

stmt = con.createStatement( ResultSet .TYPE_SCROLL_INSENSITIVE,
ResultSet .CONCUR_UPDATABLE );

The ResultSet type will now allow us to scroll backwards as well as forwards.

Run your programme again. Click the Next button unt il you get to the last  record. You should see
the error message from the t ry part  of  the t ry … catch block appear:
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In the next lesson, you'll learn how to backwards through your database records.

 

<-- Databases and Java Forms | Move Back through a Java Database -->
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The code for the Previous but ton is similar to
the Next  but ton. But instead of  using rs.Next ,
you use rs.Previous.

Return to the Design window and double click
your Previous but ton to create a code stub.

Instead of  typing out all that  code again, simply
copy and paste the code from your Next button.
Then change the rs.Next , in the IF statement to
rs.Previous. Change the rs.Previous in the ELSE
part  to rs.Next. You can also change your error
message text  f rom "End of  File" to "Start  of  File".

Your code should look like this:
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Run your programme again. You should be able to move backward and forward through the
database by clicking your two buttons.

 

<-- Scrolling Buttons | Move to the First  and Last Records -->
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Moving to the f irst  and last  records of  your database is a lot  easier.

Double click your First  but ton to create the code stub. Now add the following code:
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We have no need of  an IF ... ELSE Statement, now. The only thing we need to do is move the
Cursor to the f irst  record with rs.First , then display the f irst  record in the Text Fields.

Similarly, add the following code for your Last button (you can copy and paste the code for the
First  button):

The only change to make is the use of  rs.Last on the f irst  line in place of  rs.First .
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When you've added the code, run your programme again. You should now be able to jump to the
last  record in your database, and jump to the f irst  record.

In the next part , you'll learn how to update a record.

 

<-- Previous Record | Update a Record -->
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Updating a Record
Databases and Java Forms: 1 2 3 4 5 6 7 8

 

The ResultSet has Update methods that allow you to update records not only in the ResultSet
itself , but  in the underlying database. Let 's see how it  works.

Make your form a bit  longer. Now add a new panel to the form. Add a new button to the panel.
Change the default  variable name to btnUpdateRecord. Change the text  on the button to
Update Record. We're also going to have buttons to create a new record in the database, to
save a record, cancel any updates, and to delete a record. So add four more buttons to the panel.
Make the following changes:

Button Variable Name: btnNewRecord
Button Text : New Record

Button Variable Name: btnDeleteRecord
Button Text : Delete Record

Button Variable Name: btnSaveRecord
Button Text : Save New Record
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Button Variable Name: btnCancelNewRecord
Button Text : Cancel New Record

When you're done, your form should look something like this one (though feel f ree to rearrange
the buttons):

Double click your Update button to create a code stub.

The f irst  thing to do is get the text  f rom the Text Fields:

String f irst  = textFirstName.getText( );
String last  = textLastName.getText( );
String job = textJobTit le.getText( );
String ID = text ID.getText( );

If  we want to update an ID f ield, however, we need to convert  the String to an Integer:

int  newID = Integer.parseInt( ID );
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The Integer object  has a method called parseInt . In between the round brackets of  parseInt , you
type the string that you're t rying to convert .

Now that we have all the data f rom the Text Fields, we can call the relevant update methods of
the ResultSet object :

rs.updateString( "First_Name", f irst  );

There are quite a few dif ferent update methods to choose from. The one above uses
updateString. But you need the f ield type from your database table here. We have three strings
(First_Name, Last_Name, Job_Tit le) and one integer value (ID). So we need three updateString
methods and one updateInt .

In between the round brackets of  the update methods, you need the name of a column from
your database (though this can be its Index value instead). Af ter a comma you type the
replacement data. So, in the example above, we want to update the First_Name column and
replace it  with the value held in the variable called f irst .

The update methods just  update the ResultSet, however. To commit  the changes to the
database, you issue an updateRow command:

rs.updateRow( );

Here are all the lines of  code to update the ResultSet and the database table:

t ry {
rs.updateInt( "ID", newID );
rs.updateString( "First_Name", f irst  );
rs.updateString( "last_Name", last  );
rs.updateString( "Job_Tit le", job );
rs.updateRow( );
JOptionPane.showMessageDialog(Workers.this, "Updated");

}
catch (SQLException err) {

System.out.print ln(err.getMessage() );
}

Again, we need to wrap it  all up in a t ry … catch statement, just  in case something goes wrong.
Not ice, too, that  we've added a message box for a successful update.
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Here's the ent ire code to add for your Update Button:

Run your programme and try it  out . Change some data in a Text Field (Tommy to Timmy, for
example). Then click your Update button. Scroll past  the record then go back. The change should
st ill be there. Now close down your programme and run it  again. You should f ind that the changes
are permanent.

In the next lesson, you'll see how to add a new record

 

<-- Move First , Move Last | Add a New record -->

Back to the Home Page

© All course material copyright Home and Learn

 PDFmyURL.com

http://www.homeandlearn.co.uk/java/move_to_the_first_and_last_records.html
http://www.homeandlearn.co.uk/java/add_a_new_record_to_the_database.html
http://www.homeandlearn.co.uk/java/java.html
http://pdfmyurl.com?otsrc=watermark&otclc=0.01
http://pdfmyurl.com?otsrc=watermark&otclc=0.01


 

 

COMPUTER COURSES

Home

Beginners Computing

Word 2007 to  2010

Word 2000 to  2003

Excel 2007 to  2010

Excel to  2003

Web Design

Visual Basic .NET

Beginners PHP

C# .NET

Java for Beginners

 

Add a New Record
Databases and Java Forms: 1 2 3 4 5 6 7 8

 

We have three buttons that refer to new records:
New Record, Save New Record, and Cancel New
Record. The New Record button will only clear
the Text Fields, and ready them for new data to
be entered. We can also disable some other
buttons, including the New Record button.
Another thing we can do is to make a note of
which record is current ly loaded. If  a user
changes his or her mind, we can enable all the
buttons again by clicking the Cancel button.
Clicking the Save New Record button will do the
real work of  saving the data to the database.

If  that 's all a lit t le confusing, t ry the following.
Click on your Save New Record button to select
it . In the Propert ies area on the right , locate the

Enabled property:
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Uncheck the box to the right  of  enabled. The Save New Record will be disabled. Do the same for
the Cancel New Record button. The Cancel New Record will be disabled. When your form loads, it
will look like this:
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Even if  you had code for these two buttons, nothing would happen if  you clicked on either of
them.

When the New Record button is clicked, we can disable the following buttons:

First
Previous

Next
Last

Update Record
Delete Record

New Record

The Save and Cancel buttons, however, can be enabled. If  the user clicks Cancel, we can switch
the buttons back on again.

Double click your New Record button to create a code stub. Add the following lines of  code:
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btnFirst .setEnabled( false );
btnPrevious.setEnabled( false ) ;
btnNext.setEnabled( false );
btnLast.setEnabled( false );
btnUpdateRecord.setEnabled( false );
btnDelete.setEnabled( false );
btnNewRecord.setEnabled( false );

btnSaveRecord.setEnabled( t rue );
btnCancelNewRecord.setEnabled( t rue );

So seven of  the buttons get turned of f  using the setEnabled property. Two of  the buttons get
turned on.

We can do the reverse for the Cancel button. Switch back to Design view. Double click your
Cancel New Record button to create a code stub. Add the following:

btnFirst .setEnabled( t rue );
btnPrevious.setEnabled( t rue ) ;
btnNext.setEnabled( t rue );
btnLast.setEnabled( t rue );
btnUpdateRecord.setEnabled( t rue );
btnDelete.setEnabled( t rue );
btnNewRecord.setEnabled( t rue );

btnSaveRecord.setEnabled( false );
btnCancelNewRecord.setEnabled( false );

Now run your programme and test  it  out . Click the New Record button and the form will look like
this:
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Click the Cancel New Record button and the form will look like this:
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Another thing we need to do is to record which row is current ly loaded. In other words, which row
number is current ly loaded in the Text Fields. We need to do this because the Text Fields are
going to be cleared. If  the Cancel button is clicked, then we can reload the data that was erased.

Add the following Integer variable to the top of  your code, just  below your Connect ion,
Statement, and ResultSet lines:

int  curRow = 0;

The top of  your code should look like this:
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Now go back to your New Record code.

To get which row the Cursor is current ly point ing to there is a method called getRow. This allows
you to store the row number that the Cursor is current ly on:

 

curRow = rs.getRow( );

We'll use this row number in the Cancel New Record code.

The only other thing we need to do for the New Record button is to clear the Text Fields. This is
quite simple:

textFirstName.setText("");
textLastName.setText("");
textJobTit le.setText("");
text ID.setText("");

So we're just  set t ing the Text property to a blank string.

Because we've used a method of  the ResultSet, we need to wrap everything up in a t ry … catch
block. Here's what the code should look like for your New Record button:
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For the Cancel button, we need to get the row that was previously loaded and put the data back
in the Text Fields.

To move the Cursor back to the row it  was previously point ing to, we can use the absolute
method:

rs.absolute( curRow );

The absolute method moves the Cursor to a f ixed posit ion in the ResultSet. We want to move it
the value that we stored in the variable curRow.

Now that Cursor is point ing at  the correct  row, we can load the data into the Text Fields:

textFirstName.setText( rs.getString("First_Name") );
textLastName.setText( rs.getString("Last_Name") );
textJobTit le.setText( rs.getString("Job_Tit le") );
text ID.setText( Integer.toString( rs.get Int("ID" )) );
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Wrapping it  all in a t ry … catch block gives us the following code:

When you've f inished adding the code for the New and Cancel buttons, run your programme and
try it  out . Before clicking the New Record button, the form will look like this:
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Click the New Record button to see the Text Fields cleared:
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Clicking the Cancel button will reload the data:
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Now that the New and Cancel buttons have been set up, we can go ahead and save any new
data entered into the Text Fields.

 

<-- Update | Save a New Record -->
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Databases and Java Forms: 1 2 3 4 5 6 7 8

 

Before you can save a new record, you have to move the Cursor to something called the Insert
Row. This creates a blank record in the ResultSet. You then add the data to the ResultSet:

rs.moveToInsertRow( );

rs.updateInt("ID", newID);
rs.updateString("First_Name", f irst);
rs.updateString("Last_Name", last);
rs.updateString("Job_Tit le", job);

rs.insertRow( );

After adding the data to the ResultSet, the f inal line inserts a new row.

However, to commit  any changes to the database what we'll do is to close our Statement object
and our ResultSet object . We can then reload everything. If  we don't  do this, there's a danger that
the new record won't  get  added, either to the ResultSet or the database. (This is due to the type
of Driver we've used.)
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To close a Statement or a ResultSet, you just  issue the close command:

stmt.close( );
rs.close( );

The code to reload everything is the same as the code you wrote when the form f irst  loads:

stmt = con.createStatement(ResultSet .TYPE_SCROLL_SENSITIVE,
ResultSet .CONCUR_UPDATABLE);

String sql = "SELECT * FROM Workers";
rs = stmt.executeQuery(sql);

rs.next( );
int  id_col = rs.get Int("ID");
String id = Integer.toString(id_col);
String f irst2 = rs.getString("First_Name");
String last2 = rs.getString("Last_Name");
String job2 = rs.getString("Job_Tit le");

text ID.setText(id);
textFirstName.setText(f irst2);
textLastName.setText(last2);
textJobTit le.setText(job2);

You're not doing anything dif ferent, here: just  select ing all the records again and putt ing the f irst
one in the Text Fields.

Here's all the code that saves a new record to the database (Obviously, a lot  of  this code could
have went into a method of  its own):
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The code is a bit  long, but you can copy and paste a lot  of  it  f rom your DoConnect  method.
(We've Photo-shopped the stmt  line because it 's too big to f it  on this page. Yours should go on
one line).

(One other issue is that  the ID column needs to be unique. Ideally, you'd write a rout ine to get the
last  ID number, then add one to it . Other databases, like MySql, have an AutoIncrement value to
take care of  these things. Just  make sure that the ID value isn't  one you have used before,
otherwise you'll get  an error message. Or write a rout ine to get a unique ID!)

Run your programme and test  it  out . You now be able to save new records to your database.

In the next lesson, you learn about delet ing records

 

<-- Add a Record | Delete a Record-->
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Delet ing a row can be straightforward: Just  use
deleteRow method of  the ResultSet:

rs.deleteRow( );

However, the Driver we are using, the
ClientDriver, leaves a blank row in place of  the
data that was deleted. If  you try to move to that
row using your Next or Previous buttons, the ID
Text Field will have a 0 in it , and all the others will
be blank.

To solve this problem we'll f irst  delete a row then,
again, close the Statement object  and the
ResultSet objects. We can then reload all the
data in the Text Fields. That way, we won't  have
any blank rows.

Here's the code to add for your Delete Record button:
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Run your programme and test  it  out . You now be able to delete records f rom your database.

 

And that 's it  - you now have the basic knowledge to write a database programme in Java using a
GUI. Congratulat ions, if  you got this far!

 

<-- Save a Record
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